System Identification Toolbox™
Getting Started Guide

Lennart Ljung

Ty

MATLAB&SIMULINK?

R2017b > ) MathWorks’



X o)

How to Contact MathWorks

Latest news: www.mathworks.com

Sales and services: www.mathworks.com/sales_and_services
User community: www.mathworks.com/matlabcentral
Technical support: www.mathworks.com/support/contact us
Phone: 508-647-7000

The MathWorks, Inc.
3 Apple Hill Drive
Natick, MA 01760-2098

System Identification Toolbox™ Getting Started Guide
© COPYRIGHT 1988-2017 by The MathWorks, Inc.

The software described in this document is furnished under a license agreement. The software may be
used or copied only under the terms of the license agreement. No part of this manual may be photocopied
or reproduced in any form without prior written consent from The MathWorks, Inc.

FEDERAL ACQUISITION: This provision applies to all acquisitions of the Program and Documentation
by, for, or through the federal government of the United States. By accepting delivery of the Program or
Documentation, the government hereby agrees that this software or documentation qualifies as
commercial computer software or commercial computer software documentation as such terms are used or
defined in FAR 12.212, DFARS Part 227.72, and DFARS 252.227-7014. Accordingly, the terms and
conditions of this Agreement and only those rights specified in this Agreement, shall pertain to and govern
the use, modification, reproduction, release, performance, display, and disclosure of the Program and
Documentation by the federal government (or other entity acquiring for or through the federal
government) and shall supersede any conflicting contractual terms or conditions. If this License fails to
meet the government's needs or is inconsistent in any respect with federal procurement law, the
government agrees to return the Program and Documentation, unused, to The MathWorks, Inc.

Trademarks

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. See
www.mathworks.com/trademarks for a list of additional trademarks. Other product or brand
names may be trademarks or registered trademarks of their respective holders.

Patents

MathWorks products are protected by one or more U.S. patents. Please see
www.mathworks.com/patents for more information.


https://www.mathworks.com
https://www.mathworks.com/sales_and_services
https://www.mathworks.com/matlabcentral
https://www.mathworks.com/support/contact_us
http://www.mathworks.com/trademarks
http://www.mathworks.com/patents

Revision History

March 2007
September 2007
March 2008
October 2008
March 2009
September 2009
March 2010
September 2010
April 2011
September 2011
March 2012
September 2012
March 2013
September 2013
March 2014
October 2014
March 2015
September 2015
March 2016
September 2016
March 2017
September 2017

First printing
Second printing
Third printing
Online only
Online only
Online only
Online only
Online only
Online only
Online only
Online only
Online only
Online only
Online only
Online only
Online only
Online only
Online only
Online only
Online only
Online only
Online only

New for Version 7.0 (Release 2007a)
Revised for Version 7.1 (Release 2007b)
Revised for Version 7.2 (Release 2008a)
Revised for Version 7.2.1 (Release 2008b)
Revised for Version 7.3 (Release 2009a)
Revised for Version 7.3.1 (Release 2009b)
Revised for Version 7.4 (Release 2010a)
Revised for Version 7.4.1 (Release 2010b)
Revised for Version 7.4.2 (Release 2011a)
Revised for Version 7.4.3 (Release 2011b)
Revised for Version 8.0 (Release 2012a)
Revised for Version 8.1 (Release 2012b)
Revised for Version 8.2 (Release 2013a)
Revised for Version 8.3 (Release 2013b)
Revised for Version 9.0 (Release 2014a)
Revised for Version 9.1 (Release 2014b)
Revised for Version 9.2 (Release 2015a)
Revised for Version 9.3 (Release 2015b)
Revised for Version 9.4 (Release 2016a)
Revised for Version 9.5 (Release 2016b)
Revised for Version 9.6 (Release 2017a)
Revised for Version 9.7 (Release 2017b)






Contents

Product Overview

1]

System Identification Toolbox Product Description . ... ... 1-2
Key Features . .......... .. .. .. iy 1-2
Acknowledgments .. ......... ... .. .. ... ... .. .. ... 1-3
System Identification Overview . ....................... 1-4
What Is System Identification? . ....................... 1-4
About Dynamic Systems and Models ................... 1-4
System Identification Requires Measured Data ........... 1-7
Building Models from Data . .......................... 1-9
Black-Box Modeling . ............. ... ..., 1-11
Grey-Box Modeling . ........... .. ... ... 1-15
Evaluating Model Quality ........................... 1-16
Learn More .. ... .. 1-20
Related Products . ........ ... ... ... .. .. .. .. .. . . ... 1-22

Using This Product

2/

When to Use the App vs. the Command Line .............. 2-2
System Identification Workflow ........................ 2-4
Commands for Model Estimation ....................... 2-6



vi

Contents

Linear Model Identification

3

Identify Linear Models Using System Identification App . ..
Introduction . ........ ... ... .. . . .. .
Preparing Data for System Identification
Saving the Session . ..............

Estimating Linear Models Using Quick Start ............

Estimating Linear Models . ..........................

Viewing Model Parameters ........

Exporting the Model to the MATLAB Workspace .........
Exporting the Model to the Linear System Analyzer .......

Identify Linear Models Using the Command Line ........

Introduction ...................
PreparingData .................
Estimating Impulse Response Models

Estimating Delays in the Multiple-Input System .........

Estimating Model Orders Using an ARX Model Structure . . .

Estimating Transfer Functions . .. ..
Estimating Process Models ... ... ..

Estimating Black-Box Polynomial Models ...............
Simulating and Predicting Model Output ...............

Identify Low-Order Transfer Functions (Process Models)

Using System Identification App . ..
Introduction . ..................

What Is a Continuous-Time Process Model? ............
Preparing Data for System Identification ..............

Estimating a Second-Order Transfer Function (Process Model)
with Complex Poles ............

Estimating a Process Model with a Noise Component . . . ..

Viewing Model Parameters ........

Exporting the Model to the MATLAB Workspace . .......

Simulating a System Identification Toolbox Model in Simulink

Software ....................

Estimating Models Using Frequency-Domain Data ... ...
Advantages of Using Frequency-Domain Data . .........
Representing Frequency-Domain Data in the Toolbox . . . ..
Preprocessing Frequency-Domain Data for Model

Estimation ...................

Estimating Linear Parametric Models

3-135
3-136
3-136

3-142
3-143



Validating Estimated Model . ....................... 3-149
Next Steps After Identifyinga Model . ................ 3-151

Nonlinear Model Identification

4|

Identify Nonlinear Black-Box Models Using System

Identification App . .......... .. ... .. .. 4-2
Introduction ........... ... . . .. .. .. 4-2
What Are Nonlinear Black-Box Models? ... .............. 4-3
PreparingData . ..... ... .. ... ... . .. .. ... 4-7
Estimating Nonlinear ARX Models .................... 4-12
Estimating Hammerstein-Wiener Models ............... 4-24

vii






Product Overview

+  “System Identification Toolbox Product Description” on page 1-2
+ “Acknowledgments” on page 1-3

+ “System Identification Overview” on page 1-4

* “Related Products” on page 1-22



1 Product Overview

System ldentification Toolbox Product Description

1-2

Create linear and nonlinear dynamic system models from measured input-output data

System Identification Toolbox provides MATLAB® functions, Simulink® blocks, and an
app for constructing mathematical models of dynamic systems from measured input-
output data. It lets you create and use models of dynamic systems not easily modeled
from first principles or specifications. You can use time-domain and frequency-domain
input-output data to identify continuous-time and discrete-time transfer functions,
process models, and state-space models. The toolbox also provides algorithms for
embedded online parameter estimation.

The toolbox provides identification techniques such as maximum likelihood, prediction-
error minimization (PEM), and subspace system identification. To represent nonlinear
system dynamics, you can estimate Hammerstein-Weiner models and nonlinear ARX
models with wavelet network, tree-partition, and sigmoid network nonlinearities. The
toolbox performs grey-box system identification for estimating parameters of a user-
defined model. You can use the identified model for system response prediction and plant
modeling in Simulink. The toolbox also supports time-series data modeling and time-
series forecasting.

Key Features

* Transfer function, process model, and state-space model identification using time-
domain and frequency-domain response data

* Autoregressive (ARX, ARMAX), Box-Jenkins, and Output-Error model estimation
using maximum likelihood, prediction-error minimization (PEM), and subspace
system identification techniques

* Online model parameter estimation
* Time-series modeling (AR, ARMA) and forecasting

+ Identification of nonlinear ARX models and Hammerstein-Weiner models with input-
output nonlinearities such as saturation and dead zone

* Linear and nonlinear grey-box system identification for estimation of user-defined
models

* Delay estimation, detrending, filtering, resampling, and reconstruction of missing
data
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System ldentification Overview
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In this section...

“What Is System Identification?” on page 1-4

“About Dynamic Systems and Models” on page 1-4

“System Identification Requires Measured Data” on page 1-7
“Building Models from Data” on page 1-9

“Black-Box Modeling” on page 1-11

“Grey-Box Modeling” on page 1-15

“Evaluating Model Quality” on page 1-16

“Learn More” on page 1-20

What Is System Identification?

System identification is a methodology for building mathematical models of dynamic
systems on page 1-4 using measurements of the system’s input and output signals.

The process of system identification requires that you:

Measure the input and output signals on page 1-7 from your system in time or
frequency domain.

+ Select a model structure on page 1-10.

* Apply an estimation method on page 1-11 to estimate value for the adjustable
parameters in the candidate model structure.

Evaluate the estimated model on page 1-16 to see if the model is adequate for your
application needs.

About Dynamic Systems and Models

* “What Is a Dynamic Model?” on page 1-5
+ “Continuous-Time Dynamic Model Example” on page 1-5

* “Discrete-Time Dynamic Model Example” on page 1-6
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What Is a Dynamic Model?

In a dynamic system, the values of the output signals depend on both the instantaneous
values of its input signals and also on the past behavior of the system. For example, a car
seat is a dynamic system—the seat shape (settling position) depends on both the current
weight of the passenger (instantaneous value) and how long this passenger has been
riding in the car (past behavior).

A model is a mathematical relationship between a system’s input and output variables.
Models of dynamic systems are typically described by differential or difference equations,
transfer functions, state-space equations, and pole-zero-gain models.

You can represent dynamic models both in continuous-time on page 1-5 and discrete-
time on page 1-6 form.

An often-used example of a dynamic model is the equation of motion of a spring-mass-
damper system. As shown in the next figure, the mass moves in response to the force F(¢)
applied on the base to which the mass is attached. The input and output of this system
are the force F(¢) and displacement y(¢) respectively.

F(t)
,—> y(t)

e

\—\/\/\/\N\/‘—

ENL

N

Mass-Spring-Damper System Excited by Force F(t)
Continuous-Time Dynamic Model Example

You can represent the same physical system as several equivalent models. For example,
you can represent the mass-spring-damper system in continuous time as a second order
differential equation:

d%y dy
m—=+c==+kyt)=F@)
de2 dt Y

where m is the mass, k the spring’s stiffness constant, and ¢ the damping coefficient. The
solution to this differential equation lets you determine the displacement of the mass,
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y(t), as a function of external force F(¢) at any time ¢ for known values of constant m, ¢
and k.

. . . dy(t) .
Consider the displacement, y(¢), and velocity, *® = ~4r » as state variables:

y@®
x(t) = L(t)}

You can express the previous equation of motion as a state-space model of the system:

@ = Ax(t)+ BF(¢t)
dt
() = Cx(t)

The matrices A, B, and C are related to the constants m, ¢ and & as follows:

0 1

A=| p c

m om
B:[O l}
m
C=[1 0]

You can also obtain a transfer function model of the spring-mass-damper system by
taking the Laplace transform of the differential equation:

_Y(s) _ 1
F(s) (ms:2 +cs+k)

where s is the Laplace variable.
Discrete-Time Dynamic Model Example

Suppose you can only observe the input and output variables F(¢) and y(¢) of the mass-
spring-damper system at discrete time instants ¢ = nT;, where 7T is a fixed time interval
andn=0,1, 2, .... The variables are said to be sampled with sample time T,. Then, you
can represent the relationship between the sampled input-output variables as a second
order difference equation, such as:

YO+ a vt -T,) +ayyt—2T,) =bF(t-T,)

1-6
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Often, for simplicity, 7 is taken as one time unit, and the equation can be written as:
YO +ayt -1 +ayy(t—2)=bF(t-1)

where a; and a, are the model parameters. The model parameters are related to the
system constants m, ¢, and k, and the sample time T%.

This difference equation shows the dynamic nature of the model. The displacement value
at the time instant ¢ depends not only on the value of force F at a previous time instant,
but also on the displacement values at the previous two time instants y(i—1) and y(i—2).

You can use this equation to compute the displacement at a specific time. The
displacement is represented as a weighted sum of the past input and output values:

YO =bF(t-D—-a;y(t -1 —ayy(t-2)

This equation shows an iterative way of generating values of output y(¢) starting from
initial conditions (y(0) and y(1)) and measurements of input F(¢). This computation is
called simulation.

Alternatively, the output value at a given time ¢ can be computed using the measured
values of output at previous two time instants and the input value at a previous time
instant. This computation is called prediction. For more information on simulation and
prediction using a model, see topics on the “Simulation and Prediction” page.

You can also represent a discrete-time equation of motion in state-space and transfer-
function forms by performing the transformations similar to those described in
“Continuous-Time Dynamic Model Example” on page 1-5.

System ldentification Requires Measured Data

+ “Why Does System Identification Require Data?” on page 1-7
+ “Time Domain Data” on page 1-8
* “Frequency Domain Data” on page 1-8

+ “Data Quality Requirements” on page 1-9
Why Does System Identification Require Data?

System identification uses the input and output signals you measure from a system to
estimate the values of adjustable parameters in a given model structure.
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Obtaining a good model of your system depends on how well your measured data reflects
the behavior of the system. See “Data Quality Requirements” on page 1-9.

Using this toolbox, you build models using time-domain input-output signals, frequency
response data, time series signals, and time-series spectra.

Time Domain Data

Time-domain data consists of the input and output variables of the system that you
record at a uniform sampling interval over a period of time.

For example, if you measure the input force, F(f), and mass displacement, y(¢), of the
spring-mass-damper system on page 1-5 at a uniform sampling frequency of 10 Hz, you
obtain the following vectors of measured values:

Upoas = F(T,), F@T,),F(3T,),..., F(NT,)]
Ymeas =[¥(T,), ¥2T,),y(BT)),..., y(NT,)]

where T, = 0.1 seconds and N7, is time of the last measurement.

If you want to build a discrete-time model from this data, the data vectors u,,,,s and ¥,,.4s
and the sample time T provide sufficient information for creating such a model.

If you want to build a continuous-time model, you should also know the intersample
behavior of the input signals during the experiment. For example, the input may be
piecewise constant (zero-order hold) or piecewise linear (first-order hold) between
samples.

Frequency Domain Data

Frequency domain data represents measurements of the system input and output
variables that you record or store in the frequency domain. The frequency domain signals
are Fourier transforms of the corresponding time domain signals.

Frequency domain data can also represent the frequency response of the system,
represented by the set of complex response values over a given frequency range. The
frequency response describes the outputs to sinusoidal inputs. If the input is a sine wave
with frequency o, then the output is also a sine wave of the same frequency, whose
amplitude is A(w) times the input signal amplitude and a phase shift of ®(w) with respect
to the input signal. The frequency response is A(w)e(®®),
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In the case of the mass-spring-damper system, you can obtain the frequency response
data by using a sinusoidal input force and measuring the corresponding amplitude gain
and phase shift of the response, over a range of input frequencies.

You can use frequency-domain data to build both discrete-time and continuous-time
models of your system.

Data Quality Requirements

System identification requires that your data capture the important dynamics of your
system. Good experimental design ensures that you measure the right variables with
sufficient accuracy and duration to capture the dynamics you want to model. In general,
your experiment must:

+ Use inputs that excite the system dynamics adequately. For example, a single step is
seldom enough excitation.

* Measure data long enough to capture the important time constants.

+ Set up data acquisition system to have good signal-to-noise ratio.

* Measure data at appropriate sampling intervals or frequency resolution.

You can analyze the data quality before building the model using techniques available in

the Signal Processing Toolbox software. For example, analyze the input spectra to
determine if the input signals have sufficient power over the bandwidth of the system.

You can also analyze your data to determine peak frequencies, input delays, important
time constants, and indication of nonlinearities using non-parametric analysis tools in
this toolbox. You can use this information for configuring model structures for building
models from data. For more information, see:

* “Correlation Models”

+ “Frequency-Response Models”

Building Models from Data

+  “System Identification Requires a Model Structure” on page 1-10
* “How the Toolbox Computes Model Parameters” on page 1-10

+ “Configuring the Parameter Estimation Algorithm” on page 1-11


http://www.mathworks.com/products/signal/
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System Identification Requires a Model Structure

A model structure is a mathematical relationship between input and output variables
that contains unknown parameters. Examples of model structures are transfer functions
with adjustable poles and zeros, state space equations with unknown system matrices,
and nonlinear parameterized functions.

The following difference equation represents a simple model structure:
y(k)+ayk—1)=bu(k)

where a and b are adjustable parameters.

The system identification process requires that you choose a model structure and apply
the estimation methods to determine the numerical values of the model parameters.

You can use one of the following approaches to choose the model structure:

* You want a model that is able to reproduce your measured data and is as simple as
possible. You can try various mathematical structures available in the toolbox. This
modeling approach is called black-box modeling on page 1-11.

*  You want a specific structure for your model, which you may have derived from first
principles, but do not know numerical values of its parameters. You can then
represent the model structure as a set of equations or state-space system in MATLAB
and estimate the values of its parameters from data. This approach is known as grey-
box modeling on page 1-15.

How the Toolbox Computes Model Parameters

The System Identification Toolbox software estimates model parameters by minimizing
the error between the model output and the measured response. The output ¥,,,4.; of the
linear model is given by:

ymodel(t) = Gu(t)
where G is the transfer function.

To determine G, the toolbox minimizes the difference between the model output y,,40(2)
and the measured output y,,...(f). The minimization criterion is a weighted norm of the
error, v(t), where:

U<t) = ymeas(t) - ymodel(t)'
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Ymodel(t) 18 one of the following:

* Simulated response (Gu(t) of the model for a given input u(f)

* Predicted response of the model for a given input u(f) and past measurements of
Output (ymeas<t'1)a ymeas<t'2)>'--)

Accordingly, the error v(f) is called simulation error or prediction error. The estimation
algorithms on page 1-11 adjust parameters in the model structure G such that the norm
of this error is as small as possible.

Configuring the Parameter Estimation Algorithm
You can configure the estimation algorithm by:

+ Configuring the minimization criterion to focus the estimation in a desired frequency
range, such as put more emphasis at lower frequencies and deemphasize higher
frequency noise contributions. You can also configure the criterion to target the
intended application needs for the model such as simulation or prediction.

+  Specifying optimization options for iterative estimation algorithms.
The majority of estimation algorithms in this toolbox are iterative. You can configure

an iterative estimation algorithm by specifying options, such as the optimization
method and the maximum number of iterations.

For more information about configuring the estimation algorithm, see “Options to
Configure the Loss Function” and the topics for estimating specific model structures.

Black-Box Modeling

+  “Selecting Black-Box Model Structure and Order” on page 1-11
* “When to Use Nonlinear Model Structures?” on page 1-13
+ “Black-Box Estimation Example” on page 1-14

Selecting Black-Box Model Structure and Order

Black-box modeling is useful when your primary interest is in fitting the data regardless
of a particular mathematical structure of the model. The toolbox provides several linear
and nonlinear black-box model structures, which have traditionally been useful for
representing dynamic systems. These model structures vary in complexity depending on
the flexibility you need to account for the dynamics and noise in your system. You can

1-11
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choose one of these structures and compute its parameters to fit the measured response
data.

Black-box modeling is usually a trial-and-error process, where you estimate the
parameters of various structures and compare the results. Typically, you start with the
simple linear model structure and progress to more complex structures. You might also
choose a model structure because you are more familiar with this structure or because
you have specific application needs.

The simplest linear black-box structures require the fewest options to configure:

+ Transfer function, with a given number of poles and zeros.
*  Linear ARX model, which is the simplest input-output polynomial model.

+ State-space model, which you can estimate by specifying the number of model states

Estimation of some of these structures also uses noniterative estimation algorithms,
which further reduces complexity.

You can configure a model structure using the model order. The definition of model order
varies depending on the type of model you select. For example, if you choose a transfer
function representation, the model order is related to the number of poles and zeros. For
state-space representation, the model order corresponds to the number of states. In some
cases, such as for linear ARX and state-space model structures, you can estimate the
model order from the data.

If the simple model structures do not produce good models, you can select more complex
model structures by:

+  Specifying a higher model order for the same linear model structure. Higher model
order increases the model flexibility for capturing complex phenomena. However,
unnecessarily high orders can make the model less reliable.

+ Explicitly modeling the noise:
y()=Gu(t)+He(t)

where H models the additive disturbance by treating the disturbance as the output of
a linear system driven by a white noise source e(t).

Using a model structure that explicitly models the additive disturbance can help to
improve the accuracy of the measured component G. Furthermore, such a model
structure is useful when your main interest is using the model for predicting future
response values.
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+ Using a different linear model structure.

See “Linear Model Structures”.

* Using a nonlinear model structure.

Nonlinear models have more flexibility in capturing complex phenomena than linear
models of similar orders. See “Nonlinear Model Structures”.

Ultimately, you choose the simplest model structure that provides the best fit to your
measured data. For more information, see “Estimating Linear Models Using Quick Start”
on page 3-22.

Regardless of the structure you choose for estimation, you can simplify the model for your
application needs. For example, you can separate out the measured dynamics (G) from
the noise dynamics (H) to obtain a simpler model that represents just the relationship
between y and u. You can also linearize a nonlinear model about an operating point.

When to Use Nonlinear Model Structures?

A linear model is often sufficient to accurately describe the system dynamics and, in most
cases, you should first try to fit linear models. If the linear model output does not
adequately reproduce the measured output, you might need to use a nonlinear model.

You can assess the need to use a nonlinear model structure by plotting the response of
the system to an input. If you notice that the responses differ depending on the input
level or input sign, try using a nonlinear model. For example, if the output response to an
input step up is faster than the response to a step down, you might need a nonlinear
model.

Before building a nonlinear model of a system that you know is nonlinear, try
transforming the input and output variables such that the relationship between the
transformed variables is linear. For example, consider a system that has current and
voltage as inputs to an immersion heater, and the temperature of the heated liquid as an
output. The output depends on the inputs via the power of the heater, which is equal to
the product of current and voltage. Instead of building a nonlinear model for this two-
input and one-output system, you can create a new input variable by taking the product
of current and voltage and then build a linear model that describes the relationship
between power and temperature.

If you cannot determine variable transformations that yield a linear relationship
between input and output variables, you can use nonlinear structures such as Nonlinear

1-13
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ARX or Hammerstein-Wiener models. For a list of supported nonlinear model structures
and when to use them, see “Nonlinear Model Structures”.

Black-Box Estimation Example

You can use the System Identification app or commands to estimate linear and nonlinear
models of various structures. In most cases, you choose a model structure and estimate
the model parameters using a single command.

Consider the mass-spring-damper system, described in “About Dynamic Systems and
Models” on page 1-4. If you do not know the equation of motion of this system, you can
use a black-box modeling approach to build a model. For example, you can estimate
transfer functions or state-space models by specifying the orders of these model
structures.

A transfer function is a ratio of polynomials:
(bO +bys+ bys” +)
(1+ f1s +f232 +)

G(s) =

For the mass-spring damper system, this transfer function is:

G(s)= !

(ms2 +cs+ k)

which is a system with no zeros and 2 poles.

In discrete-time, the transfer function of the mass-spring-damper system can be:
bz !

G(z1)=
: (1+f12_1 + f22_2)

where the model orders correspond to the number of coefficients of the numerator and
the denominator (nb = 1 and nf = 2) and the input-output delay equals the lowest order
exponent of z7! in the numerator (nk = 1).

In continuous-time, you can build a linear transfer function model using the tfest
command:

m = tfest(data,2,0)
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where data is your measured input-output data, represented as an iddata object and
the model order is the set of number of poles (2) and the number of zeros (0).

Similarly, you can build a discrete-time model Output Error structure using the following
command:

m = oe(data, [l 2 11])

The model order is [nb nf nk] =[1 2 1]. Usually, you do not know the model orders in
advance. You should try several model order values until you find the orders that
produce an acceptable model.

Alternatively, you can choose a state-space structure to represent the mass-spring-
damper system and estimate the model parameters using the ssest or the n4sid
command:

m = ssest (data, 2)
where order = 2 represents the number of states in the model.

In black-box modeling, you do not need the system’s equation of motion—only a guess of
the model orders.

For more information about building models, see “Steps for Using the System
Identification App” and “Model Estimation Commands”.

Grey-Box Modeling

In some situations, you can deduce the model structure from physical principles. For
example, the mathematical relationship between the input force and the resulting mass
displacement in the mass-spring-damper system on page 1-5 is well known. In state-
space form, the model is given by:

dx _ Ax(t)+ BF(t)
dt
y(t) = Cx(t)

where x(t) = [y(t);v(t)] is the state vector. The coefficients A, B, and C are functions of
the model parameters:

A=1[01;-kIm —c/m]

1-15
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B=10; 1/m]
C=[10]

Here, you fully know the model structure but do not know the values of its parameters—
m, ¢ and k.

In the grey-box approach, you use the data to estimate the values of the unknown
parameters of your model structure. You specify the model structure by a set of
differential or difference equations in MATLAB and provide some initial guess for the
unknown parameters specified.

In general, you build grey-box models by:

Creating a template model structure.
2 Configuring the model parameters with initial values and constraints (if any).

3 Applying an estimation method to the model structure and computing the model
parameter values.

The following table summarizes the ways you can specify a grey-box model structure.

Grey-Box Structure Representation Learn More

Represent the state-space model structure |+ “Estimate State-Space Models with
as a structured idss model object and Canonical Parameterization”
estimate the state-space matrices A, Band |. <“Rgtimate State-Space Models with

C. Structured Parameterization”

You can compute the parameter values,
such as m, ¢, and &, from the state space
matrices A and B. For example, m = 1/B(2)
and k =-A(2,1)m.

Represent the state-space model structure |“Grey-Box Model Estimation”
as an idgrey model object. You can
directly estimate the values of parameters
m, c and k.

Evaluating Model Quality

* “How to Evaluate and Improve Model Quality” on page 1-17
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+ “Comparing Model Response to Measured Response” on page 1-17
* “Analyzing Residuals” on page 1-18
+ “Analyzing Model Uncertainty” on page 1-19

How to Evaluate and Improve Model Quality
After you estimate the model, you can evaluate the model quality by:

+ “Comparing Model Response to Measured Response” on page 1-17
* “Analyzing Residuals” on page 1-18
* “Analyzing Model Uncertainty” on page 1-19

Ultimately, you must assess the quality of your model based on whether the model
adequately addresses the needs of your application. For information about other
available model analysis techniques, see “Model Analysis”.

If you do not get a satisfactory model, you can iteratively improve your results by trying
a different model structure, changing the estimation algorithm settings, or performing
additional data processing. If these changes do not improve your results, you might need
to revisit your experimental design and data gathering procedures.

Comparing Model Response to Measured Response

Typically, you evaluate the quality of a model by comparing the model response to the
measured output for the same input signal.

Suppose you use a black-box modeling approach to create dynamic models of the spring-
mass damper system. You try various model structures and orders, such as:

modell = arx(data, [2 1 11);
model?2 = nédsid(data, 3)

You can simulate these models with a particular input and compare their responses
against the measured values of the displacement for the same input applied to the real
system. The following figure compares the simulated and measured responses for a step
input.

1-17
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The previous figure indicates that mode12 is better than model1 because model2 better
fits the data (65% vs. 83%).

The % fit indicates the agreement between the model response and the measured output:
100 means a perfect fit, and 0 indicates a poor fit (that is, the model output has the same
fit to the measured output as the mean of the measured output).

For more information, see topics on the “Compare Output with Measured Data” page.
Analyzing Residuals

The System Identification Toolbox software lets you perform residual analysis to assess
the model quality. Residuals represent the portion of the output data not explained by

the estimated model. A good model has residuals uncorrelated with past inputs.

For more information, see the topics on the “Residual Analysis” page.
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Analyzing Model Uncertainty

When you estimate the model parameters from data, you obtain their nominal values
that are accurate within a confidence region. The size of this region is determined by the
values of the parameter uncertainties computed during estimation. The magnitude of the
uncertainties provide a measure of the reliability of the model. Large uncertainties in
parameters can result from unnecessarily high model orders, inadequate excitation levels
in the input data, and poor signal-to-noise ratio in measured data.

You can compute and visualize the effect of parameter uncertainties on the model
response in time and frequency domains using pole-zero maps, Bode response, and step
response plots. For example, in the following Bode plot of an estimated model, the shaded
regions represent the uncertainty in amplitude and phase of model's frequency response,
computed using the uncertainty in the parameters. The plot shows that the uncertainty
is low only in the 5 to 50 rad/s frequency range, which indicates that the model is reliable
only in this frequency range.
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-400
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For more information, see “Computing Model Uncertainty”.

Learn More

The System Identification Toolbox documentation provides you with the necessary

information to use this product. Additional resources are available to help you learn more

about specific aspects of system identification theory and applications.

The following book describes methods for system identification and physical modeling:
Ljung, L., and T. Glad. Modeling of Dynamic Systems. PTR Prentice Hall, Upper Saddle
River, NdJ, 1994.

These books provide detailed information about system identification theory and
algorithms:

* Ljung, L. System Identification: Theory for the User. Second edition. PTR Prentice
Hall, Upper Saddle River, NdJ, 1999.

+ Soderstrom, T., and P. Stoica. System Identification. Prentice Hall International,
London, 1989.

For information about working with frequency-domain data, see the following book:
Pintelon, R., and J. Schoukens. System Identification. A Frequency Domain Approach.
Wiley-IEEE Press, New York, 2001.

For information on nonlinear identification, see the following references:

+ Sjoberg, J., Q. Zhang, L. Ljung, A. Benveniste, B. Deylon, P. Glorennec, H.
Hjalmarsson, and A. Juditsky, “Nonlinear Black-Box Modeling in System
Identification: a Unified Overview.” Automatica. Vol. 31, Issue 12, 1995, pp. 1691—
1724.

+ Juditsky, A., H. Hjalmarsson, A. Benveniste, B. Delyon, L. Ljung, J. Sjéberg, and Q.
Zhang, “Nonlinear Black-Box Models in System Identification: Mathematical
Foundations.” Automatica. Vol. 31, Issue 12, 1995, pp. 1725-1750.

+ Zhang, Q., and A. Benveniste, “Wavelet networks.” IEEE Transactions on Neural
Networks. Vol. 3, Issue 6, 1992, pp. 889-898.

* Zhang, Q., “Using Wavelet Network in Nonparametric Estimation.” IEEE
Transactions on Neural Networks. Vol. 8, Issue 2, 1997, pp. 227—-236.

For more information about systems and signals, see the following book:
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Oppenheim, J., and Willsky, A.S. Signals and Systems. PTR Prentice Hall, Upper Saddle
River, NJ, 1985.

The following textbook describes numerical techniques for parameter estimation using

criterion minimization:
Dennis, J.E., Jr., and R.B. Schnabel. Numerical Methods for Unconstrained Optimization
and Nonlinear Equations. PTR Prentice Hall, Upper Saddle River, NdJ, 1983.
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The following table summarizes MathWorks® products that extend and complement the
System Identification Toolbox software. For current information about these and other
MathWorks products, point your Web browser to:

www.mathworks.com

Product

Description

“Control System Toolbox”

Provides extensive tools to analyze plant
models created in the System Identification
Toolbox software and to tune control
systems based on these plant models. You
can use the identified models directly for
advanced linear analysis and control design
tasks — no conversion of the format
required.

“Model Predictive Control Toolbox”

Uses the linear plant models created in the
System Identification Toolbox software for
predicting plant behavior that is optimized
by the model-predictive controller.

“Neural Network Toolbox”

Provides flexible neural-network structures
for estimating nonlinear models using the
System Identification Toolbox software.

“Optimization Toolbox”

When this toolbox is installed, you have the
option of using the 1sgnonlin
optimization algorithm for linear and
nonlinear identification.

“Robust Control Toolbox”

Provides tools to design multiple-input and
multiple-output (MIMO) control systems
based on plant models created in the
System Identification Toolbox software.
Helps you assess robustness based on
confidence bounds for the identified plant
model.




Related Products

Product

Description

“Signal Processing Toolbox”

Provides additional options for:

+ Filtering
(The System Identification Toolbox
software provides only the fifth-order
Butterworth filter.)

* Spectral analysis

After using the advanced data processing
capabilities of the Signal Processing
Toolbox software, you can import the data
into the System Identification Toolbox
software for modeling.

“Simulink”

Provides System Identification blocks for
simulating the models you identified using
the System Identification Toolbox software.
Also provides blocks for model estimation.
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“When to Use the App vs. the Command Line” on page 2-2
“System Identification Workflow” on page 2-4

“Commands for Model Estimation” on page 2-6
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When to Use the App vs. the Command Line

2-2

After installing the System Identification Toolbox product, you can start the System
Identification app or work at the command line.

You can work either in the app or at the command line to preprocess data, and estimate,
validate, and compare models.

The following operations are available only at the command line:

*  Generating input and output data (see idinput).

+  Estimating coefficients of linear and nonlinear ordinary differential or difference
equations (grey-box models).

+ Using recursive online estimation methods. For more information, see topics about
estimating linear models recursively on the “Online Estimation” page.

*  Converting between continuous-time and discrete-time models (see c2d and d2c
reference pages).

+ Converting models to Control System Toolbox™ LTI objects (see ss, tf, and zpk).

Note Conversions to LTI objects require the Control System Toolbox software.

New users should start by using the app to become familiar with the product. To open
the app, on the Apps tab of MATLAB desktop, in the Apps section, click System
Identification. Alternatively, type systemIdentification in the MATLAB
Command Window.

To work at the command line, type the commands directly in the MATLAB Command
Window. For more information about a command, type doc command name in the
MATLAB Command Window.

See Also

More About
. “System Identification Workflow” on page 2-4

. “Commands for Model Estimation” on page 2-6



See Also

“Working with System Identification App”
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System ldentification Workflow

System identification is an iterative process, where you identify models with different
structures from data and compare model performance. Ultimately, you choose the
simplest model that best describes the dynamics of your system.

Because this toolbox lets you estimate different model structures quickly, you should try
as many different structures as possible to see which one produces the best results.

A system identification workflow might include the following tasks:
1  Process data for system identification by:

Importing data into the MATLAB workspace.

* Representing data in the System Identification app or as an iddata or idfrd
object in the MATLAB workspace.

+ Plotting data to examine both time- and frequency-domain behavior.

To analyze the data for the presence of constant offsets and trends, delay,
feedback, and signal excitation levels, you can also use the advice command.

Preprocessing data by removing offsets and linear trends, interpolating missing
values, filtering to emphasize a specific frequency range, or resampling
(interpolating or decimating) using a different time interval.

2 Identify linear or nonlinear models:

*  Frequency-response models
*  Impulse-response models
Low-order transfer functions (process models)
Input-output polynomial models
+ State-space models
+  Transfer function models
* Nonlinear black-box models
Ordinary difference or differential equations (grey-box models)
3 Validate models.
When you do not achieve a satisfactory model, try a different model structure and

order or try another identification algorithm. In some cases, you can improve results
by including a noise model.
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You might need to preprocess your data before doing further estimation. For
example, if there is too much high-frequency noise in your data, you might need to
filter or decimate (resample) the data before modeling.

4  Postprocess models:

Transform between continuous- and discrete-time domains
* Transform between model representations
+  Extract numerical model data
Subreference, concatenate and merge models
+ Linearize nonlinear models
5 Use identified models for:

“Simulation and Prediction”

* Control design for the estimated plant using other MathWorks products.

You can import an estimated linear model into Control System Toolbox, Model
Predictive Control Toolbox™, Robust Control Toolbox™, or Simulink software.

As dynamic blocks in Simulink

For online applications, you can perform online estimation.
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Commands for Model Estimation

2-6

The following tables summarize System Identification Toolbox commands for offline and
online estimation. For detailed information about using each command, see the
corresponding reference page.

You can compile all the estimation commands using MATLAB Compiler™ software.
Using MATLAB Coder™ software, you can only generate C and C++ code for online
estimation commands, except for rpem, rplr, and segment.
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Commands for Offline Estimation

Model Type Estimation Commands
Transfer function models tfest
Process models (low-order procest

transfer functions expressed in
time-constant form)

Linear input-output polynomial
models

armax (ARMAX and ARIMAX models)
arx (ARX and ARIX models)

b3 (BJ only)

iv4 (ARX only)

ivx (ARX only)

oe (OE only)

polyest (for all models)

State-space models ndsid
ssest
ssregest

Frequency-response models etfe
spa
spafdr

Correlation models cra
impulseest

Linear time-series models ar
arx (for multiple outputs)
ivar

Linear grey-box models greyest

Nonlinear ARX models nlarx

Hammerstein-Wiener models nlhw

Nonlinear grey-box models nlgreyest

Linear and nonlinear models pem
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Commands for Online Estimation

Model Type Estimation Commands
Linear input-output polynomial |recursiveARX
models recursiveARMAX
recursiveOE
recursiveBJd
Linear time-series models recursiveAR
recursiveARMA
Model that is linear in recursivelLS
parameters
Linear polynomial models rpem
rplr

segment (AR, ARMA, ARX, and ARMAX models
only)

See Also

More About

. “System Identification Workflow” on page 2-4

. “What Is Online Estimation?”
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“Identify Linear Models Using System Identification App” on page 3-2
“Identify Linear Models Using the Command Line” on page 3-54

“Identify Low-Order Transfer Functions (Process Models) Using System Identification
App” on page 3-104

“Estimating Models Using Frequency-Domain Data” on page 3-135
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|dentify Linear Models Using System Identification App

In this section...

“Introduction” on page 3-2

“Preparing Data for System Identification” on page 3-3

“Saving the Session” on page 3-20

“Estimating Linear Models Using Quick Start” on page 3-22
“Estimating Linear Models” on page 3-28

“Viewing Model Parameters” on page 3-48

“Exporting the Model to the MATLAB Workspace” on page 3-51

“Exporting the Model to the Linear System Analyzer” on page 3-53

Introduction

+ “Objectives” on page 3-2

+  “Data Description” on page 3-3
Objectives

Estimate and validate linear models from single-input/single-output (SISO) data to find
the one that best describes the system dynamics.

After completing this tutorial, you will be able to accomplish the following tasks using
the System Identification app:

* Import data arrays from the MATLAB workspace into the app.

* Plot the data.

*  Process data by removing offsets from the input and output signals.

+  Estimate, validate, and compare linear models.
+  Export models to the MATLAB workspace.

Note The tutorial uses time-domain data to demonstrate how you can estimate linear
models. The same workflow applies to fitting frequency-domain data.
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This tutorial is based on the example in section 17.3 of System Identification: Theory for
the User, Second Edition, by Lennart Ljung, Prentice Hall PTR, 1999.

Data Description

This tutorial uses the data file dryer2 .mat, which contains single-input/single-output
(SISO) time-domain data from Feedback Process Trainer PT326. The input and output
signals each contain 1000 data samples.

This system heats the air at the inlet using a mesh of resistor wire, similar to a hair
dryer. The input is the power supplied to the resistor wires, and the output is the air
temperature at the outlet.

Preparing Data for System Identification

* “Loading Data into the MATLAB Workspace” on page 3-3

* “Opening the System Identification App” on page 3-3

+ “Importing Data Arrays into the System Identification App” on page 3-4
+  “Plotting and Processing Data” on page 3-9

Loading Data into the MATLAB Workspace

Load the data in dryer2.mat by typing the following command in the MATLAB
Command Window:

load dryer2

This command loads the data into the MATLAB workspace as two column vectors, u2
and y2, respectively. The variable u2 is the input data and y2 is the output data.

Opening the System Identification App

To open the System Identification app, type the following command in the MATLAB
Command Window:

systemIdentification

The default session name, Untitled, appears in the title bar.

3-3
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n System Identification - Untitled EI@
File Options Window Help
Import data - Import models -
l Operations JL
<— Preprocess =]
=
Waorking Data
Estimate —= )
Data Views To To Model Views
Time plot Workspace | | LTI Viewer Model output Tranzient resp Nonlinear ARX
Data spectra _ Model resids Freguency resp Hamm-\Wiener
Frequency function Zeros and poles
Noise spectrum
E=h Validation Data F
Status line iz here.

Importing Data Arrays into the System Identification App

You can import the single-input/single-output (SISO) data from a sample data file
dryer2.mat into the app from the MATLAB workspace.

You must have already loaded the sample data into MATLAB, as described in “Loading
Data into the MATLAB Workspace” on page 3-3, and opened the System Identification
app, as described in “Opening the System Identification App” on page 3-3.

To import data arrays into the System Identification app:

1 Select Import data > Time domain data. This action opens the Import Data dialog
box.
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Import data v

Import data

Time domain data... k‘

Freq. domain data...
Data object...
Example...

In the Import Data dialog box, specify the following options:

Input — Enter u2 as the name of the input variable.
*  Output — Enter y2 as the name of the output variable.

+ Data name — Change the default name to data. This name labels the data in
the System Identification app after the import operation is completed.

Starting time — Enter 0 as the starting time. This value designates the starting
value of the time axis on time plots.

+ Sample Time — Enter 0. 08 as the time between successive samples in seconds.
This value is the actual sample time in the experiment.

The Import Data dialog box now resembles the following figure.
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4 Import Data EI@

Data Format for Signals

Time-Domain Signals -

Workspace Variable

Input: u?

Output: vz

Data Information

Drata name: data
Starting time: 0
Sample time: 0.08

| Import | | Reset |

| Close | | Help |

In the Data Information area, click More to expand the dialog box and specify the

following options:

Input Properties

InterSample — Accept the default zoh (zero-order hold) to indicate that the
input signal was piecewise-constant between samples during data acquisition.
This setting specifies the behavior of the input signals between samples when you
transform the resulting models between discrete-time and continuous-time

representations.

Period — Accept the default inf to specify a nonperiodic input.




Identify Linear Models Using System Identification App

Note For a periodic input, enter the whole number of periods of the input signal
in your experiment.

Channel Names

* Input — Enter power.

Tip Naming channels helps you to identify data in plots. For multivariable input
and output signals, you can specify the names of individual Input and Output
channels, separated by commas.

* Output — Enter temperature.

Physical Units of Variables

* Input — Enter W for power units.

Tip When you have multiple inputs and outputs, enter a comma-separated list of
Input and Output units corresponding to each channel.

Output — Enter ~oC for temperature units.

Notes — Enter comments about the experiment or the data. For example, you might
enter the experiment name, date, and a description of experimental conditions.
When you estimate models from this data, these models inherit your notes.

The expanded Import Data dialog box now resembles the following figure.
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4 Im port Data

(=[O =]

Data Format for Signals

Time-Domain Signals

Input Properties

InterSample:

Period:

Workspace Variable

Input: u?

Output: vz

Channel Hames

Input: power

Output: temperature

Data Information

Drata name: data
Starting time: 0
Sample time: 0.08

Physical Units of Variables

| Reset

| Close | | Help

Input: W
Output: agl
Hotes

4  Click Import to add the data to the System Identification app. The app displays an

icon to represent the data.
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Import data -
‘l Operations
?W <— Preprocess -
data

f
A

=+ data
Working Data
Estimate — -

5 Click Close to close the Import Data dialog box.
Plotting and Processing Data

In this portion of the tutorial, you evaluate the data and process it for system
identification. You learn how to:

+  Plot the data.

*  Remove offsets from the data by subtracting the mean values of the input and the
output.

* Split the data into two parts to use one part model estimation and the other part for
model validation.

The reason you subtract the mean values from each signal is because, typically, you build
linear models that describe the responses for deviations from a physical equilibrium.
With steady-state data, it is reasonable to assume that the mean levels of the signals
correspond to such an equilibrium. Thus, you can seek models around zero without
modeling the absolute equilibrium levels in physical units.

You must have already imported data into the System Identification app, as described in
“Importing Data Arrays into the System Identification App” on page 3-4.

To plot and process the data:

1  Select the Time plot check box to open the Time Plot. If the plot window is empty,
click the data icon in the System Identification app.
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e

E Time Plot: power-=temperature E@

File Options Style  Channel Experiment Help

Input and output signals

temperature
th & ~

T

1

e
T

Lk

0 10 20 30 40 &0 G0 70 80
Time

The top axes show the output data (temperature), and the bottom axes show the
input data (power). Both the input and the output data have nonzero mean values.

2 Subtract the mean input value from the input data and the mean output value from
the output data. In the System Identification app, select <--Preprocess > Remove
means.
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Import data >
Operations
1‘ p
,\'/\- <— Preprocess x|
data
<— Preprocess
Select channels...
Select experiments...
Merge experiments...
Select range...
Remove trends
Fitter...
i Resample...
Llaevens Transform data...
Time plot Quick start Model output
|:| Data spectra _ Model resid
|:| Frequency function \/\
data
Tl Validation Data

o plot)

This action adds a new data set to the System Identification app with the default
name datad (the suffix d means detrend), and updates the Time Plot window to

display both the original and the detrended data. The detrended data has a zero
mean value.
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Specify the detrended data to be used for estimating models. Drag the data set
datad to the Working Data rectangle.
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Drag and drop data set.

Import data )
Operations

MM :<-Pre ocess v:

data datad

Y
datad
Working Data

!

_Estimate = |

Alternatively, right-click the datad icon to open the Data/model Info dialog box.
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] Data/model Info: datad EI@
Data name: datad
Color; [0,0.5,0
Time domain data set with 1000 samples. -

Sample time: 0.08 seconds
Hame: datad

m

Jutputs Unit (if specified)
temperature ~oC

Diary and Notes

% Import data
datad = detrend(data, 0)

[] Use as Validation Data
[ pPresent | [ Expot | [ cClose | [ Help |

Select the Use as Working Data check-box. Click Apply and then Close. This
action adds datad to the Working Data rectangle.

4  Split the data into two parts and specify the first part for model estimation, and the
second part for model validation.

a Select <—-Preprocess > Select range to open the Select Range window.
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|:| Data spectra

ency function

Import data -
‘t ' Operations
,\./\ IV\ <— Preprocess
data datad
=— Preprocess
Select channels...
Select experiments...
Merge experiments...
Remove means
Remove trends
Fitter...
i Resample...
LERUETS Transformdata...
Time plot Quick start

Mod

Mo

In the Select Range window, create a data set containing the first 500 samples.
In the Samples field, specify 1 500.

Tip You can also select data samples using the mouse by clicking and dragging a
rectangular region on the plot. If you select samples on the input-channel axes,
the corresponding region is also selected on the output-channel axes.

In the Data name field, type the name data_est.
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Wark time span using mouse (draw rectangle) or keyboard.

Click Insert to add this new data set to the System Identification app to be used
for model estimation.

Repeat this process to create a second data set containing a subset of the data to
use for validation. In the Select Range window, specify the last 500 samples in
the Samples field. Type the name data val in the Data name field. Click
Insert to add this new data set to the System Identification app.
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n Select Range: power->temperature EI@

File Options Style Channel Help

Input and output signals

2
@
5 Time span:
™
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E
o Samples:
-2 501 1000
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2
data_wal
@
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[=]
=
2 Close
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Time

Wark time span using mouse (draw rectangle) or keyboard.

f  Click Close to close the Select Range window.

5 In the System Identification app, drag and drop data est to the Working Data
rectangle, and drag and drop data val to the Validation Data rectangle.

3-17



3 Linear Model Identification
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Drag and drop validation data set

6 To get information about a data set, right-click its icon. For example, right-click
data_est to open the Data/model Info dialog box.
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] Data/model Info: data_est EI@
Data name: data_est
Calar: [1,0,0]
Time domain data set with 500 samples. P

Sample time: 0.08 seconds
Mame: data_est

m

Jutputs Unit (if specified)
temperature ~oC
Inputs Unit (if specified)
power W -

Diary and Motes

% Import data
datad = detrend(data,0)
data_est = datad([1:500])

[ Use as Working Data

[[] Use as validation Data Apply

e | [men ) (o ] [ e ]

You can also change certain values in the Data/model Info dialog box, including:

Changing the name of the data set in the Data name field.

Changing the color of the data icon in the Color field. You specify colors using
RGB values (relative amounts of red, green, and blue). Each value is between 0
and 1. For example, [1, 0, 0] indicates that only red is present, and no green and
blue are mixed into the overall color.

Viewing or editing the commands executed on this data set in the Diary and
Notes area. This area contains the command-line equivalent to the processing

3-19



3 Linear Model Identification

you performed using the System Identification app. For example, as shown in the
Data/model Info: estimate window, the data est data set is a result of importing
the data, detrending the mean values, and selecting the first 500 samples of the
data.

% Import data
datad = detrend(data,0)
data est = datad([1:500])

For more information about these and other toolbox commands, see the
corresponding reference pages.

The Data/model Info dialog box also displays the total number of samples, the sample
time, and the output and input channel names and units. This information is not
editable.

Tip As an alternative shortcut, you can select Preprocess > Quick start from the
System Identification app to perform all of the data processing steps in this tutorial.

Learn More

For information about supported data processing operations, such as resampling and
filtering the data, see “Preprocess Data”.

Saving the Session

After you process the data, as described in “Plotting and Processing Data” on page 3-9,
you can delete any data sets in the window that you do not need for estimation and
validation, and save your session. You can open this session later and use it as a starting
point for model estimation and validation without repeating these preparatory steps.

You must have already processed the data into the System Identification app, as
described in “Plotting and Processing Data” on page 3-9.

To delete specific data sets from a session and save the session:
1 In the System Identification app:

a Drag and drop the data data set into Trash.
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b Drag and drop the datad data set into Trash.

Alternatively, you can press the Delete key on your keyboard to move the data sets

to Trash.

Note Moving items to the Trash does not delete them. To permanently delete items,
select Options > Empty trash.

The following figure shows the System Identification app after moving the items to

Trash.

Import data -

1
A

data_est data_val

Data Views
Time plot
[ Data =pectra

|:| Frequency function

Import models -
Operations 4
<— Preprocess ~)
]
= data_est
Working Data
Estimate —= -
To To Model Views
Workspace || LTI Viewer Model output Transient resp Monlinear ARX
Model resids Freguency resp Hamm-Wiener
[[]] Zeros and poles
data_val .
Noise spectrum
== Validation Data

The object datad is now in the trash.

2 Dragand drop the data est and data val data sets to fill the empty rectangles, as
shown in the following figure.
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Import data - Import models -
* Operations *
,\J\ <— Preprocess -
data_est data_val 1
]
= data_est
Working Data
Estimate —= hd
Data Views Model Views
To To
V| Time plot Workspace || LTI Viewer Model output Transient resp Monlinear ARX
Data spectra Model resids Frequency resp Hamm-Wiener
Freguency function [[]] W Zeros and poles
data_val Noise spectrum
jic==h Validation Data

3 Select File > Save session as to open the Save Session dialog box, and browse to
the folder where you want to save the session file.

4 In the File name field, type the name of the session dryer2 processed data, and
click Save. The resulting file has a . sid extension.

Tip You can open a saved session when starting the System Identification app by typing
the following command at the MATLAB prompt:

systemIdentification('dryer2 processed data')

For more information about managing sessions, see “Starting and Managing Sessions”.

Estimating Linear Models Using Quick Start

* “How to Estimate Linear Models Using Quick Start” on page 3-22
+ “Types of Quick Start Linear Models” on page 3-23
+ “Validating the Quick Start Models” on page 3-24

How to Estimate Linear Models Using Quick Start

You can use the Quick Start feature in the System Identification app to estimate linear
models. Quick Start might produce the final linear models you decide to use, or provide
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you with information required to configure the estimation of accurate parametric models,
such as time constants, input delays, and resonant frequencies.

You must have already processed the data for estimation, as described in “Plotting and
Processing Data” on page 3-9.

In the System Identification app , select Estimate > Quick start.
This action generates plots of step response, frequency-response, and the output of state-

space and polynomial models. For more information about these plots, see “Validating
the Quick Start Models” on page 3-24.

Import data x| Import models >
Operations
) " 1
,\'/\ <— Preprocess hd
data_est data_val 1 .
=
data_est
Working Data
Estimate —= =
Ty Estimate —= e
ala Views Transfer Function Models... rodel Views
Time plot State Space Models... Model output Transient resp Nonlinear ARX
Process Models...
[] Data spectra Polynomial Models... Model resids Frequency resp Hamm-Wiener
. Nonlinear Models...
|:| Freguency function Zeros and poles
Spectral Models... N
Correlation Models. .. fj'm_l—“'al Noise spectrum
Refine Existing Models... i b

Types of Quick Start Linear Models

Quick Start estimates the following four types of models and adds the following to the
System Identification app with default names:

imp — Step response over a period of time using the impulse algorithm.

spad — Frequency response over a range of frequencies using the spa algorithm. The

frequency response is the Fourier transform of the impulse response of a linear
system.

By default, the model is evaluated at 128 frequency values, ranging from 0 to the
Nyquist frequency.

3-23



3 Linear Model Identification

* arxgs — Fourth-order autoregressive (ARX) model using the arx algorithm.

This model is parametric and has the following structure:
YO+ yE-D+...+a,,yt-n,) =
bijut —ny)+...+ b, ult—ny —ny +1)+e(t)

y(t) represents the output at time ¢, u(z) represents the input at time ¢, n, is the
number of poles, n; is the number of b parameters (equal to the number of zeros plus
1), n;, is the number of samples before the input affects output of the system (called
the delay or dead time of the model), and e(?) is the white-noise disturbance. System

Identification Toolbox software estimates the parameters @; ...a,, and b;...b,, using
the input and output data from the estimation data set.

In arxgs, n,=n,=4, and n, is estimated from the step response model imp.
* n4s3 — State-space model calculated using n4sid. The algorithm automatically

selects the model order (in this case, 3).

This model is parametric and has the following structure:
% = Ax(t) + Bu(¢) + Ke(?)

y(t) = Cx(t) + Du(t) + e(t)
y(t) represents the output at time ¢, u(f) represents the input at time ¢, x is the state

vector, and e(t) is the white-noise disturbance. The System Identification Toolbox
product estimates the state-space matrices A, B, C, D, and K.

Note The Quick Start option does not create a transfer function model or a process model
which can also be good starting model types.

Validating the Quick Start Models

Quick Start generates the following plots during model estimation to help you validate
the quality of the models:

*  Step-response plot

* Frequency-response plot
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*  Model-output plot

You must have already estimated models using Quick Start to generate these plots, as
described in “How to Estimate Linear Models Using Quick Start” on page 3-22.
Step-Response Plot

The following step-response plot shows agreement among the different model structures
and the measured data, which means that all of these structures have similar dynamics.

Tip If you closed the plot window, select the Transient resp check box to reopen this
window. If the plot is empty, click the model icons in the System Identification app
window to display the models on the plot.

u Transient Response: power-=temper... EI@
File Options 5Style  Channel Help
Step Response

1 T T
0.8t
0.6+
0.4t
02t

ot
_uz L L L L

-1 ] 1 2 £l 4

Time
No transient response for SPA model

Step Response for imp, arxgs, and n4s3

Tip You can use the step-response plot to estimate the dead time of linear systems. For
example, the previous step-response plot shows a time delay of about 0.25 s before the
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3-26

system responds to the input. This response delay, or dead time, is approximately equal
to about three samples because the sample time is 0. 08 s for this data set.

Frequency-Response Plot

The following frequency-response plot shows agreement among the different model
structures and the measured data, which means that all of these structures have similar

dynamics.

Tip If you closed this plot window, select the Frequency resp check box to reopen this
window. If the plot is empty, click the model icons in the System Identification app

window to display the models on the plot.

Fregquency response

10
[1k]
R
= 07|
o
=
<
10
2000
= \ﬁ
3 1000}
b
i D—\—_—H
i _‘_'_‘_‘—\—\_._‘_‘_‘_H—q_
o
_1DDD -1 I IIIIIIIII:I I IIIIIIII1 I III”“Q
10 10 10 10

Frequency iradis)

Frequency Response for Models spad, arxqgs, and n4s3
Model-Output Plot

The Model Output window shows agreement among the different model structures and
the measured output in the validation data.
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Tip If you closed the Model Output window, select the Model output check box to
reopen this window. If the plot is empty, click the model icons in the System
Identification app window to display the models on the plot.

u Model Output: temperature EI@
File Options Style  Channel  Experiment Help
Measured and simulated model output
15
Best Fits
1 1 nds3: 89.51
- 80
05 w | angs: 89 44
imp: 89.02
: A
-0.5
-1 \
15}
ey . A L
40 50 60 70 80
Time
No model output for SPA models.

Measured Output and Model Output for Models imp, arxgs, and n4s3

The model-output plot shows the model response to the input in the validation data. The
fit values for each model are summarized in the Best Fits area of the Model Output
window. The models in the Best Fits list are ordered from best at the top to worst at the
bottom. The fit between the two curves is computed such that 100 means a perfect fit,
and 0 indicates a poor fit (that is, the model output has the same fit to the measured
output as the mean of the measured output).

In this example, the output of the models matches the validation data output, which
indicates that the models seem to capture the main system dynamics and that linear
modeling is sufficient.
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Tip To compare predicted model output instead of simulated output, select this option
from the Options menu in the Model Output window.

Estimating Linear Models

+ “Strategy for Estimating Accurate Models” on page 3-28
+ “Estimating Possible Model Orders” on page 3-28

+  “Identifying Transfer Function Models” on page 3-32

+  “Identifying State-Space Models” on page 3-36

+ “Identifying ARMAX Models” on page 3-41

*  “Choosing the Best Model” on page 3-44

Strategy for Estimating Accurate Models

The linear models you estimated in “Estimating Linear Models Using Quick Start” on
page 3-22 showed that a linear model sufficiently represents the dynamics of the system.

In this portion of the tutorial, you get accurate parametric models by performing the
following tasks:

1 Identifying initial model orders and delays from your data using a simple,
polynomial model structure (ARX).

2 Exploring more complex model structures with orders and delays close to the initial
values you found.

The resulting models are discrete-time models.
Estimating Possible Model Orders

To identify black-box models, you must specify the model order. However, how can you
tell what model orders to specify for your black-box models? To answer this question, you
can estimate simple polynomial (ARX) models for a range of orders and delays and
compare the performance of these models. You choose the orders and delays that
correspond to the best model fit as an initial guess for more accurate modeling using
various model structures such as transfer function and state-space models.

About ARX Models

For a single-input/single-output system (SISO), the ARX model structure is:
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yO+ayt-D+...+a,,yt-n,) =
biut —np)+...+bpult —ny, —ny +1) + e(t)

y(t) represents the output at time ¢, u(?) represents the input at time ¢, n, is the number
of poles, n; is the number of zeros plus 1, n, is the input delay—the number of samples

before the input affects the system output (called delay or dead time of the model), and
e(t) is the white-noise disturbance.

You specify the model orders n,, n;, and n;, to estimate ARX models. The System

Identification Toolbox product estimates the parameters ¢ ...a, and by...0,, from the
data.

How to Estimate Model Orders

1 In the System Identification app, select Estimate > Polynomial Models to open
the Polynomial Models dialog box.

Estimate —= A
Estimate —=

Tranzfer Function Modelz. ..
State Space Models. .

Process Models...
Monlinear Models...
Spectral Models...
Correlation Models. ..
Refine Existing Models...
Quick Start

2 From the Structure list, select ARX: [na nb nk]. By default, this is already
selected.

3 Edit the Orders field to try all combinations of poles, zeros, and delays, where each
value is from 1 to 10:

[1:10 1:10 1:10]

3-29



3 Linear Model Identification

e

u Palynomial Models E@

Structure: ARX: [na nb nk] |
Orders: [1:10 1:10 1:1IJ]|

Equation: Ay=Bu+e

Method: @) ARX N

Domain: Continuous @) Dizcrete (0.08 seconds)

|:| Add noige integration ("ARK" model)

Input delay: 0
Name:
FOCUS!| prediction v Initial state: Auto v
Regularization... Covariance: | potimate =
Display progress Stop iterations
[ Order Selection ] [ Order Editor... ]
| Estmate | | ciose | | Help |

4  Click Estimate to open the ARX Model Structure Selection window, which displays
the model performance for each combination of model parameters.

You use this plot to select the best-fit model.
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ARX Model Structure Selection EI@

File Optiocns Style  Help

Model Misfit vs number of pars
2 Mumber of par's

Green: MOL Choice
Blue: AIC Choice 15
1.5 Red- Best Fit Wiz fit=0.201592

na=&
nb=9

nk=2

05 Insert

g J| -5

30

Unexplained outputwariance {in %)

Mumber of pars

Click on bars to inspect models.

The horizontal axis is the total number of parameters — n, + n,,.

The vertical axis, called Unexplained output variance (in %), is the portion of
the output not explained by the model-—the ARX model prediction error for the
number of parameters shown on the horizontal axis.

The prediction error is the sum of the squares of the differences between the
validation data output and the model one-step-ahead predicted output.

n; is the delay.

Three rectangles are highlighted on the plot in green, blue, and red. Each color
indicates a type of best-fit criterion, as follows:

Red — Best fit minimizes the sum of the squares of the difference between the
validation data output and the model output. This rectangle indicates the overall
best fit.

Green — Best fit minimizes Rissanen MDL criterion.

Blue — Best fit minimizes Akaike AIC criterion.
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7
8

In this tutorial, the Unexplained output variance (in %) value remains
approximately constant for the combined number of parameters from 4 to 20. Such
constancy indicates that model performance does not improve at higher orders. Thus,
low-order models might fit the data equally well.

Note When you use the same data set for estimation and validation, use the MDL
and AIC criteria to select model orders. These criteria compensate for overfitting
that results from using too many parameters. For more information about these
criteria, see the selstruc reference page.

In the ARX Model Structure Selection window, click the red bar (corresponding to 15
on the horizontal axis), and click Insert. This selection inserts n,=6, n,=9, and n;,=2
into the Polynomial Models dialog box and performs the estimation.

This action adds the model arx692 to the System Identification app and updates the
plots to include the response of the model.

Note The default name of the parametric model contains the model type and the
number of poles, zeros, and delays. For example, arx692 is an ARX model with n,=6,
n,=9, and a delay of two samples.

In the ARX Model Structure Selection window, click the third bar corresponding to 4
parameters on the horizontal axis (the lowest order that still gives a good fit), and
click Insert.

* This selection inserts n,=2, n;=2, and n,=3 (a delay of three samples) into the
Polynomial Models dialog box and performs the estimation.

* The model arx223 is added to the System Identification app and the plots are
updated to include its response and output.

Click Close to close the ARX Model Structure Selection window.
Click Close to close the Polynomial Models dialog box.

Identifying Transfer Function Models

By estimating ARX models for different order combinations, as described in “Estimating
Possible Model Orders” on page 3-28, you identified the number of poles, zeros, and
delays that provide a good starting point for systematically exploring different models.

The overall best fit for this system corresponds to a model with six poles, nine zeros, and
a delay of two samples. It also showed that a low-order model with n, = 2 (two poles), n, =
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2 (one zero), and n, = 3 (input-output delay) also provides a good fit. Thus, you should
explore model orders close to these values.

In this portion of the tutorial, you estimate a transfer function model.

+ “About Transfer Function Models” on page 3-33
* “How to Estimate Transfer Function Models” on page 3-33

* “Learn More” on page 3-36

About Transfer Function Models

The general transfer function model structure is:

Y(s) = ’;“L((“’))mg L EGs)

en\s

Y(s), U(s) and E(s) represent the Laplace transforms of the output, input and error,
respectively. num(s) and den(s) represent the numerator and denominator polynomials
that define the relationship between the input and the output. The roots of the
denominator polynomial are referred to as the model poles. The roots of the numerator
polynomial are referred to as the model zeros.

You must specify the number of poles and zeros to estimate a transfer function model.
The System Identification Toolbox product estimates the numerator and denominator
polynomials, and input/output delays from the data.

The transfer function model structure is a good choice for quick estimation because it
requires that you specify only 2 parameters to get started: np is the number of poles and
nz is the number of zeros.

How to Estimate Transfer Function Models

1 In the System Identification app, select Estimate > Transfer Function Models to
open the Transfer Functions dialog box.
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Estimate —= ~4

Estimate —=
Transfer Function Models... *

State Space Models...
Process Models...
Pohynomial Models. ..
Monlinear Models...
Spectral Models. ..
Correlation Models...
Refine Existing Models...
Quick Start

In the Transfer Functions dialog box, specify the following options:

+ Number of poles — Leave the default value 2 to specify a second order function,
for two poles.
Number of zeros — Leave the default value 1.

+ Continuous-time — Leave this checked.

Click I/0 Delay to expand the input/output delay specification area.

By estimating ARX models for different order combinations, as described in

“Estimating Possible Model Orders” on page 3-28, you identified a 3 sample delay

(nk = 3). This delay translates to a continuous-time delay of (nk-1) *Ts , which is
equal to 0.16 seconds.

Specify Delay as 0.16 seconds. Leave Fixed checked.

Use the default Estimation Options. By default, the app assigns the name t£1 to the
model. The dialog box should look like this.
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4\ Transfer Functions EI@

Model name: tf1 &

Mumber of poles: |2

MNumber of zeros: |1

() Discrete-time (Ts = 0.08) Feedthrough

v [/O Delay

Output:  y1

Input Delay Fixed Minimum  Maximum
power 0.16 | o 2.4

b Estimation Options

| Esimate | | Close | | Help |

Click Estimate to add a transfer function model called tf1 to the System
Identification app. You can view the output of the estimation of the transfer function
model in comparison with the estimations of other models, in the Model output

window.
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Model Output: terperature E'@
File Opticns Style  Channel Experiment Help
Measured and simulated model output
15 . .
. lﬁ ” | _ Best Fits
1t [ b i1 4 laBoz: 80,7
o l"u |, th,ll '_. l-.l:'l'll arxG92: 89.78
i -' ! k] nds3: 89.51
05 L 1 '] ! -"I.- | “- 1 W5
v iar 1 angs: 89.44
ol AT ! 1| i
]
LI Y A T
080 E, 1) | I JLJ ' | [ara223: 89.02
vil 1 (][] f imp: 59.02
e I[]
'1 L ! Wt -II«. r I||I
A5 k) 1l y ! o
-2 I I I
40 50 60 0 a0
Time
Mo model output for SPA models.

-

Tip If you closed the Model Output window, you can regenerate it by selecting the
Model output check box in the System Identification app. If the new model does not
appear on the plot, click the model icon in the System Identification app to make the

model active.

5

Learn More

To learn more about identifying transfer function models, see “Transfer Function

Models”.

Identifying State-Space Models

By estimating ARX models for different order combinations, as described in “Estimating
Possible Model Orders” on page 3-28, you identified the number of poles, zeros, and
delays that provide a good starting point for systematically exploring different models.
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The overall best fit for this system corresponds to a model with six poles, nine zeros, and
a delay of two samples. It also showed that a low-order model with n,=2 (two poles), n,=2
(one zero), and n;,=3 (input-output delay) also provides a good fit. Thus, you should
explore model orders close to these values.

In this portion of the tutorial, you estimate a state-space model.

+ “About State-Space Models” on page 3-37
+ “How to Estimate State-Space Models” on page 3-37
* “Learn More” on page 3-40

About State-Space Models

The general state-space model structure (innovation form) is:

% = Ax(t) + Bu(d) + Ke(t)

y(#) = Cx(t) + Du(t) + e(t)

y(t) represents the output at time ¢, u(?) represents the input at time ¢, x(z) is the state
vector at time ¢, and e(?) is the white-noise disturbance.

You must specify a single integer as the model order (dimension of the state vector) to
estimate a state-space model. The System Identification Toolbox product estimates the
state-space matrices A, B, C, D, and K from the data.

The state-space model structure is a good choice for quick estimation because it requires
that you specify only the number of states (which equals the number of poles). You can
optionally also specify the delays and feedthrough behavior.

How to Estimate State-Space Models

1 In the System Identification app, select Estimate > State Space Models to open
the State Space Models dialog box.
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2

Eztimate —= ~4

Estimate —=
Transfer Function Models. ..

State Space Modelz...
Procesz Models...
Pohynomial Models. ..
Monlinear Models...
Spectral Models...
Correlation Models...
Refine Existing Models...
Quick Start

In the Specify value field, specify the model order. Type 6 to create a sixth-order
state-space model.

This choice is based on the fact that the best-fit ARX model has six poles.

Tip Although this tutorial estimates a sixth-order state-space model, you might want
to explore whether a lower-order model adequately represents the system dynamics.

Click Estimation Options to expand the estimation options area.

Change Focus to Simulation to optimize the model to use for output simulation.

The State Space Models dialog box looks like the following figure.
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4\ State Space Models

Model name: ss1 &

Model Order:

@ Specify value: 6

_) Pick best value in the range: | 1:10
@ Continuous-time 1 Discrete-time (Ts = 0.1)

b Model Structure Configuration
w Estimation Options
Estimation Method: lSubspace (MN45ID)

M4Weight: Aute T | NdHorizon: |Aute

Focus

Allow unstable models
Estimate covariance
Display progress

Initial states: Aute x|

| Estimate | | Close | | Help

Click Estimate to add a state-space model called ss1 to the System Identification

app.

You can view the output of the estimation of the state-space model in comparison
with the estimations of other models, in the Model output window.
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n Model Output: terperature E'@
File Opticns Style Channel Experiment Help
Measured and simulated model output
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Best Fits
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Mo model output for SPA models.

Tip If you closed the Model Output window, you can regenerate it by selecting the
Model output check box in the System Identification app. If the new model does not
appear on the plot, click the model icon in the System Identification app to make the
model active.

6 Click Close to close the State Space Models dialog box.

Learn More

To learn more about identifying state-space models, see “State-Space Models”.
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Identifying ARMAX Models

By estimating ARX models for different order combinations, as described in “Estimating
Possible Model Orders” on page 3-28, you identified the number of poles, zeros, and
delays that provide a good starting point for systematically exploring different models.

The overall best fit for this system corresponds to a model with six poles, nine zeros, and
a delay of two samples. It also showed that a low-order model with n,=2 (two poles), n,=2
(one zero), and n;,=3 also provides a good fit. Thus, you should explore model orders close
to these values.

In this portion of the tutorial, you estimate an ARMAX input-output polynomial model.

+ “About ARMAX Models” on page 3-41
+ “How to Estimate ARMAX Models” on page 3-42
* “Learn More” on page 3-44

About ARMAX Models

For a single-input/single-output system (SISO), the ARMAX polynomial model structure
is:
YO+ aryE —1D+...+ apg yt —ny) =

biut —ny)+...+bpult—n, —ny +1)+

et)+cet—1)+...+c et —ng)

y(t) represents the output at time ¢, u(?) represents the input at time ¢, n, is the number
of poles for the dynamic model, n; is the number of zeros plus 1, n, is the number of poles
for the disturbance model, n; is the number of samples before the input affects output of
the system (called the delay or dead time of the model), and e(%) is the white-noise
disturbance.

Note The ARMAX model is more flexible than the ARX model because the ARMAX
structure contains an extra polynomial to model the additive disturbance.

You must specify the model orders to estimate ARMAX models. The System
Identification Toolbox product estimates the model parameters @; ..., , by...b,  and

¢ ---¢, from the data.
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How to Estimate ARMAX Models

1 In the System Identification app , select Estimate > Polynomial Models to open
the Polynomial Models dialog box.

Estimate —= &l
Estimate —=

Transfer Function Models...
Slate Space Models...

Process Models...
Monlinear Models...
Spectral Models...
Correlation Models. ..
Refine Existing Models...

Quick Start
2 From the Structure list, select ARMAX: [na nb nc nk] to estimate an ARMAX
model.
ARX: [na nb nk] I
ARM: [na nb nk]

ARMAX: [na nb nc nk) *

QE: [nk nf nk]
BJ: [nb nc nd nf nk]

3 Inthe Orders field, set the orders na, nb, nc, and nk to the following values:

[2 2 2 2]

The app assigns the name to the model amx2222, by default, visible in the Name
field.
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u Polynomial Models

=5

Structure: ARMAX: [na nb nc nk]

Orders: [22232)

|:| Add noise integration ("ARIMAX" model)

Input delay: o

Name: amxz2Z2

Eguation: Ay=Bu+Ce
Method: Prediction error method

Domain: Continuous @ Discrete (0.08 seconds)

Focus:| oo diction 4 Initial sta

Regularization. . Covariance:

te: Auto ¥ |

Estimate hd

D Display progress

Stop iterations.

[ tteration Options... ] [

Crder Editor... ]

[ Estmate | [ ciose |

[ Hep |

4  Click Estimate to add the ARMAX model to the System Identification app.

5 Repeat steps 3 and 4 using higher Orders 3 3 2 2. These orders result in a model

that fits the data almost as well as the higher order ARX model arx692.
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Model Output: temperature E@
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Tip If you closed the Model Output window, you can regenerate it by selecting the
Model output check box in the System Identification app. If the new model does not
appear on the plot, click the model icon in the System Identification app to make the
model active.

6 Click Close to close the Polynomial Models dialog box.

Learn More

To learn more about identifying input-output polynomial models, such as ARMAX, see
“Input-Output Polynomial Models”.

Choosing the Best Model

You can compare models to choose the model with the best performance.
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You must have already estimated the models, as described in “Estimating Linear
Models” on page 3-28.

Summary of Models

The following figure shows the System Identification app, which includes all the
estimated models in “Estimating Linear Models” on page 3-28.

Import data - Import models -
l Operations. l
M <— Preprocess. - \_ k N
data_est data_wval imp spad arxgs nds3
1 k k |— v
= “
arx692 ark223 | 1 551
= —
data_est '\
Working Data %
am223? amx3322
Data Views Model Views
To To
[T Time plot Workspace || LTI Viewer Model output [T] Transient resp Monlinear ARX
[] Data =pectra [] Model resids [] Frequency resp Hamm-Wiener
|:| Freguency function [[]] |:| Zeros and poles
data_val |:| Noise spectrum

== Validation Data
Examining the Model Output

Examine the model output plot to see how well the model output matches the measured
output in the validation data set. A good model is the simplest model that best describes
the dynamics and successfully simulates or predicts the output for different inputs.
Models are listed by name in the Best Fits area of the Model Output plot. Note that one
of the simpler models, amx3322, produced a similar fit as the highest-order model you
created, arx692.
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Model Qutput: ternperature EI@
File Options Style  Channel Experiment Help
Measured and simulated model output
1.5 . T .
. Best Fits
1t 4 |amxG92: B9.78
i amx3322: 89.6
0.5 ] 1 4z 90 51
arxgs: 89.44
0 1 ]
05 ank223: 89.02
imp: 89.02
-1 ]
-1.5¢ R
2 1 L L
40 50 60 70 20
Time
No medel output for SPA models.

Tip If you closed the Model Output window, you can regenerate it by selecting the Model
output check box in the System Identification app. If the new model does not appear on
the plot, click the model icon in the System Identification app to make the model active.

To validate your models using a different data set, you can drag and drop this data set
into the Validation Data rectangle in the System Identification app. If you transform
validation data into the frequency domain, the Model Output plot updates to show the
model comparison in the frequency domain.

To get a closer look at how well these models fit the data, magnify a portion of the plot by
clicking and dragging a rectangle around the region of interest, as shown in the following
figure.
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Measured and simulated model output
15

0.5 : H

-1 k i
-1.5} L a 1
-2 . . .

40 50 &0 70 a0

Time

Releasing the mouse magnifies this region and shows that the output of all models
matches the validation data well.

Measured and simulated model output

Time
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Viewing Model Parameters

+ “Viewing Model Parameter Values” on page 3-48

+ “Viewing Parameter Uncertainties” on page 3-50
Viewing Model Parameter Values
You can view the numerical parameter values for each estimated model.

You must have already estimated the models, as described in “Estimating Linear
Models” on page 3-28.

To view the parameter values of the model amx3322, right-click the model icon in the
System Identification app. The Data/model Info dialog box opens.
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(] Data/model Info: amex3322 EI@

Model name:

amx3322
Color. [0.1,0,0.6]
Discrete-time ARMAY model: A({z)v(t) = B{zju(t) + C(z)je =

B{z) =1 - 1.508 z~-1 + 0.7293 z~-2 - 0.121% =z~-3

m

B(z) = 0.004256 2~-2 + 0.08201 z~-3 + 0.02642 z~-4
C{z) =1 - 0.5837 z~-1 + 0.2588 =z~-2

Name: amx3322
Sample time: 0.08 seconds

4 L) F

Diary and Motes

% Import data

datad = detrend{data,0)

data est = datad{[1:500])

Opt = armax0ptions;

amx3322 = armax(data estc,[3 3 2 2], Opt)

I Show in LTI Viewer ]

[ Present ]l Export l[ Close ][ Help
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The noneditable area of the Data/model Info dialog box lists the parameter values
correspond to the following difference equation for your system:

y()—1.508y(t—1)+0.7291y(t —2)-0.1219y(t - 3) =
0.004257u(t —2)+0.06201u(t — 3) + 0.02643u(t —4) + e(t) — 0.5835e(t — 1) + 0.2588e(t — 2)

Note The coefficient of u(z-2) is not significantly different from zero. This lack of
difference explains why delay values of both 2 and 3 give good results.

Parameter values appear in the following format:

AR)=1+az !t +.. . +ay,z ™

B(2) =byz ™ 4. 4B,z 0
C@)=1+¢z+.. +c, 2™

The parameters appear in the ARMAX model structure, as follows:
A(@)y(@®) = B(@Q)u(t) + C(qe(t)

which corresponds to this general difference equation:
YO+ a1 yE—D+...+ap, ¥t —n,) =
bju(t —np)+...+b ult—ny, —ny +1)+
e)+cet—1)+...+ ¢ et —ng)

y(t) represents the output at time ¢, u(?) represents the input at time ¢, n, is the number
of poles for the dynamic model, n; is the number of zeros plus 1, n, is the number of poles
for the disturbance model, n; is the number of samples before the input affects output of
the system (called the delay or dead time of the model), and e(z) is the white-noise
disturbance.

Viewing Parameter Uncertainties
You can view parameter uncertainties of estimated models.

You must have already estimated the models, as described in “Estimating Linear
Models” on page 3-28.

To view parameter uncertainties, click Present in the Data/model Info dialog box, and
view the model information at the MATLAB prompt.
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The 1-standard deviation uncertainty for the model parameters is in parentheses next to
each parameter value.

Exporting the Model to the MATLAB Workspace

The models you create in the System Identification app are not automatically available
in the MATLAB workspace. To make a model available to other toolboxes, Simulink, and
System Identification Toolbox commands, you must export your model from the System
Identification app to the MATLAB workspace. For example, if the model is a plant that
requires a controller, you can import the model from the MATLAB workspace into the
Control System Toolbox product.

You must have already estimated the models, as described in “Estimating Linear
Models” on page 3-28.

To export the amx3322 model, drag it to the To Workspace rectangle in the System
Identification app. Alternatively, click Export in the Data/model Info dialog box.
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Import cata v Import models v
& Operstions &
=l =--Preprocess o

cata_est cata_val mp spac arxgs nas?

L] AN T A | r

arxBs2 arx223 | tf1 | ss!
= |;— =
dats_est !\

VWorking Data L}

amx2222 amx3322

Estimate --= b
Data Views Nocel Views
Te To

Time plot Viorkspace (| LTIViewer [ 7] yfGel cutput Transient resp
Data spectra Mocel resids Freguency resp
Freguency function [[]] E ﬁ EE ? Zeros and poles

4 e Neise spectrum

as Valicatior Data

\\home-00-ah\sdas\Documents\ZrsID\1 2RNGAE9ET7_data_esticryer_linear models. sid saved

Drag and drop model to Workspace

The model appears in the MATLAB Workspace browser.

Workspace G
Value Min Max
=1x idpohy=
=1000x1 double> 34100 64100
<1000x1 double> 3.2008 6.2508

Note This model is an idpoly model object.

After the model is in the MATLAB workspace, you can perform other operations on the
model. For example, if you have the Control System Toolbox product installed, you might
transform the model to a state-space object using:

ss_model=ss (amx3322)
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Exporting the Model to the Linear System Analyzer

If you have the Control System Toolbox product installed, the To Linear System
Analyzer rectangle appears in the System Identification app.

The Linear System Analyzer is a graphical user interface for viewing and manipulating
the response plots of linear models. It displays the following plots:

* Step- and impulse-response

* Bode, Nyquist, and Nichols

*  Frequency-response singular values

* Pole/zero

* Response to general input signals

+  Unforced response starting from given initial states (only for state-space models)

To plot a model in the Linear System Analyzer, drag and drop the model icon to the To
Linear System Analyzer rectangle in the System Identification app. Alternatively,
click Show in Linear System Analyzer in the Data/model Info dialog box.

For more information about working with plots in the Linear System Analyzer, see
“Linear System Analyzer Overview” (Control System Toolbox).
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|dentify Linear Models Using the Command Line

3-54

In this section...

“Introduction” on page 3-54

“Preparing Data” on page 3-55

“Estimating Impulse Response Models” on page 3-64

“Estimating Delays in the Multiple-Input System” on page 3-67
“Estimating Model Orders Using an ARX Model Structure” on page 3-68
“Estimating Transfer Functions” on page 3-74

“Estimating Process Models” on page 3-78

“Estimating Black-Box Polynomial Models” on page 3-87

“Simulating and Predicting Model Output” on page 3-98

Introduction

+ “Objectives” on page 3-54
* “Data Description” on page 3-55

Objectives

Estimate and validate linear models from multiple-input/single-output (MISO) data to
find the one that best describes the system dynamics.

After completing this tutorial, you will be able to accomplish the following tasks using
the command line:

+ Create data objects to represent data.

* Plot the data.

*  Process data by removing offsets from the input and output signals.

+  Estimate and validate linear models from the data.

*  Simulate and predict model output.

Note This tutorial uses time-domain data to demonstrate how you can estimate linear
models. The same workflow applies to fitting frequency-domain data.
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Data Description

This tutorial uses the data file co2data.mat, which contains two experiments of two-
input and single-output (MISO) time-domain data from a steady-state that the operator
perturbed from equilibrium values.

In the first experiment, the operator introduced a pulse wave to both inputs. In the
second experiment, the operator introduced a pulse wave to the first input and a step
signal to the second input.

Input 1
Rate of Chemical ——m

Consumption C02 Cutput:
{kg/min) Production |3 Rateofcoz
nput 2 Process (Pr;”?r“nﬁ‘m')”"
Current (A) —————3 2

Preparing Data

* “Loading Data into the MATLAB Workspace” on page 3-55

+  “Plotting the Input/Output Data” on page 3-56

+ “Removing Equilibrium Values from the Data” on page 3-58

+ “Using Objects to Represent Data for System Identification” on page 3-59
* “Creating iddata Objects” on page 3-59

+ “Plotting the Data in a Data Object” on page 3-61

+ “Selecting a Subset of the Data” on page 3-63

Loading Data into the MATLAB Workspace

Load the data.

load co2data

This command loads the following five variables into the MATLAB Workspace:

* Input expl and Output expl are the input and output data from the first
experiment, respectively.

* Input exp2 and Output exp2 are the input and output data from the second
experiment, respectively.
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* Time is the time vector from 0 to 1000 minutes, increasing in equal increments of 0.5
min.

For both experiments, the input data consists of two columns of values. The first column
of values is the rate of chemical consumption (in kilograms per minute), and the second
column of values is the current (in amperes). The output data is a single column of the
rate of carbon-dioxide production (in milligrams per minute).

Plotting the Input/Output Data

Plot the input and output data from both experiments.

plot (Time, Input expl, Time, Output expl)
legend('Input 1', "Input 2', 'Output 1')
figure

plot (Time, Input exp2, Time, Output exp2)
legend('Input 1', "Input 2', 'Output 1")
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Input 1
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Output 1
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The first plot shows the first experiment, where the operator applies a pulse wave to each
input to perturb it from its steady-state equilibrium.

The second plot shows the second experiment, where the operator applies a pulse wave to
the first input and a step signal to the second input.

Removing Equilibrium Values from the Data

Plotting the data, as described in “Plotting the Input/Output Data” on page 3-56, shows
that the inputs and the outputs have nonzero equilibrium values. In this portion of the
tutorial, you subtract equilibrium values from the data.

The reason you subtract the mean values from each signal is because, typically, you build
linear models that describe the responses for deviations from a physical equilibrium.
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With steady-state data, it is reasonable to assume that the mean levels of the signals
correspond to such an equilibrium. Thus, you can seek models around zero without
modeling the absolute equilibrium levels in physical units.

Zoom 1in on the plots to see that the earliest moment when the operator applies a
disturbance to the inputs occurs after 25 minutes of steady-state conditions (or after the
first 50 samples). Thus, the average value of the first 50 samples represents the
equilibrium conditions.

Use the following commands to remove the equilibrium values from inputs and outputs
in both experiments:

Input expl = Input expl-...

ones (size (Input expl,1l),1)*mean(Input expl(1:50,:));
Output expl = Output expl-...

mean (Output expl (1:50,:));
Input exp2 = Input exp2-...

ones (size (Input exp2,1),1)*mean(Input exp2(1:50,:));
Output exp2 = Output exp2-...

mean (Output exp2(1:50,:));

Using Objects to Represent Data for System Identification

The System Identification Toolbox data objects, iddata and idfrd, encapsulate data
values and data properties into a single entity. You can use the System Identification
Toolbox commands to conveniently manipulate these data objects as single entities.

In this portion of the tutorial, you create two iddata objects, one for each of the two
experiments. You use the data from Experiment 1 for model estimation, and the data
from Experiment 2 for model validation. You work with two independent data sets
because you use one data set for model estimation and the other for model validation.

Note When two independent data sets are not available, you can split one data set into
two parts, assuming that each part contains enough information to adequately represent
the system dynamics.

Creating iddata Objects

You must have already loaded the sample data into the MATLAB workspace, as
described in “Loading Data into the MATLAB Workspace” on page 3-55.
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Use these commands to create two data objects, ze and zv :

Ts = 0.5; % Sample time is 0.5 min
iddata (Output expl, Input expl,Ts);
iddata (Output exp2, Input exp2,Ts);

ze =
zv =

ze contains data from Experiment 1 and zv contains data from Experiment 2. Ts is the
sample time.

The iddata constructor requires three arguments for time-domain data and has the

following syntax:
data obj = iddata(output, input, sampling interval);

To view the properties of an iddata object, use the get command. For example, type this
command to get the properties of the estimation data:

get (ze)

struct with fields:
Domain: 'Time'
Name: "'
OutputData: [2001x1 double]
y: 'Same as OutputData'
OutputName: {'yl'}
OutputUnit: {''}
InputData: [2001x2 double]
u: 'Same as InputData'
InputName: {2x1 cell}
InputUnit: {2x1 cell}
Period: [2x1 double]
InterSample: {2x1 cell}
Ts: 0.5000
Tstart: []
SamplingInstants: [2001x0 double]
TimeUnit: 'seconds'
ExperimentName: 'Expl'
Notes: {}
UserData: []

3-60



Identify Linear Models Using the Command Line

To learn more about the properties of this data object, see the iddata reference page.

To modify data properties, you can use dot notation or the set command. For example, to

assign channel names and units that label plot axes, type the following syntax in the
MATLAB Command Window:

% Set time units to minutes

ze.TimeUnit = 'min';
% Set names of input channels
ze.InputName = {'ConsumptionRate', 'Current'};

% Set units for input variables
ze.InputUnit = {'kg/min', 'A'};
% Set name of output channel

ze.OutputName = 'Production';
% Set unit of output channel
ze.OutputUnit = 'mg/min';

% Set validation data properties

zv.TimeUnit = 'min';

zv.InputName {'ConsumptionRate', '"Current'};
zv.InputUnit = {'kg/min', 'A'};

zv.OutputName 'Production';

zv.OutputUnit 'mg/min';

You can verify that the ITnputName property of ze is changed, or "index" into this
property:

ze.linputname;

Tip Property names, such as InputUnit, are not case sensitive. You can also abbreviate
property names that start with Input or Output by substituting u for Input and y for
Output in the property name. For example, OutputUnit is equivalent to yunit.

Plotting the Data in a Data Object
You can plot iddata objects using the plot command.

Plot the estimation data.

plot (ze)
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Input-Output Data
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The bottom axes show inputs ConsumptionRate and Current, and the top axes show
the output ProductionRate .

Plot the validation data in a new figure window.

figure
plot (zv)
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Input-Output Data
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Zoom in on the plots to see that the experiment process amplifies the first input
(ConsumptionRate ) by a factor of 2, and amplifies the second input (Current ) by a

factor of 10.
Selecting a Subset of the Data

Before you begin, create a new data set that contains only the first 1000 samples of the
original estimation and validation data sets to speed up the calculations.

zel = ze(1:1000);
zZvl = zv(1:1000);

For more information about indexing into iddata objects, see the corresponding
reference page.
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Estimating Impulse Response Models

+ “Why Estimate Step- and Frequency-Response Models?” on page 3-64
+ “Estimating the Frequency Response” on page 3-64
+ “Estimating the Empirical Step Response” on page 3-65

Why Estimate Step- and Frequency-Response Models?

Frequency-response and step-response are nonparametric models that can help you
understand the dynamic characteristics of your system. These models are not
represented by a compact mathematical formula with adjustable parameters. Instead,
they consist of data tables.

In this portion of the tutorial, you estimate these models using the data set ze. You must
have already created ze, as described in “Creating iddata Objects” on page 3-59.

The response plots from these models show the following characteristics of the system:

* The response from the first input to the output might be a second-order function.

* The response from the second input to the output might be a first-order or an
overdamped function.

Estimating the Frequency Response

The System Identification Toolbox product provides three functions for estimating the
frequency response:

* etfe computes the empirical transfer function using Fourier analysis.

* spa estimates the transfer function using spectral analysis for a fixed frequency
resolution.

* spafdr lets you specify a variable frequency resolution for estimating the frequency
response.

Use spa to estimate the frequency response.
Ge = spal(ze);

Plot the frequency response as a Bode plot.

bode (Ge)
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The amplitude peaks at the frequency of about 0.7 rad/s, which suggests a possible
resonant behavior (complex poles) for the first input-to-output combination -
ConsumptionRate to Production.

In both plots, the phase rolls off rapidly, which suggests a time delay for both input/
output combinations.

Estimating the Empirical Step Response

To estimate the step response from the data, first estimate a non-parametric impulse
response model (FIR filter) from data and then plot its step response.

% model estimation
Mimp = impulseest (Zel, 60);
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% step response

step (Mimp)
Step Response
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The step response for the first input/output combination suggests an overshoot, which
indicates the presence of an underdamped mode (complex poles) in the physical system.

The step response from the second input to the output shows no overshoot, which
indicates either a first-order response or a higher-order response with real poles

(overdamped response).

The step-response plot indicates a nonzero delay in the system, which is consistent with
the rapid phase roll-off you got in the Bode plot you created in “Estimating the Empirical
Step Response” on page 3-65.
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Estimating Delays in the Multiple-Input System

+ “Why Estimate Delays?” on page 3-67
+ “Estimating Delays Using the ARX Model Structure” on page 3-67
+ “Estimating Delays Using Alternative Methods” on page 3-68

Why Estimate Delays?

To identify parametric black-box models, you must specify the input/output delay as part
of the model order.

If you do not know the input/output delays for your system from the experiment, you can
use the System Identification Toolbox software to estimate the delay.

Estimating Delays Using the ARX Model Structure

In the case of single-input systems, you can read the delay on the impulse-response plot.
However, in the case of multiple-input systems, such as the one in this tutorial, you
might be unable to tell which input caused the initial change in the output and you can
use the delayest command instead.

The command estimates the time delay in a dynamic system by estimating a low-order,
discrete-time ARX model with a range of delays, and then choosing the delay that
corresponding to the best fit.

The ARX model structure is one of the simplest black-box parametric structures. In
discrete-time, the ARX structure is a difference equation with the following form:

yO+ayE-D+...+a,,yt-n,) =
biut —ng)+...+b,pult—n, —ny +1) + e(t)

y(t) represents the output at time ¢, u(?) represents the input at time ¢, n, is the number
of poles, n, is the number of b parameters (equal to the number of zeros plus 1), n,; is the
number of samples before the input affects output of the system (called the delay or dead
time of the model), and e(t) is the white-noise disturbance.

delayest assumes that n,=n,=2 and that the noise e is white or insignificant, and
estimates n,,.

To estimate the delay in this system, type:

delayest (ze)
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3-68

This result includes two numbers because there are two inputs: the estimated delay for
the first input is 5 data samples, and the estimated delay for the second input is 10 data
samples. Because the sample time for the experiments is 0.5 min, this corresponds to a
2.5 -min delay before the first input affects the output, and a 5.0 -min delay before the
second input affects the output.

Estimating Delays Using Alternative Methods
There are two alternative methods for estimating the time delay in the system:

*  Plot the time plot of the input and output data and read the time difference between
the first change in the input and the first change in the output. This method is
practical only for single-input/single-output system; in the case of multiple-input
systems, you might be unable to tell which input caused the initial change in the
output.

+ Plot the impulse response of the data with a 1-standard-deviation confidence region.
You can estimate the time delay using the time when the impulse response is first
outside the confidence region.

Estimating Model Orders Using an ARX Model Structure

* “Why Estimate Model Order?” on page 3-68

+ “Commands for Estimating the Model Order” on page 3-69

+ “Model Order for the First Input-Output Combination” on page 3-71

+ “Model Order for the Second Input-Output Combination” on page 3-73

Why Estimate Model Order?

Model order is one or more integers that define the complexity of the model. In general,
model order is related to the number of poles, the number of zeros, and the response
delay (time in terms of the number of samples before the output responds to the input).
The specific meaning of model order depends on the model structure.

To compute parametric black-box models, you must provide the model order as an input.
If you do not know the order of your system, you can estimate it.
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After completing the steps in this section, you get the following results:

+ For the first input/output combination: n,=2, n,=2, and the delay n,=5.
*  For the second input/output combination: n,=1, n,=1, and the delay n,=10.

Later, you explore different model structures by specifying model-order values that are
slight variations around these initial estimate.

Commands for Estimating the Model Order

In this portion of the tutorial, you use struc, arxstruc, and selstruc to estimate and
compare simple polynomial (ARX) models for a range of model orders and delays, and
select the best orders based on the quality of the model.

The following list describes the results of using each command.:
* struc creates a matrix of model-order combinations for a specified range of n,, n,,

and n;, values.

* arxstruc takes the output from struc, systematically estimates an ARX model for
each model order, and compares the model output to the measured output. arxstruc
returns the loss function for each model, which is the normalized sum of squared
prediction errors.

* selstruc takes the output from arxstruc and opens the ARX Model Structure
Selection window, which resembles the following figure, to help you choose the model
order.

You use this plot to select the best-fit model.
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ARX Model Structure Selection EI@
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Click on bars to inspect models.

The horizontal axis is the total number of parameters — n, + n,,.

The vertical axis, called Unexplained output variance (in %), is the portion of
the output not explained by the model-—the ARX model prediction error for the
number of parameters shown on the horizontal axis.

The prediction error is the sum of the squares of the differences between the
validation data output and the model one-step-ahead predicted output.

n; 1s the delay.

Three rectangles are highlighted on the plot in green, blue, and red. Each color
indicates a type of best-fit criterion, as follows:

Red — Best fit minimizes the sum of the squares of the difference between the
validation data output and the model output. This rectangle indicates the overall
best fit.

Green — Best fit minimizes Rissanen MDL criterion.

Blue — Best fit minimizes Akaike AIC criterion.
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In this tutorial, the Unexplained output variance (in %) value remains
approximately constant for the combined number of parameters from 4 to 20. Such
constancy indicates that model performance does not improve at higher orders. Thus,
low-order models might fit the data equally well.

Note When you use the same data set for estimation and validation, use the MDL and
AIC criteria to select model orders. These criteria compensate for overfitting that
results from using too many parameters. For more information about these criteria,
see the selstruc reference page.

Model Order for the First Input-Output Combination

In this tutorial, there are two inputs to the system and one output and you estimate
model orders for each input/output combination independently. You can either estimate
the delays from the two inputs simultaneously or one input at a time.

It makes sense to try the following order combinations for the first input/output
combination:

* n,/2:5
* nb=1 :5
* nk:5

This is because the nonparametric models you estimated in “Estimating Impulse
Response Models” on page 3-64 show that the response for the first input/output
combination might have a second-order response. Similarly, in “Estimating Delays in the
Multiple-Input System” on page 3-67, the delay for this input/output combination was
estimated to be 5.

To estimate model order for the first input/output combination:

1 Use struc to create a matrix of possible model orders.

NN1 = struc(2:5,1:5,5);

2 Use selstruc to compute the loss functions for the ARX models with the orders in
NN1.

selstruc (arxstruc(ze(:,:,1),2zv(:,:,1),NN1))

Note ze (:, :,1) selects the first input in the data.
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This command opens the interactive ARX Model Structure Selection window.

ARX Model Structure %ection EI@

File Optiocns Style  Help

Model Misfit vs number of pars

Mumber of par's
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= Blue: AIC Choice| | 5

[1¥]

2 Red: Best Fit Misfit=0.85807
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= [ selct |
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3 Close

=
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0 Help
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Mumber of pars

Inspect models by clicking bars or press SELECT.

Note The Rissanen MDL and Akaike AIC criteria produces equivalent results and
are both indicated by a blue rectangle on the plot.

The red rectangle represents the best overall fit, which occurs for n,=2, n,=3, and
n;,=5. The height difference between the red and blue rectangles is insignificant.
Therefore, you can choose the parameter combination that corresponds to the lowest
model order and the simplest model.

Click the blue rectangle, and then click Select to choose that combination of orders:
n,=2
nb=2

nk:5

To continue, press any key while in the MATLAB Command Window.
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Model Order for the Second Input-Output Combination

It makes sense to try the following order combinations for the second input/output
combination:

* ng~1:3
* nb:l : 3
° nk=10

This is because the nonparametric models you estimated in “Estimating Impulse
Response Models” on page 3-64 show that the response for the second input/output
combination might have a first-order response. Similarly, in “Estimating Delays in the
Multiple-Input System” on page 3-67, the delay for this input/output combination was
estimated to be 10.

To estimate model order for the second input/output combination:

1 Use struc to create a matrix of possible model orders.

NN2 = struc(1:3,1:3,10);

2 Use selstruc to compute the loss functions for the ARX models with the orders in
NN2.

selstruc (arxstruc(ze(:,:,2),zv(:,:,2),NN2))

This command opens the interactive ARX Model Structure Selection window.
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e

ARX Model Structure Selection [E EI@

File Optiocns Style  Help

Model Misfit vs number of pars

Mumber of par's
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Inspect models by clicking bars or press SELECT.

Note The Akaike AIC and the overall best fit criteria produces equivalent results.
Both are indicated by the same red rectangle on the plot.

The height difference between all of the rectangles is insignificant and all of these
model orders result in similar model performance. Therefore, you can choose the
parameter combination that corresponds to the lowest model order and the simplest
model.

3  Click the yellow rectangle on the far left, and then click Select to choose the lowest
order: n,=1, n,=1, and n,=10.

4  To continue, press any key while in the MATLAB Command Window.

Estimating Transfer Functions

+  “Specifying the Structure of the Transfer Function” on page 3-75
+ “Validating the Model” on page 3-76
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+ “Residual Analysis” on page 3-77
Specifying the Structure of the Transfer Function

In this portion of the tutorial, you estimate a continuous-time transfer function. You
must have already prepared your data, as described in “Preparing Data” on page 3-55.
You can use the following results of estimated model orders to specify the orders of the
model:

*  For the first input/output combination, use:

Two poles, corresponding to na=2 in the ARX model.
* Delay of 5, corresponding to nk=5 samples (or 2.5 minutes) in the ARX model.

*  For the second input/output combination, use:

One pole, corresponding to na=1 in the ARX model
+ Delay of 10, corresponding to nk=10 samples (or 5 minutes) in the ARX model.

You can estimate a transfer function of these orders using the t fest command. For the
estimation, you can also choose to view a progress report by setting the Display option
to on in the option set created by the t festOptions command.

Opt = tfestOptions('Display','on');
Collect the model orders and delays into variables to pass to tfest.

np = [2 1];
ioDelay = [2.5 5];

Estimate the transfer function.

mtf = tfest(Zel,np, [],ioDelay,Opt);

View the model's coefficients.

mtf
mtf =
From input "ConsumptionRate" to output "Production":
72.13 s - 1.252
exp(-2.5%s) * ———-m—mmmmmmmm
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s*2 + 25.57 s + 0.9572

From input "Current" to output "Production":
5.234
exp (=5*s) * ——-—-————-
s + 0.5132

Continuous-time identified transfer function.
Parameterization:
Number of poles: [2 1] Number of zeros: [1 0]

Number of free coefficients: 6
Use "tfdata", "getpvec", "getcov" for parameters and their uncertainties.

Status:

Estimated using TFEST on time domain data "Zel".

Fit to estimation data: 85.72%

FPE: 6.523, MSE: 6.407

The model's display shows more than 85% fit to estimation data.

Validating the Model

In this portion of the tutorial, you create a plot that compares the actual output and the
model output using the compare command.

compare (Zvl, mtf)
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Amplitude

Simulated Response Comparison
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The comparison shows about 60% fit.

Residual Analysis

400 450

500

Use the resid command to evaluate the characteristics of the residuals.

resid (Zvl, mtf)
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Amplitude

3-78

Residue Correlation
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The residuals show high degree of auto-correlation. This is not unexpected since the
model mt £ does not have any components to describe the nature of the noise separately.
To model both the measured input-output dynamics and the disturbance dynamics you
will need to use a model structure that contains elements to describe the noise
component. You can use b, ssest and procest commands, which create models of
polynomial, state-space and process structures respectively. These structures, among
others, contain elements to capture the noise behavior.

Estimating Process Models

* “Specifying the Structure of the Process Model” on page 3-79
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+ “Viewing the Model Structure and Parameter Values” on page 3-80
+  “Specifying Initial Guesses for Time Delays” on page 3-81

+ “Estimating Model Parameters Using procest” on page 3-81

+ “Validating the Model” on page 3-83

+ “Estimating a Process Model with Noise Model” on page 3-85

Specifying the Structure of the Process Model

In this portion of the tutorial, you estimate a low-order, continuous-time transfer
function (process model). the System Identification Toolbox product supports continuous-
time models with at most three poles (which might contain underdamped poles), one
zero, a delay element, and an integrator.

You must have already prepared your data, as described in “Preparing Data” on page 3-
55.

You can use the following results of estimated model orders to specify the orders of the
model:

*  For the first input/output combination, use:

* Two poles, corresponding to n,=2 in the ARX model.
+ Delay of 5, corresponding to n,=5 samples (or 2.5 minutes) in the ARX model.

*  For the second input/output combination, use:

*  One pole, corresponding to n,=1 in the ARX model.
+ Delay of 10, corresponding to n;=10 samples (or 5 minutes) in the ARX model.

Note Because there is no relationship between the number of zeros estimated by the
discrete-time ARX model and its continuous-time counterpart, you do not have an
estimate for the number of zeros. In this tutorial, you can specify one zero for the first
input/output combination, and no zero for the second-output combination.

Use the idproc command to create two model structures, one for each input/output
combination:

midprocO0 = idproc ({'P2ZUD','P1D"}, 'TimeUnit', 'minutes');
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The cell array { 'P22UD', 'P1D"'} specifies the model structure for each input/output
combination:

* 'P2ZUD' represents a transfer function with two poles ( P2 ), one zero ( Z ),
underdamped (complex-conjugate) poles (U ) and a delay (D).

* 'P1D' represents a transfer function with one pole ( P1 ) and a delay (D).
The example also uses the TimeUnit parameter to specify the unit of time used.
Viewing the Model Structure and Parameter Values

View the two resulting models.

midprocO

midprocO =
Process model with 2 inputs: y = Gll(s)ul + G1l2(s)u2
From input 1 to output 1:
1+Tz*s
Gll(s) = Kp * —====—=——————————————-— * exp (-Td*s)
1+2%Zeta*Twrs+ (Tw*s) ~2

Kp = NaN
Tw = NaN
Zeta = NaN
Td = NaN
Tz = NaN

From input 2 to output 1:

Kp
Gl2(s) = ————=—————-— * exp (-Td*s)
1+Tpl*s
Kp = NaN
Tpl = NaN
Td = NaN

Parameterization:
'P2DUZ"’ 'P1D'
Number of free coefficients: 8
Use "getpvec", "getcov" for parameters and their uncertainties.
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Status:
Created by direct construction or transformation. Not estimated.

The parameter values are set to NaN because they are not yet estimated.
Specifying Initial Guesses for Time Delays

Set the time delay property of the model object to 2.5 min and 5 min for each input/
output pair as initial guesses. Also, set an upper limit on the delay because good initial
guesses are available.

midprocO.Structure(l,1).Td.Value = 2.5;

midprocO.Structure(1l,2).Td.Value = 5;

midprocO.Structure(l,1).Td.Maximum =
(1,2)

3;
midprocO.Structure .Td.Maximum = 7

’ ’

Note When setting the delay constraints, you must specify the delays in terms of actual
time units (minutes, in this case) and not the number of samples.

Estimating Model Parameters Using procest

procest 1s an iterative estimator of process models, which means that it uses an
iterative nonlinear least-squares algorithm to minimize a cost function. The cost function
is the weighted sum of the squares of the errors.

Depending on its arguments, procest estimates different black-box polynomial models.
You can use procest, for example, to estimate parameters for linear continuous-time
transfer-function, state-space, or polynomial model structures. To use procest, you
must provide a model structure with unknown parameters and the estimation data as
input arguments.

For this portion of the tutorial, you must have already defined the model structure, as
described in “Specifying the Structure of the Process Model” on page 3-79. Use midproc0
as the model structure and Ze1 as the estimation data:

midproc = procest (Zel,midprocO) ;

present (midproc)

midproc =
Process model with 2 inputs: y = Gll(s)ul + G1l2(s)u2
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From input "ConsumptionRate" to output "Production":
1+Tz*s
Gll(s) = Kp * —===——=—=————————————-— * exp (-Td*s)
1+2*Zeta*Tw*s+ (Tw*s) "2

Kp = -1.1807 +/- 0.29986

Tw = 1.6437 +/- 714.6
Zeta = 16.036 +/- 6958.9

Td 2.426 +/- 64.276

Tz -109.19 +/- 63.733

From input "Current" to output "Production":
Kp

Kp = 10.264 +/- 0.048404
Tpl = 2.049 +/- 0.054901
Td = 4.9175 +/- 0.034374

Parameterization:
'P2DUZ’ 'P1D'
Number of free coefficients: 8
Use "getpvec", "getcov" for parameters and their uncertainties.

Status:
Termination condition: Maximum number of iterations reached.
Number of iterations: 20, Number of function evaluations: 279

Estimated using PROCEST on time domain data "Zel".
Fit to estimation data: 86.2%

FPE: 6.081, MSE: 5.984

More information in model's "Report" property.

Unlike discrete-time polynomial models, continuous-time models let you estimate the
delays. In this case, the estimated delay values are different from the initial guesses you
specified of 2.5 and 5, respectively. The large uncertainties in the estimated values of
the parameters of G 1 (s) indicate that the dynamics from input 1 to the output are not
captured well.

To learn more about estimating models, see “Process Models”.
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Amplitude

Validating the Model

In this portion of the tutorial, you create a plot that compares the actual output and the

model output.

compare (Zvl,midproc)

Simulated Response Comparison
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The plot shows that the model output reasonably agrees with the measured output: there
1s an agreement of 60% between the model and the validation data.

Use resid to perform residual analysis.

resid (Zvl,midproc)
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Residue Correlation
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The cross-correlation between the second input and residual errors is significant. The
autocorrelation plot shows values outside the confidence region and indicates that the
residuals are correlated.

Change the algorithm for iterative parameter estimation to Levenberg-Marquardt.
Opt = procestOptions;
Opt.SearchMethod = 'Im';

midprocl = procest (Zel,midproc,Opt) ;

Tweaking the algorithm properties or specifying initial parameter guesses and rerunning
the estimation may improve the simulation results. Adding a noise model may improve
prediction results but not necessarily the simulation results.
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Estimating a Process Model with Noise Model

This portion of the tutorial shows how to estimate a process model and include a noise
model in the estimation. Including a noise model typically improves model prediction
results but not necessarily the simulation results.

Use the following commands to specify a first-order ARMA noise:
Opt = procestOptions;

Opt.DisturbanceModel = 'ARMAl';

midproc2 = procest (Zel,midprocO,Opt);

You can type 'dist' instead of 'DisturbanceModel'. Property names are not case
sensitive, and you only need to include the portion of the name that uniquely identifies
the property.

Compare the resulting model to the measured data.

compare (Zvl,midproc2)
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Simulated Response Comparison
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The plot shows that the model output maintains reasonable agreement with the
validation-data output.

Perform residual analysis.

resid(Zvl,midproc?2)
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Amplitude
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The residual plot shows that autocorrelation values are inside the confidence bounds.
Thus adding a noise model produces uncorrelated residuals. This indicates a more
accurate model.

Estimating Black-Box Polynomial Models

* “Model Orders for Estimating Polynomial Models” on page 3-88
+ “Estimating a Linear ARX Model” on page 3-88

+ “Estimating State-Space Models” on page 3-91

+ “Estimating a Box-Jenkins Model” on page 3-94

* “Comparing Model Output to Measured Output” on page 3-96
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Model Orders for Estimating Polynomial Models

In this portion of the tutorial, you estimate several different types of black-box, input-
output polynomial models.

You must have already prepared your data, as described in “Preparing Data” on page 3-
55.

You can use the following previous results of estimated model orders to specify the orders
of the polynomial model:

* For the first input/output combination, use:

Two poles, corresponding to n,=2 in the ARX model.
*  One zero, corresponding to n,=2 in the ARX model.
+ Delay of 5, corresponding to n,=5 samples (or 2.5 minutes) in the ARX model.

*  For the second input/output combination, use:

*  One pole, corresponding to n,=1 in the ARX model.
* No zeros, corresponding to n,=1 in the ARX model.

* Delay of 10, corresponding to n,=10 samples (or 5 minutes) in the ARX model.
Estimating a Linear ARX Model

+ “About ARX Models” on page 3-88
+ “Estimating ARX Models Using arx” on page 3-89
* “Accessing Model Data” on page 3-90

* “Learn More” on page 3-91

About ARX Models

For a single-input/single-output system (SISO), the ARX model structure is:
yO+ayt-D+...+a,,yt-n,) =
bjut —np)+...+b ult—ny —ny +1)+e(?)

y(t) represents the output at time ¢, u(?) represents the input at time ¢, n, is the number
of poles, n, is the number of zeros plus 1, n; is the number of samples before the input
affects output of the system (called the delay or dead time of the model), and e(?) is the
white-noise disturbance.
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The ARX model structure does not distinguish between the poles for individual input/
output paths: dividing the ARX equation by A, which contains the poles, shows that A
appears in the denominator for both inputs. Therefore, you can set n, to the sum of the
poles for each input/output pair, which is equal to 3 in this case.

The System Identification Toolbox product estimates the parameters @, ...a,, and b;...b,
using the data and the model orders you specify.

Estimating ARX Models Using arx
Use arx to compute the polynomial coefficients using the fast, noniterative method arx:

marx = arx(Zel,'na',3,'nb',[2 1], 'nk',[5 10]);

present (marx) % Displays model parameters
% with uncertainty information

marx =
Discrete-time ARX model: A(z)y(t) = B(z)u(t) + e(t)
A(z) =1 - 1.027 (+/- 0.02907) z~-1 + 0.1678 (+/- 0.042) z"-2 + 0.01289 (
+/- 0.02583) z"-3
Bl(z) = 1.86 (+/- 0.189) z~-5 - 1.608 (+/- 0.1888) z"-6
B2(z) = 1.612 (+/- 0.07392) z~-10

Sample time: 0.5 minutes

Parameterization:

Polynomial orders: na=3 nb=[2 1] nk=[5 10]

Number of free coefficients: 6

Use "polydata", "getpvec", "getcov" for parameters and their uncertainties.
Status:

Estimated using ARX on time domain data "Zel".
Fit to estimation data: 90.7% (prediction focus)
FPE: 2.768, MSE: 2.719

More information in model's "Report" property.

MATLAB estimates the polynomials A, B1 , and B2. The uncertainty for each of the
model parameters is computed to 1 standard deviation and appears in parentheses next
to each parameter value.
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Alternatively, you can use the following shorthand syntax and specify model orders as a
single vector:

marx = arx(Zel,[3 2 1 5 10]);

Accessing Model Data

The model you estimated, marx, is a discrete-time idpoly object. To get the properties of
this model object, you can use the get function:

get (marx)

A: [1 -1.0267 0.1678 0.0129]
B: {[0 0O 0 0 0 1.8599 -1.6084] [0 0OO0OO0OO0OOOOOO01.6118]}
C: 1
D: 1
F: {[1] (11}
IntegrateNoise: 0
Variable: 'z"-1"
IODelay: [0 0]
Structure: [1lxl pmodel.polynomiall]
NoiseVariance: 2.7436
Report: [1x1l idresults.arx]

InputDelay: [2x1 double]
OutputDelay: 0
Ts: 0.5000
TimeUnit: 'minutes'
InputName: {2x1 cell}
InputUnit: {2x1 cell}
InputGroup: [1xl struct]
OutputName: {'Production'}
OutputUnit: {'mg/min'}
OutputGroup: [1xl struct]
Notes: [0x1 string]
UserData: []
Name: "'
SamplingGrid: [1x1l struct]

You can access the information stored by these properties using dot notation. For
example, you can compute the discrete poles of the model by finding the roots of the A
polynomial.

marx poles = roots(marx.a)
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marx poles =
0.7953
0.2877
-0.0564

In this case, you access the A polynomial using marx. a.

The model marx describes system dynamics using three discrete poles.

Tip You can also use pole to compute the poles of a model directly.

Learn More

To learn more about estimating polynomial models, see “Input-Output Polynomial
Models”.

For more information about accessing model data, see “Data Extraction”.

Estimating State-Space Models

+ “About State-Space Models” on page 3-91
+ “Estimating State-Space Models Using n4sid” on page 3-92
* “Learn More” on page 3-94

About State-Space Models

The general state-space model structure is:
% = Ax(t) + Bu(t) + Ke(t)
y(t) = Cx(t) + Du(t) + e(t)

y(t) represents the output at time ¢, u(t) represents the input at time ¢, x(z) is the state
vector at time ¢, and e(%) is the white-noise disturbance.

You must specify a single integer as the model order (dimension of the state vector) to
estimate a state-space model. By default, the delay equals 1.
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3-92

The System Identification Toolbox product estimates the state-space matrices A, B, C, D,
and K using the model order and the data you specify.

The state-space model structure is a good choice for quick estimation because it contains
only two parameters: n is the number of poles (the size of the A matrix) and nk is the
delay.

Estimating State-Space Models Using n4sid

Use the n4sid command to specify a range of model orders and evaluate the
performance of several state-space models (orders 2 to 8):

mndsid = ndsid(Zel,2:8, 'InputDelay',[4 9]);

This command uses the fast, noniterative (subspace) method and opens the following
plot. You use this plot to decide which states provide a significant relative contribution to
the input/output behavior, and which states provide the smallest contribution.

4

Red: Default Choice (4)

35+ B

Log of Singular Yalues
[}
(8]
1

1 2 3 4 ) B 7 8 9
Model Order

Model Order: |5 - Apply

The vertical axis is a relative measure of how much each state contributes to the input/
output behavior of the model (log of singular values of the covariance matrix). The
horizontal axis corresponds to the model order n. This plot recommends n=4, indicated by
a red rectangle.

To select this model order, select 4 from the Model Order drop-down list and click
Apply.
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By default, n4sid uses a free parameterization of the state-space form. To estimate a
canonical form instead, set the value of the SSParameterization property to
"Canonical' . You can also specify the input-to-output delay (in samples) using the
'InputDelay’' property.

mCanonical = n4dsid(Zel, 3, 'SSParameterization', 'canonical', 'InputbDelay', [4 9]);
present (mCanonical); % Display model properties

mCanonical =
Discrete-time identified state-space model:
x(t+Ts) = A x(t) + B u(t) + K e(t)
y(t) = C x(t) + D u(t) + e(t)
A =
x1 X2 x3
x1 0 1 0
%2 0 0 1
x3 0.0737 +/- 0.05919 -0.6093 +/- 0.1626 1.446 +/- 0.1287
B =
ConsumptionR Current
x1 1.844 +/- 0.175 0.5633 +/- 0.122
%2 1.063 +/- 0.1673 2.308 +/- 0.1222
x3 0.2779 +/- 0.09615 1.878 +/- 0.1058
C =
x1l x2 x3

Production 1 0 0
ConsumptionR Current
Production 0 0
K =
Production
x1l 0.8674 +/- 0.03169
x2 0.6849 +/- 0.04145
x3 0.5105 +/- 0.04352

Input delays (sampling periods): 4 9

Sample time: 0.5 minutes
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Parameterization:
CANONICAL form with indices: 3.
Feedthrough: none
Disturbance component: estimate
Number of free coefficients: 12
Use "idssdata", "getpvec", "getcov" for parameters and their uncertainties.

Status:

Estimated using N4SID on time domain data "Zel".
Fit to estimation data: 91.39% (prediction focus)
FPE: 2.402, MSE: 2.331

More information in model's "Report" property.

Note mn4sid and mCanonical are discrete-time models. To estimate a continuous-time
model, set the 'Ts' property to 0 in the estimation command, or use the ssest
command:

mCT1l = n4sid(Zel, 3, 'Ts', 0, 'InputbDelay', [2.5 5])
mCT2 ssest (Zel, 3, 'InputbDelay', [2.5 5])

Learn More
To learn more about estimating state-space models, see “State-Space Models”.

Estimating a Box-Jenkins Model

+ “About Box-Jenkins Models” on page 3-94
+ “Estimating a BJ Model Using pem” on page 3-95
* “Learn More” on page 3-96

About Box-Jenkins Models

The general Box-Jenkins (BJ) structure is:

& B (q) C(q)
=Y 2LLy (t—nk))+ =L e(t)
K= 2 " ) By

To estimate a BJ model, you need to specify the parameters n,, n;, n., ny, and n,,.
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Whereas the ARX model structure does not distinguish between the poles for individual
input/output paths, the BJ model provides more flexibility in modeling the poles and
zeros of the disturbance separately from the poles and zeros of the system dynamics.

Estimating a BJ Model Using pem

You can use pem to estimate the BJ model. pem is an iterative method and has the
following general syntax:

pem(data, 'na',na, 'nb',nb, 'nc',nc, 'nd',nd, 'nf',nf, 'nk', nk)

To estimate the BJ model, type:

na = 0;
nb=1[211];
nc = 1;
nd = 1;
nf =1[1211];
nk = [ 5 10];

mbj = polyest(Zel, [na nb nc nd nf nk]);

This command specifies nf=2 , nb=2 , nk=>5 for the first input, and nf=nb=1 and nk=10
for the second input.

Display the model information.

present (mbj)

gficzete—time BJ model: y(t) = [B(z)/F(z)]u(t) + [C(z)/D(z)]e(t)
Bl(z) = 1.823 (+/- 0.1792) z"-5 - 1.315 (+/- 0.2367) z"-6
B2(z) = 1.791 (+/- 0.06431) z"-10
C(z) =1 + 0.1068 (+/- 0.04009) z~-1
D(z) =1 - 0.7452 (+/- 0.02694) z"-1
Fl(z) =1 - 1.321 (+/- 0.06936) z~-1 + 0.5911 (+/- 0.05514) z"-2
F2(z) = 1 - 0.8314 (+/- 0.006441) z~-1

Sample time: 0.5 minutes
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Parameterization:
Polynomial orders: nb=[2 1] nc=1 nd=1 nf=[2 1]
nk=[5 10]
Number of free coefficients: 8
Use "polydata", "getpvec", "getcov" for parameters and their uncertainties.

Status:
Termination condition: Near (local) minimum, (norm(g) < tol).
Number of iterations: 6, Number of function evaluations: 13

Estimated using POLYEST on time domain data "Zel".
Fit to estimation data: 90.75% (prediction focus)
FPE: 2.733, MSE: 2.689

More information in model's "Report" property.

The uncertainty for each of the model parameters is computed to 1 standard deviation
and appears in parentheses next to each parameter value.

The polynomials C and D give the numerator and the denominator of the noise model,
respectively.

Tip Alternatively, you can use the following shorthand syntax that specifies the orders as
a single vector:

b7 is a version of pem that specifically estimates the BJ model structure.

Learn More

To learn more about identifying input-output polynomial models, such as BdJ, see “Input-
Output Polynomial Models”.

Comparing Model Output to Measured Output

Compare the output of the ARX, state-space, and Box-Jenkins models to the measured
output.

compare (Zvl,marx,mn4sid, mbj)
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compare plots the measured output in the validation data set against the simulated
output from the models. The input data from the validation data set serves as input to
the models.

Perform residual analysis on the ARX, state-space, and Box-Jenkins models.

resid(Zvl,marx,mnd4sid, mbj)
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Residue Correlation
AutoCorr XCorr {ConsumptionRate) X Corr (Current)

087

06T

047

Amplitude
e@Production

027

All three models simulate the output equally well and have uncorrelated residuals.
Therefore, choose the ARX model because it is the simplest of the three input-output
polynomial models and adequately captures the process dynamics.

Simulating and Predicting Model Output

*  “Simulating the Model Output” on page 3-99
* “Predicting the Future Output” on page 3-100
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Simulating the Model Output

In this portion of the tutorial, you simulate the model output. You must have already
created the continuous-time model midproc2, as described in “Estimating Process
Models” on page 3-78.

Simulating the model output requires the following information:

* Input values to the model

+ Initial conditions for the simulation (also called initial states)

For example, the following commands use the iddata and idinput commands to
construct an input data set, and use sim to simulate the model output:

% Create input for simulation

U = iddata([],idinput([200 2]),'Ts',0.5, 'TimeUnit', 'min");

% Simulate the response setting initial conditions equal to zero
ysim 1 = sim(midproc2,U);

To maximize the fit between the simulated response of a model to the measured output
for the same input, you can compute the initial conditions corresponding to the measured
data. The best fitting initial conditions can be obtained by using findstates on the
state-space version of the estimated model. The following commands estimate the initial
states XOest from the data set zv1:

% State-space version of the model needed for computing initial states
midproc2 ss = idss(midproc2);
X0est = findstates (midproc2 ss,Zvl);

Next, simulate the model using the initial states estimated from the data.

% Simulation input

Usim = Zv1(:,[],:):

Opt = simOptions('InitialCondition',X0est);
ysim 2 = sim(midproc2 ss,Usim,Opt);

Compare the simulated and the measured output on a plot.

figure

plot([ysim 2.y, zZvl.y])
legend ({ 'model output', 'measured'})
xlabel ('time'), ylabel ('Output')
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Predicting the Future Output

Many control-design applications require you to predict the future outputs of a dynamic
system using the past input/output data.

For example, use predict to predict the model response five steps ahead:

predict (midproc2, Zel, 5)
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argument of compare specifies a five-step-ahead prediction. When you do not specify a

third argument, compare assumes an infinite prediction horizon and simulates the

model output instead.

compare (Zel,midproc2, 5)
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Use pe to compute the prediction error Err between the predicted output of midproc?2
and the measured output. Then, plot the error spectrum using the spectrum command.

[Err] = pe(midproc2,Zvl);
spectrum(spa (Exrr, []1,logspace (-2,2,200)))
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The prediction errors are plotted with a 1-standard-deviation confidence interval. The
errors are greater at high frequencies because of the high-frequency nature of the
disturbance.
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|dentify Low-Order Transfer Functions (Process Models) Using
System ldentification App

In this section...

“Introduction” on page 3-104
“What Is a Continuous-Time Process Model?” on page 3-105
“Preparing Data for System Identification” on page 3-106

“Estimating a Second-Order Transfer Function (Process Model) with Complex Poles” on
page 3-113

“Estimating a Process Model with a Noise Component” on page 3-120

“Viewing Model Parameters” on page 3-125

“Exporting the Model to the MATLAB Workspace” on page 3-127

“Simulating a System Identification Toolbox Model in Simulink Software” on page 3-128

Introduction

+ “Objectives” on page 3-104
+ “Data Description” on page 3-105

Objectives

Estimate and validate simple, continuous-time transfer functions from single-input/
single-output (SISO) data to find the one that best describes the system dynamics.

After completing this tutorial, you will be able to accomplish the following tasks using
the System Identification app :

+ Import data objects from the MATLAB workspace into the app.

* Plot and process the data.

+  Estimate and validate low-order, continuous-time models from the data.

+  Export models to the MATLAB workspace.

+ Simulate the model using Simulink software.

Note This tutorial uses time-domain data to demonstrate how you can estimate linear
models. The same workflow applies to fitting frequency-domain data.
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Data Description

This tutorial uses the data file proc data.mat, which contains 200 samples of
simulated single-input/single-output (SISO) time-domain data. The input is a random
binary signal that oscillates between -1 and 1. White noise (corresponding to a load
disturbance) is added to the input with a standard deviation of 0.2, which results in a
signal-to-noise ratio of about 20 dB. This data is simulated using a second-order system
with underdamped modes (complex poles) and a peak response at 1 rad/s:

G(s) = ;26_23
1+02s+s

The sample time of the simulation is 1 second.

What Is a Continuous-Time Process Model?

Continuous-time process models are low-order transfer functions that describe the system
dynamics using static gain, a time delay before the system output responds to the input,
and characteristic time constants associated with poles and zeros. Such models are
popular in the industry and are often used for tuning PID controllers, for example.
Process model parameters have physical significance.

You can specify different process model structures by varying the number of poles,
adding an integrator, or including a time delay or a zero. The highest process model
order you can specify in this toolbox is three, and the poles can be real or complex
(underdamped modes).

In general, a linear system is characterized by a transfer function G, which is an operator
that takes the input u to the output y:

y=Gu

For a continuous-time system, G relates the Laplace transforms of the input U(s) and the
output Y(s), as follows:

Y (s)=G(s)U(s)

In this tutorial, you estimate G using different process-model structures.

For example, the following model structure is a first-order, continuous-time model, where
K is the static gain, T,; is a time constant, and 7} is the input-to-output delay:
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K -sT,

G(s) = e
1+ STp]_

Preparing Data for System Identification

* “Loading Data into the MATLAB Workspace” on page 3-106

* “Opening the System Identification App” on page 3-106

+ “Importing Data Objects into the System Identification App” on page 3-107
*  “Plotting and Processing Data” on page 3-109

Loading Data into the MATLAB Workspace

Load the data in proc_data.mat by typing the following command in the MATLAB
Command Window:

load proc data

This command loads the data into the MATLAB workspace as the data object z. For more
information about iddata objects, see the corresponding reference page.

Opening the System Identification App

To open the System Identification app , type the following command at the MATLAB
Command Window:

systemIdentification

The default session name, Untitled, appears in the title bar.
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B System Identification - Untitled = |
File Options Window Help
Import data > Import models >
4 Operations. “
<— Preprocess -
=
Working Data
Estimate —= =)
Data Views To To Model Views
Time plot Workspace || LTI Viewer Model output Transient resp Nonlinear ARX
Data spectra _ Model resids Frequency resp Hamm-Wiener
Frequency function ”I] Zeros and poles
Noize spectrum
ge=h \alidation Data
Status line is here.

Importing Data Objects into the System Identification App
You can import data object into the app from the MATLAB workspace.

You must have already loaded the sample data into MATLAB, as described in “Loading
Data into the MATLAB Workspace” on page 3-106, and opened the app, as described in
“Opening the System Identification App” on page 3-106.

To import a data object into the System Identification app :
1 Select Import data > Data object.

This action opens the Import Data dialog box.

impnrt data - |

Import data

Time domain data...
Freq. domain data...

Example...
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2 In the Import Data dialog box, specify the following options:

* Object — Enter z as the name of the MATLAB variable that is the time-domain
data object. Press Enter.

+ Data name — Use the default name z, which is the same as the name of the
data object you are importing. This name labels the data in the System
Identification app after the import operation is completed.

+ Starting time — Enter 0 as the starting time. This value designates the starting
value of the time axis on time plots.

Sample time — Enter 1 as the time between successive samples in seconds. This
value represents the actual sample time in the experiment.

The Import Data dialog box now resembles the following figure.

4] Import Data EI@

Data Format for Signals

IDDATA or IDFRINFRD -

Workspace Variable

Object: z
Type: IDDATA,
(Time Domain’

Data Information

Data name: =
Starting time: 0
Sample time: 1

More

| Import | | Reset |

| Close | | Help |
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3 Click Import to add the data to the System Identification app. The app adds an icon
to represent the data.

Import data -
‘l Operations

<— Preprocess -
z

)
. WU:N\"\
Working Data
L
Estimate — -

4  Click Close to close the Import Data dialog box.
Plotting and Processing Data

In this portion of the tutorial, you evaluate the data and process it for system
identification. You learn how to:

* Plot the data.

*  Remove offsets by subtracting the mean values of the input and the output.

+  Split the data into two parts. You use one part of the data for model estimation, and
the other part of the data for model validation.

The reason you subtract the mean values from each signal is because, typically, you build
linear models that describe the responses for deviations from a physical equilibrium.
With steady-state data, it is reasonable to assume that the mean levels of the signals
correspond to such an equilibrium. Thus, you can seek models around zero without
modeling the absolute equilibrium levels in physical units.

You must have already imported data into the System Identification app, as described in
“Importing Data Objects into the System Identification App” on page 3-107.

To plot and process the data:
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1

Select the Time plot check box to open the Time Plot window.

(4 Time Plot: ul->y1 =3 =8~

File Options Style Channel Experiment Help

Input and output signals

ul
=
T
I

05 - H

=1 L I | L) 1 I
0 20 40 &0 80 100 120 140 160 180 200
Time

The bottom axes show the input data—a random binary sequence, and the top axes
show the output data.

The next two steps demonstrate how to modify the axis limits in the plot.

To modify the vertical-axis limits for the input data, select Options > Set axes
limits in the Time Plot figure window.

In the Limits for Time Plot dialog box, set the new vertical axis limit of the input
data channel ul to [-1.5 1.5]. Click Apply and Close.
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(B Limits for TimePlot. |- = | & |[mse)
Time [ Auto
[0 200] [ Log
¥1 Auto
[-5 5 [ Log
ul [T Auto
[-1.51.5] [ Log
[ Apply | | Close J

Note The other two fields in the Limits for Time Plot dialog box, Time and y1, let
you set the axis limits for the time axis and the output channel axis, respectively.
You can also specify each axis to be logarithmic or linear by selecting the
corresponding option.

The following figure shows the updated time plot.

3-111



3 Linear Model Identification

3-112

(4 Time Plot: ul->y1 =] |
File Options Style Channel Experiment Help
c Input and output signals
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1
50
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4 In the System Identification app , select <—-Preprocess > Quick start to perform
the following four actions:
*  Subtract the mean value from each channel.
Split the data into two parts.
+ Specify the first part of the data as estimation data (or Working Data).
+  Specify the second part of the data as Validation Data.

Learn More

For information about supported data processing operations, such as resampling and
filtering the data, see “Preprocess Data”.
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Estimating a Second-Order Transfer Function (Process Model) with
Complex Poles

+ “Estimating a Second-Order Transfer Function Using Default Settings” on page 3-113
+ “Tips for Specifying Known Parameters” on page 3-116
+ “Validating the Model” on page 3-117

Estimating a Second-Order Transfer Function Using Default Settings

In this portion of the tutorial, you estimate models with this structure:
K _T"is
(1+ 28T, s+ Tw232 )

G(s) =

You must have already processed the data for estimation, as described in “Plotting and
Processing Data” on page 3-109.

To identify a second-order transfer function:

1 In the System Identification app, select Estimate > Process models to open the
Process Models dialog box.

Eztimate —= ~4

Estimate —=
Tranzfer Function Models...
State Space Models...

Polynomial Models... k

Neonlinear Models. ..
Spectral Models. ..
Correlation Models...
Refine Existing Models...
Quick Start

2 Inthe Model Transfer Function area of the Process Models dialog box, specify the
following options:

*  Under Poles, select 2 and Underdamped.

This selection updates the Model Transfer Function to a second-order model
structure that can contain complex poles.
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Make sure that the Zero and Integrator check boxes are cleared to exclude a
zero and an integrator (self-regulating ) from the model.

Model Transfer Function

K exp(-Td s)

(1+(2ZetaTw) s+ (Tw=s)*2)

Poles

2 * | Underdamped -

|:| Zero
Delay

|:| Integrator

The Parameter area of the Process Models dialog box now shows four active
parameters: K, Tw, Zeta, and Td. In the Initial Guess area, keep the default Auto-
selected option to calculate the initial parameter values during the estimation.
The Initial Guess column in the Parameter table displays Auto.

Keep the default Bounds values, which specify the minimum and maximum values
of each parameter.

Tip If you know the range of possible values for a parameter, you can type these
values into the corresponding Bounds fields to help the estimation algorithm. Press
the Enter key after you specify the values.

Keep the default settings for the estimation algorithm:

Disturbance Model — None means that the algorithm does not estimate the
noise model. This option also sets the Focus to Simulation.

* Focus — Simulation means that the estimation algorithm does not use the
noise model to weigh the relative importance of how closely to fit the data in
various frequency ranges. Instead, the algorithm uses the input spectrum in a
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particular frequency range to weigh the relative importance of the fit in that
frequency range.

Tip The Simulation setting is optimized for identifying models that you plan to
use for output simulation. If you plan to use your model for output prediction or
control applications, or to improve parameter estimates using a noise model,
select Prediction.

Initial condition — Auto means that the algorithm analyzes the data and
chooses the optimum method for handling the initial state of the system. If you
get poor results, you might try setting a specific method for handling initial
states, rather than choosing it automatically.

+ Covariance — Estimate means that the algorithm computes parameter
uncertainties that display as model confidence regions on plots.

The app assigns a name to the model, shown in the Name field (located at the
bottom of the dialog box). By default, the name is the acronym P2DU, which indicates
two poles (P2), a delay (D), and underdamped modes (U).
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Process Models [E=8E=R===
Model Transfer Function Parameter Known Value Initial Guess Bounds
K Auto [-nf Inf]
K expl-Td s) Tw Auto [0 Inf]
(1+(2ZetaTw) =+ (Tw s)*2) Zeta Auto [0 Inf]
0 0 [0 Inf]
Poles 0 0 [-Inf Inf]
2 = || Underdamped v Td Aute [03]
Initial Guess
Zero
@) Auto-selected
| Delay
From existing model:
Integrator
User-defined ‘Value—=Initial Guess
Disturbance Model: Nene - Initial condition: Auto - Regularization. ..
Focus: Simulation - Covariance: Estimate - Options...
Display progress Stop terations
Name: P2DU [ Estmate | [ cose | Help |

6 Click Estimate to add the model P2DU to the System Identification app.

Tips for Specifying Known Parameters

If you know a parameter value exactly, you can type this value in the Initial Guess
column of the Process Models dialog box. Press the Enter key after you specify the value.

If you know the approximate value of a parameter, you can help the estimation algorithm
by entering an initial value in the Initial Guess column. In this case, keep the Known
check box cleared to allow the estimation to fine-tune this initial guess.

For example, to fix the time-delay value Td at 2s, type this value into Value field of the
Parameter table in the Process Models dialog box, and press the Enter key. Select the

corresponding Known check box.
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Known checkboxes.

ParameterKry( Value Initial Guess Bounds

K ] 0.99632 Auto [-Inf Inf]
Tw [ 0.99831 Auto [0 10000]
Zeta 7] 0.10828 Auto [0 Inf]

0 0 [0 Inf]

0 0 [-Inf Inf]
d [ 1.991 Auto [030]
Initial Guess

@ Auto-selected

From existing model:

User-defined [ Value—=Initial Guess ]

Validating the Model

You can analyze the following plots to evaluate the quality of the model:

+  Comparison of the model output and the measured output on a time plot

+ Autocorrelation of the output residuals, and cross-correlation of the input and the
output residuals

You must have already estimated the model, as described in “Estimating a Second-Order
Transfer Function Using Default Settings” on page 3-113.

Examining Model Output
You can use the model-output plot to check how well the model output matches the
measured output in the validation data set. A good model is the simplest model that best

describes the dynamics and successfully simulates or predicts the output for different
inputs.
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To generate the model-output plot, select the Model output check box in the System
Identification app. If the plot is empty, click the model icon in the System Identification
app window to display the model on the plot.

Model Output: y1 EI@

File Options Style Channel Experiment Help

Measured and simulated model output

4
Best Fits
P20 77.56
2
0
-2

_4 1 1 1 L
100 120 140 160 180 200
Time

The System Identification Toolbox software uses input validation data as input to the
model, and plots the simulated output on top of the output validation data. The preceding
plot shows that the model output agrees well with the validation-data output.

The Best Fits area of the Model Output plot shows the agreement (in percent) between
the model output and the validation-data output.

Recall that the data was simulated using the following second-order system with
underdamped modes (complex poles), as described in “Data Description” on page 3-105,
and has a peak response at 1 rad/s:

G(s) = 1 5 e2s
1+02s+s

Because the data includes noise at the input during the simulation, the estimated model
cannot exactly reproduce the model used to simulate the data.
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Examining Model Residuals
You can validate a model by checking the behavior of its residuals.

To generate a Residual Analysis plot, select the Model resids check box in the System
Identification app.

Residual Analysis: ul->yl EI@

File Options Style  Channel Help

Autocorrelation of residuals for output y1

= . . .
Cross corr for input u1 and output v1 resids

0.5

] W
-0.5 L

-20 -10 0 10 20

Samples

The top axes show the autocorrelation of residuals for the output (whiteness test). The
horizontal scale is the number of lags, which is the time difference (in samples) between
the signals at which the correlation is estimated. Any fluctuations within the confidence
interval are considered to be insignificant. A good model should have a residual
autocorrelation function within the confidence interval, indicating that the residuals are
uncorrelated. However, in this example, the residuals appear to be correlated, which is
natural because the noise model is used to make the residuals white.

The bottom axes show the cross-correlation of the residuals with the input. A good model
should have residuals uncorrelated with past inputs (independence test). Evidence of
correlation indicates that the model does not describe how a portion of the output relates
to the corresponding input. For example, when there is a peak outside the confidence
interval for lag &, this means that the contribution to the output y(z) that originates from
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the input u(z-k) is not properly described by the model. In this example, there is no
correlation between the residuals and the inputs.

Thus, residual analysis indicates that this model is good, but that there might be a need
for a noise model.

Estimating a Process Model with a Noise Component

+ “Estimating a Second-Order Process Model with Complex Poles” on page 3-120
+ “Validating the Models” on page 3-122

Estimating a Second-Order Process Model with Complex Poles

In this portion of the tutorial, you estimate a second-order transfer function and include
a noise model. By including a noise model, you optimize the estimation results for
prediction application.

You must have already estimated the model, as described in “Estimating a Second-Order
Transfer Function Using Default Settings” on page 3-113.

To estimate a second-order transfer function with noise:

1 If the Process Models dialog box is not open, select Estimate > Process Models in
the System Identification app. This action opens the Process Models dialog box.

Eztimate —= -4

Estimate —=
Transfer Function Models...
State Space Models...

Polynomial Models... k

Neonlinear Models. ..
Spectral Models. ..
Correlation Models...
Refine Existing Models...
Quick Start

2 Inthe Model Transfer Function area, specify the following options:

* Under Poles, select 2 and Underdamped. This selection updates the Model
Transfer Function to a second-order model structure that can contain complex
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poles. Make sure that the Zero and Integrator check boxes are cleared to
exclude a zero and an integrator (self-regulating ) from the model.

Model Transfer Function

K expl(-Td s}

(1+(2ZetaTw) s+ (Tw s)*2)

Poles

2 * | |Underdamped -

Zero
| Delay

Integrator

+ Disturbance Model — Set to Order 1 to estimate a noise model H as a
continuous-time, first-order ARMA model:

C

H=—e
D

where and D are first-order polynomials, and e is white noise.

This action specifies the Focus as Prediction, which improves accuracy in the
frequency range where the noise level is low. For example, if there is more noise
at high frequencies, the algorithm assigns less importance to accurately fitting
the high-frequency portions of the data.

+ Name — Edit the model name to P2DUe1l to generate a model with a unique
name in the System Identification app.

Click Estimate.

In the Process Models dialog box, set the Disturbance Model to Order 2 to
estimate a second-order noise model.
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5 Edit the Name field to P2DUe2 to generate a model with a unique name in the
System Identification app.

6 Click Estimate.
Validating the Models

In this portion of the tutorial, you evaluate model performance using the Model Output
and the Residual Analysis plots.

You must have already estimated the models, as described in “Estimating a Second-
Order Transfer Function Using Default Settings” on page 3-113 and “Estimating a
Second-Order Process Model with Complex Poles” on page 3-120.

Comparing the Model Output Plots

To generate the Model Output plot, select the Model output check box in the System
Identification app. If the plot is empty or a model output does not appear on the plot,
click the model icons in the System Identification app window to display these models on
the plot.

The following Model Output plot shows the simulated model output, by default. The
simulated response of the models is approximately the same for models with and without
noise. Thus, including the noise model does not affect the simulated output.

Measured and simulated model output

4
Best Fits
P2DUe2: 7961
2t 4 [P2DUe1: 78.33
P20 77.56
0 1
a2 J

_4 1 1 1 1
100 120 140 160 180 200
Time
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To view the predicted model output, select Options > 5 step ahead predicted output
in the Model Output plot window.

The following Model Output plot shows that the predicted model output of P2DUe2 (with
a second-order noise model) is better than the predicted output of the other two models
(without noise and with a first-order noise model, respectively).

Measured and 5 step predicted output

4
Best Fits
F20le2: 78.64
2t 41 [P2DUe1:.78.5
P20 77.56
0 N
a1t i

_4 1 1 1 1
100 120 140 160 180 200
Time

Comparing the Residual Analysis Plots

To generate the Residual Analysis plot, select the Model resids check box in the System
Identification app. If the plot is empty, click the model icons in the System Identification
app window to display these models on the plot.

P2DUe?2 falls well within the confidence bounds on the Residual Analysis plot.
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Residual Analysis: ul-=yl EI@

File Options Style  Channel Help

Autocorrelation of residuals for output y1

Samples

To view residuals for P2DUe2 only, remove models P2DU and P2DUel from the Residual
Analysis plot by clicking the corresponding icons in the System Identification app.

Import models -

1
e

P2DU P2DUel || P2DUe2

The Residual Analysis plot updates, as shown in the following figure.
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Autocorrelation of residuals for output y1

Samples

The whiteness test for P2DUe2 shows that the residuals are uncorrelated, and the
independence test shows no correlation between the residuals and the inputs. These tests
indicate that P2DUe2 is a good model.

Viewing Model Parameters

+ “Viewing Model Parameter Values” on page 3-125

+ “Viewing Parameter Uncertainties” on page 3-127
Viewing Model Parameter Values

You can view the numerical parameter values and other information about the model
P2DUe2 by right-clicking the model icon in the System Identification app . The Data/
model Info dialog box opens.
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4| Datafmodel Info: P2DUe2 (o ===
Model name: P2DUa2
Color: [1.0,0]
Process model with transfer function: -
Kp
G(3) = ——————m—m— * exp(-Td*s) =

1+2*Zeta*Twea+ (Tw*s) ~2

Kp = 0.99738
Iw = 0.99874
Zeta = 0.10829
Id = 2.0058 -

Diary and Notes

% Import z
d = dtrend(z,0)
de = zd([1:100]})

BB

P2DUe2 = pem(zde, "P2DU"'Dist', "ARMA2");

Show in LTI Viewer

| present | | moor | | cose | | Hep

The noneditable area of the dialog box lists the model coefficients that correspond to the
following model structure:

K _Tzis

G(s) = TG
(1+2§Tws+Tw s )

The coefficients agree with the model used to simulate the data:
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G(s) = ;26_23
1+02s+s

Viewing Parameter Uncertainties

To view parameter uncertainties for the system transfer function, click Present in the
Data/model Info dialog box, and view the information in the MATLAB Command
Window.

Kp = 0.99821 +/- 0.019982
Tw = 0.99987 +/- 0.0037697
Zeta = 0.10828 +/- 0.0042304
Td = 2.004 +/- 0.0029717

The 1-standard-deviation uncertainty for each model parameter follows the +/- symbol.

P2DUe?2 also includes an additive noise term, where H is a second-order ARMA model
and e is white noise:

H:%e

The software displays the noise model H as a ratio of two polynomials, C (s) /D (s),
where:

C(s) = s”2 + 2.186 (+/- 0.08467) s + 1.089 (+/- 0.07951)
D(s) = s”2 + 0.2561 (+/- 0.09044) s + 0.5969 (+/- 0.3046)

The 1-standard deviation uncertainty for the model parameters is in parentheses next to
each parameter value.

Exporting the Model to the MATLAB Workspace

You can perform further analysis on your estimated models from the MATLAB
workspace. For example, if the model is a plant that requires a controller, you can import
the model from the MATLAB workspace into the Control System Toolbox product.
Furthermore, to simulate your model in the Simulink software (perhaps as part of a
larger dynamic system), you can import this model as a Simulink block.

The models you create in the System Identification app are not automatically available
in the MATLAB workspace. To make a model available to other toolboxes, Simulink, and
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the System Identification Toolbox commands, you must export your model from the
System Identification app to the MATLAB workspace.

To export the P2DUe2 model, drag the model icon to the To Workspace rectangle in the
System Identification app. Alternatively, click Export in the Data/model Info dialog box.
The model now appears in the MATLAB Workspace browser.

4\ Workspace E@

.

File Edit View Graphics Debug Desktop Window  Help u
E ﬁ {E 3{‘] % Stack: | Base @Selectdata to plot -
MName Value Min Max

&) P2DUe2 <1xl idproc>

Note This model is an idproc model object.

Simulating a System Identification Toolbox Model in Simulink Software

+  “Prerequisites for This Tutorial” on page 3-128

+ “Preparing Input Data” on page 3-129

*  “Building the Simulink Model” on page 3-129

* “Configuring Blocks and Simulation Parameters” on page 3-130

*  “Running the Simulation” on page 3-133
Prerequisites for This Tutorial

In this tutorial, you create a simple Simulink model that uses blocks from the System
Identification Toolbox library to bring the data z and the model P2DUe?2 into Simulink.

To perform the steps in this tutorial, Simulink must be installed on your computer.
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Furthermore, you must have already performed the following steps:

* Load the data set, as described in “Loading Data into the MATLAB Workspace” on
page 3-106.

+  Estimate the second-order process model, as described in “Estimating a Second-Order
Process Model with Complex Poles” on page 3-120.

+  Export the model to the MATLAB workspace, as described in “Exporting the Model to
the MATLAB Workspace” on page 3-127.

Preparing Input Data

Use the input channel of the data set z as input for simulating the model output by
typing the following in the MATLAB Command Window:

z input

= z; % Creates a new iddata object.
z input.y =

[1; % Sets the output channel
% to empty.

Alternatively, you can specify any input signal.

Learn More

For more information about representing data signals for system identification, see
“Representing Data in MATLAB Workspace”.

Building the Simulink Model

To add blocks to a Simulink model:

1
On the MATLAB Home tab, click '-E-' Simulink.

2 In the Simulink start page, click Blank Model. Then click Create Model to open a
new model window.

3 1|
In the Simulink model window, click BIE to open the Library Browser. In the

Library Browser, select the System Identification Toolbox library. The right side
of the window displays blocks specific to the System Identification Toolbox product.

Tip Alternatively, to access the System Identification block library, type slident in
the MATLAB Command Window.
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4  Drag the following System Identification Toolbox blocks to the new model window:

« IDDATA Sink block
« IDDATA Source block
IDMODEL model block

5 In the Simulink Library Browser, select the Simulink > Sinks library, and drag the
Scope block to the new model window.

6 In the Simulink model window, connect the blocks to resembles the following figure.

| Input
IDDATA SIMNK
Output
Iddata Sink
Input P idss(-1,1,1,0) > I:l
iddata{1,1} -
Cope
Output b |dmodel
lddata Source

Next, you configure these blocks to get data from the MATLAB workspace and set the
simulation time interval and duration.

Configuring Blocks and Simulation Parameters
This procedure guides you through the following tasks to configure the model blocks:

*  Getting data from the MATLAB workspace.

Setting the simulation time interval and duration.

1 In the Simulink Editor, select Simulation > Model Configuration Parameters.

2 In the Configuration Parameters dialog box, in the Solver subpane, in the Stop
time field, type 200. Click OK.

This value sets the duration of the simulation to 200 seconds.

3 Double-click the Iddata Source block to open the Source Block Parameters: Iddata
Source dialog box. Then, type the following variable name in the IDDATA object
field:

z input
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This variable is the data object in the MATLAB workspace that contains the input
data.

Source Block Parameters: Iddata Source @
Iddata InputOutput (mask) (link)

This block allows to import IDDATA object from the MATLAB
Workspace.

The first output port of the block corresponds to the input signal of
the IDDATA object and the second output port corresponds to the
output signal.

Enter an IDDATA object in the edit field.

Parameters

IDDATA object

z_inpuﬂ

[ OK H Cancel H Help H Apply

Tip As a shortcut, you can drag and drop the variable name from the MATLAB
Workspace browser to the IDDATA object field.

Click OK.

Double-click the Idmodel block to open the Function Block Parameters: Idmodel
dialog box.

a Type the following variable name in the Model variable field:

P2DUe2

This variable represents the name of the model in the MATLAB workspace.
b Clear the Add noise check box to exclude noise from the simulation. Click OK.

When Add noise is selected, Simulink derives the noise amplitude from the
NoiseVariance property of the model and adds noise to the model accordingly.
The simulation propagates this noise according to the noise model H that was
estimated with the system dynamics:
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Function Block Parameters: Idmodel @
Idmodel Block (mask) (link)
The Idmodel block accepts any of the linear identified models - state
space (idss), linear grey box (idgrey), polynomial (idpoly), transfer

function (idtf) or process (idproc) models. Internally, models will be
converted to their state space equivalent for evaluation.

Initial states are only meaningful for state-space models (idss,
idgrey).

For simulations with noise, Seed(s) may be left empty for random
restarts.

Enter as many seeds as there are outputs for specific realizations.

Parameters

Identified model

F2DUe2

Initial states (state space only: idss, idgrey)
0

[C] Add noise

Noise seed(s). Default empty

0

[ 0K H Cancel H Help H Apply

Click OK.

5 Double-click the Iddata Sink block to open the Sink Block Parameters: Iddata Sink
dialog box. Type the following variable name in the IDDATA Name field:

z sim out

6 Type 1 in the Sample Time (sec.) field to set the sample time of the output data to
match the sample time of the input data.
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"] Sink Block Parameters: Iddata Sink [==al

IDDATA Sink (mask) (link)

Export simulation data to workspace as IDDATA object. The object
stores input and output signals sampled at the specified sample time
when simulation stops. The object is created in the MATLAB base
workspace when simulating from the model window or caller
workspace when simulating programmatically.

Specify the variable name in "IDDATA Name". Specify a positive
number, representing the sampling interval, in "Sample Time".

Parameters

IDDATA Name

Z_sim_out

Sample Time (sec.)

1

[ OK H Cancel H Help H Apply

Click OK.

The resulting change to the Simulink model is shown in the following figure.

| Input
IDDATA SIMK
Cutput
lddata Sink
Z_input Input > FZDUe2 > :l
ldmadel Scope

lddata Source

Running the Simulation

1 In the Simulink Editor, select Simulation > Run.

2 Double-click the Scope block to display the time plot of the model output.
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B scope =)
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3 Inthe MATLAB Workspace browser, notice the variable z_sim out that stores the
model output as an iddata object. You specified this variable name when you
configured the Iddata Sink block.

This variable stores the simulated output of the model, and it is now available for
further processing and exploration.

See Also

More About
“What Is a Process Model?”
“Estimate Process Models Using the App”
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Estimating Models Using Frequency-Domain Data

The System Identification Toolbox software lets you use frequency-domain data to
identify linear models at the command line and in the System Identification app. You
can estimate both continuous-time and discrete-time linear models using frequency-
domain data. This topic presents an overview of model estimation in the toolbox using
frequency-domain data. For an example of model estimation using frequency-domain
data, see “Frequency Domain Identification: Estimating Models Using Frequency
Domain Data”.

Frequency-domain data can be of two types:

*  Frequency domain input-output data — You obtain the data by computing Fourier
transforms of time-domain input, u«(¢), and output, y(¢), signals. The data is the set of
input, U(w), and output, Y(w), signals in frequency domain. In the toolbox, frequency-
domain input-output data is represented using iddata objects. For more information,
see “Representing Frequency-Domain Data in the Toolbox” on page 3-136.

*  Frequency-response data — Also called frequency function or frequency-response
function (FRF), the data consists of transfer function measurements, G(iw), of a
system at a discrete set of frequencies w. Frequency-response data at a frequency
tells you how a linear system responds to a sinusoidal input of the same frequency. In
the toolbox, frequency-response data is represented using idfrd objects. For more
information, see “Representing Frequency-Domain Data in the Toolbox” on page 3-
136. You can obtain frequency-response data in the following ways:

Measure the frequency-response data values directly, such as by using a spectrum
analyzer.

+  Perform spectral analysis of time-domain or frequency-domain input-output data
(iddata objects) using commands such as spa and spafdr.

+  Compute the frequency-response of an identified linear model using commands
such as freqresp, bode, and idfrd.

The workflow for model estimation on page 2-4 using frequency-domain data is the same
as that for estimation using time-domain data. If needed, you first prepare the data for
model identification by removing outliers and filtering the data. You then estimate a
linear parametric model from the data, and validate the estimation.
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Advantages of Using Frequency-Domain Data

Using frequency-domain data has the following advantages:

Data compression — You can compress long records of data when you convert time-
domain data to frequency domain. For example, you can use logarithmically spaced
frequencies.

Non uniformity — Frequency-domain data does not have to be uniformly spaced. Your
data can have frequency-dependent resolution so that more data points are used in
the frequency regions of interest. For example, the frequencies of interest could be the
bandwidth range of a system, or near the resonances of a system.

Prefiltering — Prefiltering of data in the frequency-domain becomes simple. It
corresponds to assigning different weights to different frequencies of the data.

Continuous-time signal - You can represent continuous-time signals using frequency-
domain data and use the data for estimation.

Representing Frequency-Domain Data in the Toolbox

Before performing model estimation, you specify the frequency-domain data as objects in
the toolbox. You can specify both continuous-time and discrete-time frequency-domain
data on page 3-140.

Frequency domain input-output data — Specify as an iddata object. In the
object, you store U(w), Y(w), and frequency vector . The Domain property of the
object is 'Frequency', to specify that the object contains frequency-domain signals.
If U(w), Y(w) are discrete-time Fourier transforms of discrete-time signals, sampled
with sampling interval Ts, denote the sampling interval in the iddata object. If U(w),
Y(w) are Fourier transforms of continuous-time signals, specify Ts as 0 in the iddata
object.

To plot the data at the command line, use the plot command.

For example, you can plot the phase and magnitude of frequency-domain input-output
data.

Load time-domain input-output data.

load iddatal =zl
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Magnitude (abs) ; Phase (deqg)

The time-domain inputs u and outputs y are stored in z1, an iddata object whose
Domain property is set to 'Time"'.

Fourier-transform the data to obtain frequency-domain input-output data.
zf = fft(zl);

The Domain property of zf is set to ' Frequency', indicating that it is frequency-
domain data.

Plot the magnitude and phase of the frequency-domain input-output data.

plot (zf)

Input-Output Data
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Frequency-response data — Specify as an idfrd object. If you have Control
System Toolbox software, you can also specify the data as an frd object.

To plot the data at the command line, use the bode command.

For example, you can plot the frequency-response of a transfer function model.
Create a transfer function model of your system.

sys = tf([1 0.2],[1 2 1 1]);

Calculate the frequency-response of the transfer function model, sys, at 100
frequency points. Specify the range of the frequencies as 0.1 rad/s to 10 rad/s.

freq = logspace(-1,1,100);
frdModel = idfrd(sys, freq):;

Plot the frequency-response of the model.

bode (frdModel)
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Bode Diagram
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For more information about the frequency-domain data types and how to specify them,
see “Frequency-Domain Data Representation”.

You can also transform between frequency-domain and time-domain data types using the

following commands.
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Domain Data
(iddata object)

only for evenly

spaced frequency-

domain data).

Original Data To Time-Domain To Frequency- To Frequency-Response Data
Format Data Domain Data (idfrd object)
(iddata object) (iddata object)

Time-Domain |N/A Use fft Use etfe, spa, or spafdr.

Data b + Estimate a linear

(1ddata object) parametric model from the
iddata object, and use
idfrd to compute
frequency-response data.

Frequency- Use ifft (works |N/A + Use etfe, spa, or spafdr.

Estimate a linear
parametric model from the
iddata object, and use
idfrd to compute
frequency-response data.

Frequency-
Response
Data

(idfrd object)

Not supported

Use iddata. The
software creates a
frequency-domain
iddata object
that has the same
ratio between
output and input
as the original
idfrd object
frequency-
response data.

Use spafdr. The software
calculates frequency-
response data with a
different resolution (number
and spacing of frequencies)
than the original data.

For more information about transforming between data types in the app or at the
command line, see the “Transform Data” category page.

Continuous-Time and Discrete-Time Frequency-Domain Data

Unlike time-domain data, the sample time Ts of frequency-domain data can be zero.
Frequency-domain data with zero Ts is called continuous-time data. Frequency-domain
data with Ts greater than zero is called discrete-time data.

You can obtain continuous-time frequency-domain data (Ts = 0) in the following ways:
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Generate the data from known continuous-time analytical expressions.

For example, suppose that you know the frequency-response of your system is

G(w)=1/(b+ jow), where b is a constant. Also assume that the time-domain inputs to

your system are, u(t) =e % sin wyt , where a is a constant greater than zero, and (%)
is zero for all times ¢ less than zero. You can compute the Fourier transform of () to
obtain

Uw) =y /(a+ jo)? +wy?]

Using U(w) and G(w) you can then get the frequency-domain expression for the
outputs:

Y(w) = G(o)U(w)
You can now evaluate the analytical expressions for Y(w) and U(w) over a grid of
frequency values (wgq = @, ay,...,,), and get a vector of frequency-domain input-

output data values (Yg;q,Ugriq). You can package the input-output data as a
continuous-time iddata object by specifying a zero sample time, Ts.

Ts = 0;
zf iddata(Ygrid, Ugrid, Ts, 'Frequency',wgrid)

Compute the frequency response of a continuous-time linear system at a grid of
frequencies.

For example, in the following code, you generate continuous-time frequency-response
data, FRDc, from a continuous-time transfer function model, sys for a grid of
frequencies, freq.

sys = idtf(1,[1 2 21);
freq = logspace(-2,2,100);
FRDc = idfrd(sys, freq);

Measure amplitudes and phases from a sinusoidal experiment, where the
measurement system uses anti-aliasing filters. You measure the response of the
system to sinusoidal inputs at different frequencies, and package the data as an
idfrd object. For example, the frequency-response data measured with a spectrum
analyzer is continuous-time.
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You can also conduct an experiment by using periodic, continuous-time signals
(multiple sine waves) as inputs to your system and measuring the response of your
system. Then you can package the input and output data as an iddata object.

You can obtain discrete-time frequency-domain data (Ts >0) in the following ways:
* Transform the measured time-domain values using a discrete Fourier transform.

For example, in the following code, you compute the discrete Fourier transform of
time-domain data, y, that is measured at discrete time-points with sample time 0.01

seconds.

t = 0:0.01:10;

v = iddata (sin(2*pi*10*t), [],0.01);
Y = fft(y);

+  Compute the frequency response of a discrete-time linear system.

For example, in the following code, you generate discrete-time frequency-response
data, FRDd, from a discrete-time transfer function model, sys. You specify a non-zero
sample time for creating the discrete-time model.

Ts = 1;
sys = idtf(1,[1 0.2 2.1],Ts);
FRDd = idfrd(sys, logspace(-2,2,100));

You can use continuous-time frequency-domain data to identify only continuous-time
models. You can use discrete-time frequency-domain data to identify both discrete-time
and continuous-time models. However, identifying continuous-time models from discrete-
time data requires knowledge of the intersample behavior of the data. For more
information, see “Estimating Continuous-Time and Discrete-Time Models” on page 3-145.

Note For discrete-time data, the software ignores frequency-domain data above the
Nyquist frequency during estimation.

Preprocessing Frequency-Domain Data for Model Estimation

After you have represented your frequency-domain data using iddata or idfrd objects,
you can prepare the data for estimation by removing spurious data and by filtering the
data.
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To view the spurious data, plot the data in the app, or use the plot (for iddata objects)
or bode (for idfrd objects) commands. After identifying the spurious data in the plot,
you can remove them. For example, if you want to remove data points 20-30 from zf, a
frequency-domain iddata object, use the following syntax:

z£(20:30) = [];

Since frequency-domain data does not have to be specified with a uniform spacing, you do
not need to replace the outliers.

You can also prefilter high-frequency noise in your data. You can prefilter frequency-
domain data in the app, or use idfilt at the command line. Prefiltering data can also
help remove drifts that are low-frequency disturbances. In addition to minimizing noise,
prefiltering lets you focus your model on specific frequency bands. The frequency range of
interest often corresponds to a passband over the breakpoints on a Bode plot. For
example, if you are modeling a plant for control-design applications, you can prefilter the
data to enhance frequencies around the desired closed-loop bandwidth.

For more information, see “Filtering Data”.

Estimating Linear Parametric Models

After you have preprocessed the frequency-domain data, you can use it to estimate
continuous-time and discrete-time models on page 3-145.

Supported Model Types

You can estimate the following linear parametric models using frequency-domain data.
The noise component of the models is not estimated, except for ARX models.

Model Type Additional Information |Estimation Estimation in the App
Commands
“Transfer Function - tfest See “Estimate
Models” Transfer Function
Models in the
System
Identification App”.
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Model Type Additional Information |Estimation Estimation in the App
Commands
“State-Space Models” | Estimated K matrix |+ ssest See “Estimate State-
of the state-space 0 adsid Space Models in
model is zero. System
Identification App”.
“Process Models” Disturbance model is|* procest See “Estimate
not estimated. Process Models
Using the App”.
“Input-Output You can estimate + oe See “Estimate
Polynomial Models” |[only output-error . arx Polynomial Models
and ARX models. . in the App”.
« iv4
« ivx

* polyest with na,
nc, and nd orders
of the polynomial
specified as zero

“Linear Grey-Box
Models”

Model parameters
that are only related
to the noise matrix K
are not estimated.

e greyest

Grey-box model
estimation is not
available in the app.

“Correlation Models”
(Impulse-response
models)

+ impulseest

See “Estimate
Impulse-Response
Models Using
System
Identification App”.

“Frequency-
Response Models”
(Estimated as idfrd
objects)

+ etfe
* spa
+ spafdr

See “Estimate
Frequency-Response
Models in the App”.

Before performing the estimation, you can specify estimation options, such as how the
software treats initial conditions of the estimation data. To do so at the command line,
use the estimation option set corresponding to the estimation command. For example,
suppose that you want to estimate a transfer function model from frequency-domain
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data, z f, and you also want to estimate the initial conditions of the data. Use the
tfestOptions option set to specify the estimation options, and then estimate the model.

opt = tfestOptions('InitialCondition', 'estimate');
sSys tfest (zf,opt);

sys 1s the estimated transfer function model. For information about extracting estimated
parameter values from the model, see “Extracting Numerical Model Data”. After
performing the estimation, you can validate the estimated model on page 3-149.

Note A zero initial condition for time-domain data does not imply a zero initial condition
for the corresponding frequency-domain data. For time-domain data, zero initial
conditions mean that the system is assumed to be in a state of rest before the start of
data collection. In the frequency-domain, initial conditions can be ignored only if the data
collected is periodic in nature. Thus, if you have time-domain data collected with zero
initial conditions, and you convert it to frequency-domain data to estimate a model, you
have to estimate the initial conditions as well. You cannot specify them as zero.

You cannot perform the following estimations using frequency-domain data:

+  Estimation of the noise component of a linear model, except for ARX models.
+ Estimation of nonlinear models.

+ Estimation of time series models using spectrum data only. Spectrum data is the
power spectrum of a signal, commonly stored in the SpectrumbData property of an
idfrd object.

* Online estimation using recursive algorithms.
Estimating Continuous-Time and Discrete-Time Models

You can estimate all the supported linear models on page 3-143 as discrete-time models,
except for process models. Process models are defined in continuous-time only. For the
estimation of discrete-time models, you must use discrete-time data.

You can estimate all the supported linear models as continuous-time models, except for
correlation models (see impulseest). You can estimate continuous-time models using
both continuous-time and discrete-time data. For information about continuous-time and
discrete-time data, see “Continuous-Time and Discrete-Time Frequency-Domain Data”
on page 3-140.

3-145



3 Linear Model Identification

3-146

If you are estimating a continuous-time model using discrete-time data, you must specify
the intersample behavior of the data. The specification of intersample behavior depends
on the type of frequency-domain data.

* Discrete-time frequency-domain input-output data (iddata object) — Specify the
intersample behavior of the time-domain input signal u(¢) that you Fourier
transformed to obtain the frequency-domain input signal U(w).

* Discrete-time frequency-response data (idfrd object) — The data is generated by
computing the frequency-response of a discrete-time model. Specify the intersample
behavior as the discretization method assumed to compute the discrete-time model
from an underlying continuous-time model. For an example, see “Specify Intersample
Behavior for Discrete-Time Frequency-Response Data” on page 3-146.

You can specify the intersample behavior to be piecewise constant (zero-order hold),
linearly interpolated between the samples (first-order hold), or band-limited. If you
specify the discrete-time data from your system as band-limited (that is no power above
the Nyquist frequency), the software treats the data as continuous-time by setting the
sample time to zero. The software then estimates a continuous-time model from the data.

For more information, see “Effect of Input Intersample Behavior on Continuous-Time
Models”.

Specify Intersample Behavior for Discrete-Time Frequency-Response Data

This example shows the effect of intersample behavior on the estimation of continuous-
time models using discrete-time frequency-response data.

Generate discrete-time frequency-response data. To do so, first construct a continuous-
time transfer function model, sys. Then convert it to a discrete-time model, sysd, using
the c2d command and first-order hold (FOH) method. Use the discrete-time model sysd
to generate frequency-response data at specified frequencies, freq.

sys = idtf([1 0.2],[1 2 1 1]);

sysd = c2d(sys,1l,c2dOptions ('Method', "foh'"));
freq = logspace(-1,0,10);

FRdata = idfrd(sysd, freq);

FRdata is discrete-time data. The software sets the InterSample property of FRdata to
'foh', which is the discretization method that was used to obtain sysd from sys.

Estimate a third-order continuous-time transfer function from the discrete-time data.

modell = tfest (FRdata,3,1)
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modell =

Continuous-time identified transfer function.

Parameterization:
Number of poles: 3 Number of zeros: 1
Number of free coefficients: 5
Use "tfdata", "getpvec", "getcov" for parameters and their uncertainties.

Status:

Estimated using TFEST on frequency response data "FRdata".
Fit to estimation data: 100%

FPE: 5.746e-30, MSE: 3.448e-30

modell is a continuous-time model, estimated using discrete-time frequency-response
data. The underlying continuous-time dynamics of the original third-order model sys are
retrieved in modell because the correct intersample behavior is specified in FRdata.

Now, specify the intersample behavior as zero-order hold (ZOH), and estimate a third-
order transfer function model.

FRdata.InterSample = 'zoh';
model2 = tfest (FRdata,3,1)

model2 =

s”"3 - 30.03 s"2 - 6.825 s - 17.04
Continuous-time identified transfer function.

Parameterization:
Number of poles: 3 Number of zeros: 1
Number of free coefficients: 5
Use "tfdata", "getpvec", "getcov" for parameters and their uncertainties.

Status:

Estimated using TFEST on frequency response data "FRdata".
Fit to estimation data: 94.75%

FPE: 0.002677, MSE: 0.001606
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model2 does not capture the dynamics of the original model sys. Thus, sampling related
errors are introduced in the model estimation when the intersample behavior is not
correctly specified.

Convert Frequency-Response Data Model to a Transfer Function

This example shows how to convert a frequency-response data (FRD) model to a transfer
function model. You treat the FRD model as estimation data and then estimate the
transfer function.

Obtain an FRD model.

For example, use bode to obtain the magnitude and phase response data for the
following fifth-order system:

{-;4.'!': — 5 +ﬂ.2
P+ +085 +0457 40125+ 0.04

Use 100 frequency points between 0.1 rad/s to 10 rad/s to obtain the FRD model. Use frd
to create a frequency-response model object.

freq = logspace(-1,1,100);
sysO = tf([1 0.2],[1 1 0.8 0.4 0.12 0.041);

[mag, phase] = bode(sys0, freq);
frdModel = frd(mag.*exp (lj*phase*pi/180), freq);

Obtain the best third-order approximation to the system dynamics by estimating a
transfer function with 3 zeros and 3 poles.

np = 3;
nz = 3;

sys = tfest (frdModel,np,nz);

sys is the estimated transfer function.

Compare the response of the FRD Model and the estimated transfer function model.

bode (frdModel, sys, freq(1:50)) ;
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The FRD model is generated from the fifth-order system sys0. While sys, a third-order
approximation, does not capture the entire response of sys0, it captures the response

well until approximately 0.6 rad/s.

Validating Estimated Model

After estimating a model for your system, you can validate whether it reproduces the
system behavior within acceptable bounds. It is recommended that you use separate data
sets for estimating and validating your model. You can use time-domain or frequency-
domain data to validate a model estimated using frequency-domain data. If you are using
input-output validation data to validate the estimated model, you can compare the
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simulated model response to the measured validation data output. If your validation data
is frequency-response data, you can compare it to the frequency response of the model.
For example, to compare the output of an estimated model sys to measured validation
data zv, use the following syntax:

compare (zv, sys) ;

You can also perform a residual analysis. For more information see, “Validating Models
After Estimation”.

Troubleshooting Frequency-Domain Identification

When you estimate a model using frequency-domain data, the estimation algorithm
minimizes a loss (cost) function. For example, if you estimate a SISO linear model from
frequency-response data £, the estimation algorithm minimizes the following least-
squares loss function:

N, 9
minimize Z|W(wk)(G((Dk) —f(wk))|

G(w) k=1

Here W is a frequency-dependent weight that you specify, G is the linear model that is to
be estimated, ® is the frequency, and IV, is the number of frequencies at which the data is

available. The quantity (G(a)k) - f(wk)) is the frequency-response error. For frequency-
domain input-output data, the algorithm minimizes the weighted norm of the output
error instead of the frequency-response error. For more information, see “Loss Function
and Model Quality Metrics”. During estimation, spurious or uncaptured dynamics in
your data can effect the loss function and result in unsatisfactory model estimation.

*  Unexpected, spurious dynamics — Typically observed when the high magnitude
regions of data have low signal-to-noise ratio. The fitting error around these portions
of data has a large contribution to the loss function. As a result the estimation
algorithm may overfit and assign unexpected dynamics to noise in these regions. To
troubleshoot this issue:

Improve signal-to-noise ratio — You can gather more than one set of data, and
average them. If you have frequency-domain input-output data, you can combine
multiple data sets by using the merge command. Use this data for estimation to
obtain an improved result. Alternatively, you can filter the dataset, and use it for
estimation. For example, use a moving-average filter over the data to smooth the
measured response. Apply the smoothing filter only in regions of data where you
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are confident that the unsmoothness is due to noise, and not due to system
dynamics.

+ Reduce the impact of certain portions of data on the loss function — You can
specify a frequency-dependent weight. For example, if you are estimating a
transfer function model, specify the weight in the WeightingFilter option of the
estimation option set tfestOptions. Specify a small weight in frequency regions
where the spurious dynamics exist. Alternatively, use fewer data points around
this frequency region.

Uncaptured dynamics — Typically observed when the dynamics you want to capture
have a low magnitude relative to the rest of data. Since a poor fit to low magnitude
data contributes less to the loss function, the algorithm may ignore these dynamics to
reduce errors at other frequencies. To troubleshoot this issue:

Specify a frequency-dependent weight — Specify a large weight for the frequency
region where you would like to capture dynamics.

+  Use more data points around this region.

For an example of these troubleshooting techniques, see “Troubleshoot Frequency-
Domain Identification of Transfer Function Models”.

If you do not achieve a satisfactory model using these troubleshooting techniques, try a
different model structure or estimation algorithm.

Next Steps After Identifying a Model

After estimating a model, you can perform model transformations, extract model
parameters, and simulate and predict the model response. Some of the tasks you can
perform are:

“Transforming Between Discrete-Time and Continuous-Time Representations”

“Transforming Between Linear Model Representations” — Transform between linear
parametric model representations, such as between polynomial, state-space, and zero-
pole representations.

“Extracting Numerical Model Data” — For example, extract the poles and zeros of the
model using pole and zero commands, respectively. Compute the model frequency
response for a specified set of frequencies using freqgresp.

Simulating and predicting model response

Using the model for control design
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See Also

More About
. “System Identification Workflow” on page 2-4

“Frequency Domain Identification: Estimating Models Using Frequency Domain
Data”

“Effect of Input Intersample Behavior on Continuous-Time Models”

“Troubleshoot Frequency-Domain Identification of Transfer Function Models”
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Identify Nonlinear Black-Box Models Using System Identification
App

In this section...

“Introduction” on page 4-2

“What Are Nonlinear Black-Box Models?” on page 4-3
“Preparing Data” on page 4-7

“Estimating Nonlinear ARX Models” on page 4-12

“Estimating Hammerstein-Wiener Models” on page 4-24

Introduction

+ “Objectives” on page 4-2

+ “Data Description” on page 4-2
Objectives

Estimate and validate nonlinear models from single-input/single-output (SISO) data to
find the one that best represents your system dynamics.

After completing this tutorial, you will be able to accomplish the following tasks using
the System Identification app:

+ Import data objects from the MATLAB workspace into the app.
+  Estimate and validate nonlinear models from the data.

+ Plot and analyze the behavior of the nonlinearities.
Data Description

This tutorial uses the data file twotankdata.mat, which contains SISO time-domain
data for a two-tank system, shown in the following figure.
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Tank 1

Tank 2

Two-Tank System

In the two-tank system, water pours through a pipe into Tank 1, drains into Tank 2, and
leaves the system through a small hole at the bottom of Tank 2. The measured input u(t)
to the system is the voltage applied to the pump that feeds the water into Tank 1 (in
volts). The measured output y(¢) is the height of the water in the lower tank (in meters).

Based on Bernoulli's law, which states that water flowing through a small hole at the
bottom of a tank depends nonlinearly on the level of the water in the tank, you expect the

relationship between the input and the output data to be nonlinear.

twotankdata.mat includes 3000 samples with a sample time of 0.2 s.

What Are Nonlinear Black-Box Models?

* “Types of Nonlinear Black-Box Models” on page 4-3
+ “What Is a Nonlinear ARX Model?” on page 4-4
+ “What Is a Hammerstein-Wiener Model?” on page 4-5

Types of Nonlinear Black-Box Models
You can estimate nonlinear discrete-time black-box models for both single-output and

multiple-output time-domain data. You can choose from two types of nonlinear, black-box
model structures:
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* Nonlinear ARX models

*+ Hammerstein-Wiener models

Note You can estimate Hammerstein-Wiener black-box models from input/output data
only. These models do not support time-series data, where there is no input.

For more information on estimating nonlinear black-box models, see “Nonlinear Model
Identification”.

What Is a Nonlinear ARX Model?

A nonlinear ARX model consists of model regressors and a nonlinearity estimator. The
nonlinearity estimator comprises both linear and nonlinear functions that act on the
model regressors to give the model output. This block diagram represents the structure
of a nonlinear ARX model in a simulation scenario.

Nonlinearity Estimator

u Nonlinear
—_—) > .
Regressors Function y
| uouEn e, T Troar >
i "| Function

The software computes the nonlinear ARX model output y in two stages:

1 It computes regressor values from the current and past input values and past output
data.

In the simplest case, regressors are delayed inputs and outputs, such as u(¢-1) and
y(t-3). These kind of regressors are called standard regressors. You specify the
standard regressors using the model orders and delay. For more information, see
“Nonlinear ARX Model Orders and Delay”. You can also specify custom regressors,
which are nonlinear functions of delayed inputs and outputs. For example,
u(t-1)*y(t-3). To create a set of polynomial type regressors, use polyreg.
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By default, all regressors are inputs to both the linear and the nonlinear function
blocks of the nonlinearity estimator. You can choose a subset of regressors as inputs
to the nonlinear function block.

2 It maps the regressors to the model output using the nonlinearity estimator block.
The nonlinearity estimator block can include linear and nonlinear blocks in parallel.
For example:

Fx)=L' (x-r)+d + g(Qx-1))

Here, x is a vector of the regressors, and r is the mean of the regressors x. r x)+d
is the output of the linear function block and is affine when d # 0. d is a scalar offset.

g (Q(x - 7”)) represents the output of the nonlinear function block. @ is a projection
matrix that makes the calculations well conditioned. The exact form of F(x) depends
on your choice of the nonlinearity estimator. You can select from available
nonlinearity estimators, such as tree-partition networks, wavelet networks, and
multilayer neural networks. You can also exclude either the linear or the nonlinear
function block from the nonlinearity estimator.

When estimating a nonlinear ARX model, the software computes the model
parameter values, such as L, r, d, @, and other parameters specifying g.

Resulting nonlinear ARX models are idnlarx objects that store all model data, including
model regressors and parameters of the nonlinearity estimator. For more information
about these objects, see “Nonlinear Model Structures”.

What Is a Hammerstein-Wiener Model?

This block diagram represents the structure of a Hammerstein-Wiener model:

u(t) nput | w(t) | Linear | x(t) | Outout 1 y(t)
——>» Nonlinearity > Block » Nonlinearity —»
f B/F h

Where,

* f1is a nonlinear function that transforms input data () as w(t) = f(u(t)).

w(t), an internal variable, is the output of the Input Nonlinearity block and has the
same dimension as u(t).
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B/Fis a linear transfer function that transforms w(t) as x(¢) = (B/F)w(t).

x(t), an internal variable, is the output of the Linear block and has the same
dimension as y(f).

B and F are similar to polynomials in a linear Output-Error model. For more
information about Output-Error models, see “What Are Polynomial Models?”.

For ny outputs and nu inputs, the linear block is a transfer function matrix
containing entries:

Bj’i(Q)
F;i(q@)

wherej=1,2,...,nyandi=1,2,...,nu.

h is a nonlinear function that maps the output of the linear block x(¢) to the system
output y(¢) as y(t) = h(x(z)).

Because f acts on the input port of the linear block, this function is called the input
nonlinearity. Similarly, because A acts on the output port of the linear block, this
function is called the output nonlinearity. If your system contains several inputs and
outputs, you must define the functions f and A for each input and output signal. You do
not have to include both the input and the output nonlinearity in the model structure.
When a model contains only the input nonlinearity f, it is called a Hammerstein model.
Similarly, when the model contains only the output nonlinearity A, it is called a Wiener
model.

The software computes the Hammerstein-Wiener model output y in three stages:

1

Compute w(t) = f(u(t)) from the input data.
w(?) is an input to the linear transfer function B/F.

The input nonlinearity is a static (memoryless) function, where the value of the
output a given time ¢ depends only on the input value at time ¢.

You can configure the input nonlinearity as a sigmoid network, wavelet network,
saturation, dead zone, piecewise linear function, one-dimensional polynomial, or a
custom network. You can also remove the input nonlinearity.

Compute the output of the linear block using w(t) and initial conditions: x(t) = (B/
Pw(t).
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You can configure the linear block by specifying the orders of numerator B and
denominator F.

3 Compute the model output by transforming the output of the linear block x(¢) using
the nonlinear function A as y(t) = h(x(2)).

Similar to the input nonlinearity, the output nonlinearity is a static function. You
can configure the output nonlinearity in the same way as the input nonlinearity. You
can also remove the output nonlinearity, such that y(¢) = x(¢).

Resulting models are idnlhw objects that store all model data, including model
parameters and nonlinearity estimators. For more information about these objects, see
“Nonlinear Model Structures”.

Preparing Data

* “Loading Data into the MATLAB Workspace” on page 4-7

+ “Creating iddata Objects” on page 4-7

+  “Starting the System Identification App” on page 4-9

* “Importing Data Objects into the System Identification App” on page 4-10

Loading Data into the MATLAB Workspace

Load sample data in twotankdata.mat by typing the following command in the
MATLAB Command Window:

load twotankdata
This command loads the following two variables into the MATLAB Workspace browser:

* uis the input data, which is the voltage applied to the pump that feeds the water into
Tank 1 (in volts).

* vy is the output data, which is the water height in Tank 2 (in meters).
Creating iddata Objects
System Identification Toolbox data objects encapsulate both data values and data

properties into a single entity. You can use the System Identification Toolbox commands
to conveniently manipulate these data objects as single entities.

4-7



4 Nonlinear Model Identification

4-8

You must have already loaded the sample data into the MATLAB workspace, as
described in “Loading Data into the MATLAB Workspace” on page 4-7.

Use the following commands to create two iddata data objects, ze and zv, where ze
contains data for model estimation and zv contains data for model validation. Ts is the
sample time.

Ts = 0.2; % Sample time is 0.2 sec
z = iddata(y,u,Ts);

% First 1000 samples used for estimation
ze = z(1:1000);

% Remaining samples used for validation
zv = z(1001:3000);

To view the properties of the iddata object, use the get command. For example:
get (ze)

MATLAB software returns the following data properties and values:

Domain: 'Time'
Name: ''
OutputData: [1000x1 double]
y: 'Same as OutputData'

OutputName: {'yl'}
OutputUnit: {''}
InputData: [1000x1 double]
u: 'Same as InputData'
InputName: {'ul'}
InputUnit: {''}
Period: Inf
InterSample: 'zoh'
Ts: 0.2000
Tstart: 0.2000
SamplingInstants: [1000x0 double]

TimeUnit: 'seconds'
ExperimentName: 'Expl'
Notes: {}
UserData: []

To modify data properties, use dot notation. For example, to assign channel names and
units that label plot axes, type the following syntax in the MATLAB Command Window:

% Set time units to minutes
ze.TimeUnit = 'sec';
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% Set names of input channels

ze.InputName = 'Voltage';

% Set units for input variables
ze.InputUnit = 'V';

% Set name of output channel
ze.OutputName = 'Height';

% Set unit of output channel
ze.OutputUnit = 'm';

% Set validation data properties

zv.TimeUnit = 'sec';
zv.InputName = 'Voltage';
zv.InputUnit = 'V';
zv.OutputName = 'Height';

zv.OutputUnit 'm';
To verify that the InputName property of ze is changed, type the following command:

ze.linputname

Tip Property names, such as InputName, are not case sensitive. You can also abbreviate
property names that start with Input or Output by substituting u for Input and y for
Output in the property name. For example, OutputUnit is equivalent to yunit.

Starting the System Identification App

To open the System Identification app, type the following command in the MATLAB
Command Window:

systemIdentification

The default session name, Untitled, appears in the title bar.
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System Identification - Untitled EI@
File Options Window Help
Import data - Import models -
‘ Operations. “
<— Preprocess -
=
Working Data
Estimate —= -
Data Views To To Model Views
Time plot Workspace || LTI Viewer Model output Transient resp Nonlinear ARX
Data spectra Model resids Frequency resp Hamm-Wiener
Frequency function ”” Zeros and poles
Noize spectrum
f=h \alidation Data ’
Status line is here.

Importing Data Objects into the System Identification App
You can import the data objects into the app from the MATLAB workspace.

You must have already created the data objects, as described in “Creating iddata
Objects” on page 4-7, and opened the app, as described in “Starting the System
Identification App” on page 4-9.

To import data objects:

1 In the System Identification app, select Import data > Data object.
Import data j

Import data
Time domain data...
Fredq. domain data...

Example...

This action opens the Import Data dialog box.
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ol x]

Data Format for Signals

[1DDATA or IDFRDIFRD =

Workspace Variable

Ohbject: I

Object class:

Data Information

Dats nate: Imfdﬁfﬂ—
Starting time: |1—
Sampling interval: |1—

WMore I

Import | Reset |

Close | Help |

Enter ze in the Object field to import the estimation data. Press Enter.
This action enters the object information into the Import Data fields.

Click More to view additional information about this data, including channel names
and units.

Click Import to add the icon named ze to the System Identification app.

In the Import Data dialog box, type zv in the Object field to import the validation
data. Press Enter.

Click Import to add the icon named zv to the System Identification app.
In the Import Data dialog box, click Close.

In the System Identification app, drag the validation data zv icon to the Validation
Data rectangle. The estimation data ze icon is already designated in the Working
Data rectangle.

Alternatively, right-click the zv icon to open the Data/model Info dialog box. Select
the Use as Validation Data check-box. Click Apply and then Close to add zv to
the Validation Data rectangle.
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The System Identification app now resembles the following figure.

Import data ~)
“ Operations

<— Preprocess -
za v ’

L

=
ze
Working Data
Estimate —= ~)
Data Views To To
D Time plot Workspace LTI Viewar Mod

D Data spectra

Estimating Nonlinear ARX Models

“Estimating a Nonlinear ARX Model with Default Settings” on page 4-12

“Plotting Nonlinearity Cross-Sections for Nonlinear ARX Models” on page 4-16
“Changing the Nonlinear ARX Model Structure” on page 4-19

“Selecting a Subset of Regressors in the Nonlinear Block” on page 4-21

“Specifying a Previously-Estimated Model with Different Nonlinearity” on page 4-22
“Selecting the Best Model” on page 4-24

Estimating a Nonlinear ARX Model with Default Settings

In this portion of the tutorial, you estimate a nonlinear ARX model using default model
structure and estimation options.

You must have already prepared the data, as described in “Preparing Data” on page 4-7.
For more information about nonlinear ARX models, see “What Is a Nonlinear ARX
Model?” on page 4-4
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1

In the System Identification app, select Estimate > Nonlinear models.

Estimate —= -

Estimate —=

Tranzfer Function Models...

State Space Models. ..

Process Models...

Polynomial Models. ..
Spectral Models. .. k‘

Correlation Models...

Refine Existing Models. ..
Quick Start

This action opens the Nonlinear Models dialog box.

! Nonlinear Models

| Configre | Estimate |

Model name: nlarxl

=10l x|

ImpLts (L)

Model type: I Monlinear ARY LI

Initialize... |

—_—*
Outputs ()
—_—

Regressors
U110, u2t-3), 1010,

Predicted
Outputs ()

Manlinear Block
I Linear Block I

Regressors | Model Properties |

Specify delay and number of terms in standard regressors for output Height:

Channel Name | Delay I Mo. of Terms I Resulting Regressors
Input Channels
oltage 1 2 Voltage(t-1), Voltage(t-2)
QOutput Channels
Height [ 2 Height(t-1), Height(t-2)

Mote: Model has no custom regressars.,

Infer Input Delay... |

Edit Regressors... |

Estimate |

Close | Help |

The Configure tab is already open and the default Model type is Nonlinear ARX.

In the Regressors tab, the Input Channels and Output Channels have Delay
set to 1 and No. of Terms set to 2. The model output y(z) is related to the input u(t)
via the following nonlinear autoregressive equation:
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y@) = f (@ -1), y(t - 2),ult - 1),u(t - 2))

f is the nonlinearity estimator selected in the Nonlinearity drop-down list of the
Model Properties tab, and is Wavelet Network by default. The number of units
for the nonlinearity estimator is set to Select automatically and controls the
flexibility of the nonlinearity—more units correspond to a more flexible nonlinearity.

Click Estimate.

This action adds the model nlarx1 to the System Identification app, as shown in the
following figure.

Import data > Import models >
JL Operations ‘
<— Preprocess - \
ze v f . nlanc1
=
ze
Working Data
Estimate —= ~)
Data Views To To Model Views
ime plo Model outpu ransient resp onlinear
[ Time piot Workspace || LTI Viewer | [ Model output [] Transient [] Nenlinear ARX
ata spectra Model resids requency resp amm-Viener
[ Dat ct _ [ Model resid 1 i H
requency function eros and poles
Bl F functi Oz d pol
ze |:| Noise spectrum
Trash Validation Data

Model nlarx1 inserted. Double click on icon for text information.

The Nonlinear Models dialog box displays a summary of the estimation information
in the Estimate tab. The Fit (%) is the mean square error between the measured
data and the simulated output of the model: 100% corresponds to a perfect fit (no
error) and 0% to a model that is not capable of explaining any of the variation of the
output and only the mean level.
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4\ Nonlinear Models EIIEI

b Estimation Trace

Estimation Summary
Fit (%) = 87.29

FPE = 3.999e-05

Loss Fen = 3.654e-05

* Estimation Report

Estimation of Nonlinear ARX model: nlarx1
Estimation Data: ‘ze' with 1000 samples.

Model Configuration:

Model regressors:Height(t-1), Height(t-2), Voltage(t-1), Voltage(t-2).
Regressors subset used for nonlinear block: All regressors.

m

Nonlinearity: Wavelet network with number of units chesen automatically.

Estimation Progress:

Performing estimation with Focus = Prediction....
dong. -

Meodel Refinement
Last estimated model: nland

[] Use last estimated model as initial model for next estimation

Randomize initial model before estimation

’ Estimate ] | Close | ’ Help ]

Note Fit (%) is computed using the estimation data set, and not the validation data
set. However, the model output plot in the next step compares the fit to the
validation data set.

In the System Identification app, select the Model output check box.

This action simulates the model using the input validation data as input to the
model and plots the simulated output on top of the output validation data.
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Measured and simulated model output

0.6

Best Fits
nlar1: 60.91

04 . . .
200 300 400 500 600

Time

The Best Fits area of the Model Output plot shows that the agreement between the
model output and the validation-data output.

Plotting Nonlinearity Cross-Sections for Nonlinear ARX Models

Perform the following procedure to view the shape of the nonlinearity as a function of
regressors on a Nonlinear ARX Model plot.

1 In the System Identification app, select the Nonlinear ARX check box to view the
nonlinearity cross-sections.

By default, the plot shows the relationship between the output regressors

Height (t-1) and Height (t-2). This plot shows a regular plane in the following
figure. Thus, the relationship between the regressors and the output is
approximately a linear plane.
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Select nonlinearity at output: Height -
= Output: Height
Qutput:Height [
Regressor 1:
Ll | |:| nla.rx1 “wanvenet Height(t1) -
B R Range: |[0.045354 04
Regressor 2:
Height(t-2) -
[-0.045354 04

Range:

Maonlin

Remaining regressors:

Apply

Reg 2 05 05 Reg 1

In the Nonlinear ARX Model Plot window, set Regressor 1 to Voltage (t-1). Set
Regressor 2 to Voltage (t-2). Click Apply.

The relationship between these regressors and the output is nonlinear, as shown in
the following plot.
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Select nonlinearity at output: Height -
= Output: Height

Cutput:Height

Regressor 1:

|.|“:|rt||;larx1:wa\-'9n91 Voltage(t-1) .|

IE USRS S T T TrE
: B Ll Regressor 2:

Voltage(t-2) ":

Range: |[12 10.8]

THOITTITT

Remaining regressors:

Reg 2 | Reg 1

3 To rotate the nonlinearity surface, select Style > Rotate 3D and drag the plot to a
new orientation.

4 To display a 1-D cross-section for Regressor 1, set Regressor 2 to none, and click
Apply. The following figure shows the resulting nonlinearity magnitude for
Regressor 1, which represents the time-shifted voltage signal, Voltage (t-1).
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Select nonlinearity at output:

Height -

0.297

Cutput: Height

0.296

0.295

0.294

Monlin

0.293

0.292

0.291

nlarxl wavenet

Range: M2

029
1]

Reg 1

Changing the Nonlinear ARX Model Structure

Output: Height
Regressor 1:
Voltage(t-1) v |

Range: [12 108

Regressor 2:

<nonex b

Remaining regressors:

In this portion of the tutorial, you estimate a nonlinear ARX model with specific input
delay and nonlinearity settings. Typically, you select model orders by trial and error
until you get a model that produces an accurate fit to the data.

You must have already estimated the nonlinear ARX model with default settings, as
described in “Estimating a Nonlinear ARX Model with Default Settings” on page 4-12.

1 In the Nonlinear Models dialog box, click the Configure tab, and click the

Regressors tab.

2 For the Voltage input channel, double-click the corresponding Delay cell, enter 3,

and press Enter.

This action updates the Resulting Regressors list to show Voltage (t-3) and
Voltage (t-4) — terms with a minimum input delay of three samples.

3 Click Estimate.
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This action adds the model n1arx2 to the System Identification app and updates the
Model Output window to include this model. The Nonlinear Models dialog box
displays the new estimation information in the Estimate tab.

Measured and simulated model output

0.6
Best Fits
: nlarx2: 85.36
0.4 1 Inlarct: 60,91

0.2

-0.2

04 . . .
200 300 400 500 600

Time

4  In the Nonlinear Models dialog box, click the Configure tab, and select the Model
Properties tab.

5 Inthe Number of units in nonlinear block area, select Enter, and type 6. This
number controls the flexibility of the nonlinearity.

Regressors Model Properties |

Monlinearity: I Wavelet Metwork j W Indude linear block

Properties of Wavelet Network
Mumber of units in nonlinear block:
{~ Select automatically

{* Enter: |5|

{~ Selectinteractively during estimation

Advanced... |

6 Click Estimate.
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This action adds the model n1arx3 to the System Identification app. It also updates
the Model Output window, as shown in the following figure.

Measured and simulated model output

0.6
Best Fits
nlarx3: 86.28
0.4 1 Inlare2: 85.38
nlar1: 60.91

0.2

-0.2

04 . . .
200 300 400 500 600

Time

Selecting a Subset of Regressors in the Nonlinear Block

You can estimate a nonlinear ARX model that includes only a subset of standard
regressors that enter as inputs to the nonlinear block. By default, all standard and
custom regressors are used in the nonlinear block. In this portion of the tutorial, you only
include standard regressors.

You must have already specified the model structure, as described in “Changing the
Nonlinear ARX Model Structure” on page 4-19.

1 In the Nonlinear Models dialog box, click the Configure tab, and select the
Regressors tab.

2 Click the Edit Regressors button to open the Model Regressors dialog box.
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4-22

) Model Regressors x|

Qukput: Height
Monlinearity: Wavelst Metwork

~Regressor Creation and Selection

Select how to include regressors in the nonlinear black:

All -

w Standard Regressors

Regressar Use in nonlinzar black?
Height(t-1) I~
Height(t-2) I~
Valkage(t-3) I~
Valkage(t-4) I~

3  Clear the following check boxes:

+ Height(t-2)
+ Voltage(t-3)

Click OK.

This action excludes the time-shifted Height (t-2) and Voltage (t-3) from the list
of inputs to the nonlinear block.

4 Click Estimate.

This action adds the model nlarx4 to the System Identification app. It also updates
the Model Output window.

Specifying a Previously-Estimated Model with Different Nonlinearity

You can estimate a series of nonlinear ARX models by making systematic variations to
the model structure and base each new model on the configuration of a previously
estimated model. In this portion of the tutorial, you estimate a nonlinear ARX model that
is similar to an existing model (nlarx3), but with a different nonlinearity.

1 In the Nonlinear Models dialog box, select the Configure tab. Click Initialize. This
action opens the Initial Model Specification dialog box.

2 In the Initial Model list, select n1arx3. Click OK.
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Initial Model Specification x|

Initialize model properties using an existing model {optional):

Initial Model: | nlarx3

nlarx4

- rlarx 1
Nonlinear &/ 1o

Input
Ouiput name:

Click the Model Properties tab.
In the Nonlinearity list, select Sigmoid Network.
In the Number of units in nonlinear block field, type 6.

Regressors Model Properties |

Monlinearity: I Sigmoid Network LI ¥ Indude linear block

Properties of Sigmaid Metwork

Murmber of units in nonlinear block: |5|

Click Estimate.

This action adds the model n1arx5 to the System Identification app. It also updates
the Model Output plot, as shown in the following figure.
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4-24

Measured and simulated model autput

0.6

Best Fits
nlarxd: 8628
nlar:2: 85,36
hlarxs: 846.3
d |nlarkd: 63.06
nlarxt: G091

0.4 : : :
200 300 400 500 BOD
Time

Selecting the Best Model

The best model is the simplest model that accurately describes the dynamics.

To view information about the best model, including the model order, nonlinearity, and
list of regressors, right-click the model icon in the System Identification app.

Estimating Hammerstein-Wiener Models

“Estimating Hammerstein-Wiener Models with Default Settings” on page 4-24
“Plotting the Nonlinearities and Linear Transfer Function” on page 4-27
“Changing the Hammerstein-Wiener Model Input Delay” on page 4-30

“Changing the Nonlinearity Estimator in a Hammerstein-Wiener Model”
on page 4-31

“Selecting the Best Model” on page 4-33

Estimating Hammerstein-Wiener Models with Default Settings

In this portion of the tutorial, you estimate nonlinear Hammerstein-Wiener models using
default model structure and estimation options.
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You must have already prepared the data, as described in “Preparing Data” on page 4-7.
For more information about nonlinear ARX models, see “What Is a Hammerstein-Wiener
Model?” on page 4-5

1 In the System Identification app, select Estimate > Nonlinear models to open the
Nonlinear Models dialog box.
2 In the Configure tab, select Hammerstein-Wiener in the Model type list.
J:Nonlinear Models M=l E

Configure I Estimate |

Model name: nlhwl &

(UGG | Hammerstein-Wiener Initialize... |
1 t
£>| Input Monlinearity }—p| Linear Block }—>|Output Nonlinearﬂy}ﬂp

Hammerstein-Wiener model

IJO Monlinearity I Linear Blockl

I Channel Mames I MNaonlinearity I Ma, of Units |

Input Channels

Valtage |Piecewise Linear |10 | Initial Value. .. I

Output Channels

Height |Piecewise Linear |10 | Initial Value. .. I
Estimate | Close | Help |

The I/O Nonlinearity tab is open. The default nonlinearity estimator is Piecewise
Linear with 10 units for Input Channels and Output Channels, which
corresponds to 10 breakpoints for the piecewise linear function.

3 Select the Linear Block tab to view the model orders and input delay.
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) Nonlinear Models _ (O] x|

Configure I Estimate |

Model name: nlhwi

Madel type: (EUluEE =R == Initislize. .. |
u,

L
ity _ - L
Input Monlinearity Linesr Block St Monlinesrity

Linear equation: y (t) = (B/Fu (t-n,)

1/O Nonlinearity  Linear Black I
~Model Order

Input B Order (Zeros) F Order(Poles) Input Delay (nk)

(]
(%]
=

Valtage

Infer Input Delay...

Estimate | Close | Help |

By default, the model orders and delay of the linear output-error (OE) model are
ny=2, n~3, and n;=1.

4  Click Estimate.

This action adds the model n1hwl to the System Identification app.
5 In the System Identification app, select the Model output check box.

This action simulates the model using the input validation data as input to the
model and plots the simulated output on top of the output validation data.

The Best Fits area of the Model Output window shows the agreement between the
model output and the validation-data output.
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Plotting the Nonlinearities and Linear Transfer Function

You can plot the input/output nonlinearities and the linear transfer function of the model

on a Hammerstein-Wiener plot.

1 In the System Identification app, select the Hamm-Wiener check box to view the

Hammerstein-Wiener model plot.

The plot displays the input nonlinearity, as shown in the following figure.

u Harmmerstein-Wiener Model Plot EIIEI
File Options  Style  Help
Click on a block to view its plot; [2J

—-| U }—-| Linear Block }—'-|

T

Select nonlinearity at channel: Voltage -

nlhw1:pwlinear[

Nonlinearity Walue

1 2 3 4 5 6 7 8
Input to nonlinearity at input Voltage'

2  Click the yyr, rectangle in the top portion of the Hammerstein-Wiener Model Plot

window.

The plot updates to display the output nonlinearity.
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Click on a block to view is plot:

Select nonlinearity at channel:  |Height v

0.5 T T T T —

nlhw:pwlinear

031 q

02r -

01r -

Nonlinearity Yalue

01k J

_0_2 1 1 1 1 1
-1500 -1000 -500 0 500 1000 1500

Input to nonlinearity at output ‘Height'

3 Click the Linear Block rectangle in the top portion of the Hammerstein-Wiener
Model Plot window.

The plot updates to display the step response of the linear transfer function.
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Click on a bleck to view its plot:
Usa Y

Select VO pair  |Woltage-=Height | Cheose plot type:  Step -

To Height

2000 T T T T T T T
nlhw1

1800

1600 q

1400

=
ha
=1
=
T
1

1000 q

From Woltage

600 -

400 q

200

1 1 1 1 1 1 1 1 1
0 200 400 600 800 1000 1200 1400 1600 1800 2000
Time (seconds)

4 In the Choose plot type list, select Bode. This action displays a Bode plot of the
linear transfer function.

4-29



4 Nonlinear Model Identification
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Changing the Hammerstein-Wiener Model Input Delay

In this portion of the tutorial, you estimate a Hammerstein-Wiener model with a specific
model order and nonlinearity settings. Typically, you select model orders and delays by
trial and error until you get a model that produces a satisfactory fit to the data.

You must have already estimated the Hammerstein-Wiener model with default settings,
as described in “Estimating Hammerstein-Wiener Models with Default Settings” on page

4-24.

1

In the Nonlinear Models dialog box, click the Configure tab, and select the Linear

Block tab.

For the Voltage input channel, double-click the corresponding Input Delay (nk)

cell, change the value to 3, and press Enter.
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3 Click Estimate.

This action adds the model n1hw?2 to the System Identification app and the Model
Output window is updated to include this model, as shown in the following figure.

mMeasured and simulated model output
0.8

| BestFits

0e -

of

0.zt

d inlted: 37.03

0.7 . . .
200 300 400 500 600

Tirme

The Best Fits area of the Model Output window shows the quality of the n1hw?2 fit.
Changing the Nonlinearity Estimator in a Hammerstein-Wiener Model

In this portion of the example, you modify the default Hammerstein-Wiener model
structure by changing its nonlinearity estimator.

Tip If you know that your system includes saturation or dead-zone nonlinearities, you
can specify these specialized nonlinearity estimators in your model. Piecewise Linear
and Sigmoid Network are nonlinearity estimators for general nonlinearity
approximation.

1 In the Nonlinear Models dialog box, click the Configure tab.

2 In the I/O Nonlinearity tab, for the Voltage input, click the Nonlinearity cell,
and select Sigmoid Network from the list. Click the corresponding No. of Units
cell and set the value to 20.
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Channel Names Monlinearity: I Ma. of Units I
Input Channels
“oliage Piecewise Linear ;”20 | Initial Walue. .. I
Output Channels Piecewise Linear
Height 10 | Initial value... |
Saturation
Dead Zone
Waavelet Metwark
Mone

3 Click Estimate.

This action adds the model n1hw3 to the System Identification app. It also updates
the Model Output window, as shown in the following figure.

Measured and simulated model cutput

0.8
Best Fits

nihw3: 59.84

08 ] [ihw2: 74.1
1 Inihw1: 37.03

04r

n2r

2 1 1 L
200 300 400 500 600
Time

4 In the Nonlinear Models dialog box, click the Configure tab.

5 In the I/O Nonlinearity tab, set the Voltage input Nonlinearity to Wavelet
Network. This action sets the No. of Units to be determined automatically, by
default.

6 Set the Height output Nonlinearity to One-dimensional Polynomial.
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1/O Nonlinearity | Linear Block |

Channel Names I Monlinearity I Ma. of Units I
Input Channels
\oltage |Wave|et Metwork |Select automat... | Advanced... |
Qutput Channels
Height |One-dimensiu:unal Polynamial IZ | Initial Value... |

7 Click Estimate.

This action adds the model n1hw4 to the System Identification app. It also updates
the Model Output window, as shown in the following figure.

Measured and simulated model output

0.8
Best Fits
b ad [ninw3: 89.84
nihwz: 74.1
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Selecting the Best Model
The best model is the simplest model that accurately describes the dynamics.

In this example, the best model fit was produced in “Changing the Nonlinearity
Estimator in a Hammerstein-Wiener Model” on page 4-31.
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